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OVERVIEW 
To get the most from the Knowledge Worker System (KWS) you must 
understand the main window, known as the KWS Program Window. All 
KWS operations are accessible from this window. This chapter provides a 
description of the KWS Program Window as well as the options and 
commands within it. In addition, this chapter describes general capabilities 
provided by KWS. These capabilities include selecting multiple window 
items, searching for text strings in windows, sending messages to other KWS 
users, writing quick notes while in KWS, and logging in to KWS. 

THE KWS PROGRAM WINDOW 
The KWS Program Window is the primary graphical interface between the 
user and KWS. The Program Window is the first screen that appears after 
you log in to KWS (Figure 1-1: KWS Program Window ). 

Title Bar — 
Menu Bar — 
Button Bar - 

9, Knowledge Woikei System: KAPPES S 
File   Edit   Queiy   Task   Tofio   Adrran; Notes   Toojs   Whdow   Help 

Insert    j    Delete    |    Modify   |    Steps    |    Attach Colt Ered 

Default 
Window 

Dale Due    Title 

P   t)05Feb98 Insurance review 
S        •11Feti38 Attachments Review 

O      027Feb98 Complete TAPES tor GS9 
O 27Feb9B Prepare for Midpoint TAPES objectives 

review 
—       O03Mar98 Do Its Review 

O06Mar98 Write Proposal 
O 22Mar98 Write Cover Letter 
025Mar98 Cyclic Revew 

S 25Mar98 KWS Testing, ver 3.0 
S 2GMar98 Identify SMEs to decompose tasks 

4>     089Apr98 Midpoint Tapes objectives review 
aa 

JLC 

Sure 

Status Bar jReady IE3.0 New 

Figure 1-1: KWS Program Window 

The KWS Program Window has a Title Bar across the top that displays the 
User ID of the person currently logged into KWS. The Menu Bar appears 
just below the Title Bar. It contains several pull-down menus that offer 
system features and operations relevant to the active window. The Button 
Bar appears just below the Menu Bar. Each button within the Button Bar 
will activate a single operation. The available operations depend on which 
window is active within the Workspace Area directly below the Button Bar. 
The Workspace Area is the largest display area in the KWS Program 
Window. The contents of the Workspace Area depend on the selections 
made from the Menu and Button Bars. By default, the ToDo Calendar 
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Window is displayed in the Workspace Area when you first open KWS. 
Directly below the Workspace Area is the Status Bar, which is divided into 
four regions. The leftmost region displays short descriptions of pull-down 
menu items. The second region displays the name of the current database 
connection. The third region displays a number that indicates the position of 
the currently selected item in the active window, as well as the total number 
of items listed. The rightmost region displays the number of new 
notifications. 

Menu Bar Options 
The Menu Bar contains several pull-down menus that offer system features 
and operations for the active window. Clicking once on the title of any menu 
item will cause that menu's options to appear. Clicking elsewhere on the 
screen will close the menu. 

The File Menu 

Login... 
Print 
Preferences   ► 

Exit KWS 

The File Menu contains options that enable you to view KWS-related 
messages from other users, login to the KWS Database, print the contents of 
a window, and set preferences for customizing KWS. 

Notifications 

This option opens the Notifications Window, which contains system- 
generated messages that tell you that another user has assigned a new task to 
you, deleted an assigned task, or performed some similar action. The 
Notifications Window may also contain user-generated messages. See The 
Notifications Option in this chapter for more detail on this option. 

Login... 

This option opens the Login Dialog Box, which enables you to log into any 
KWS database that you have setup via the Admin Menu, Database, Setup 
Database Connections option. See Logging in to KWS in this chapter for 
more detail on this option. 

Print 

This option is a single action command that sends the contents of the active 
window to the default printer specified in the Windows Control Panel. KWS 
will format the pages using the current page formatting setup. 
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• Show Status Bat 

>/ Show Button Bar 

Save Window Configuration Ctrl+S 

Display Fent... 

Printer Fon.t... 

Printer £age Setup... 

Applications List., 

Associations... 

File Viewer... 

WWW Browser... 

FAX... 

Preferences 

This option opens a submenu containing further options for customizing the 
appearance of the KWS Program Window, setting font and print options, and 
defining information for manipulating attachments. See Chapter 7, 
Customizing KWS, for more detail on setting preferences. 

System Options 

This option allows you to specify prompts for non-working days and 
notifications. The default action for a task due on a non-working day 
is set here. See Chapter 3, Tasks and Steps, for more on non- 
working days. Additionally, if the Notifications check box is marked 
the Notifications Window will be opened at KWS startup when the 
user has new notifications. See the Notifications section later in this 
chapter for more details on this option. 

Show Status Bar 

This option allows you to specify whether the Status Bar will be 
displayed in the KWS Program Window. If the Show Status Bar 
option has a check mark next to it, the Status Bar will be displayed. 
If not checked, it will not be displayed. 

Show Button Bar 

This option allows you to specify whether the Button Bar will be 
displayed in the KWS Program Window. If the Show Button Bar 
option has a check mark next to it, the Button Bar will be displayed. 
If not checked, it will not be displayed. 

Save Window Configuration 

This option allows you to save the current window configuration 
within KWS. When checked, this action will save the current size 
and location of all windows in the KWS workspace. These windows 
will then be displayed each time you log in to KWS until you save a 
new configuration. The contents of a Graphical Task Manager 
Window, attachment query windows, and Do It search windows are 
not saved. 

Display Font... 

This option allows you to select the font, font style, and font size 
displayed in your KWS windows. 

Printer Font... 

This option allows you to select the font, font style, and font size in 
which the content of text-based KWS windows will be printed. 

Printer Page Setup. 
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This option allows you to set some standard Windows page setup 
options such as page width and length, margins, headers, and footers. 

Applications List 

This option enables you to define the information KWS requires 
before it can launch the application program used to create or edit an 
attachment. See Chapter 7, Customizing KWS, for more detail on 
this option. 

Associations 

This option enables you to define Windows File Manager association 
information. When importing attachment files, KWS uses this 
information to determine the associated application. See Chapter 7, 
Customizing KWS, for more detail on this option. 

File Viewer 

This option allows you to specify the file viewer that KWS will use 
to view attachments. A File Viewer is a software package that 
displays the contents of a file as it would normally be displayed in 
the application that created it. If a File Viewer is not specified, you 
will not be able to view an attachment without the application 
package used to create it. See Chapter 7, Customizing KWS, for 
more detail on this option. 

WWW Browser 

This option allows you to specify the WWW browser that KWS will 
use to view WWW attachments. If a WWW Browser is not 
specified, you will not be able to view a WWW attachment without 
the application package used to create it. See Chapter 7, 
Customizing KWS for more detail on this option. 

Fax 

This option allows you to specify the Fax program that KWS will 
use to fax an attachment. If a Fax program is not specified, you will 
not be able to send attachments as faxes. See Chapter 7, 
Customizing KWS, for more detail on this option. 

Exit KWS 

This option is a single action command that closes the KWS application. It 
has the same effect as double-clicking on the File Menu Box in the upper-left 
corner of the KWS Program Window. 
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The Edit Menu 

The Edit Menu contains options that enable you to copy and paste text from 
KWS windows and to select items within KWS windows. 

Paste       Ctrl+V 

Select All F3 
Copy 

This option will copy the selected items to the clipboard. 

Paste 

This option will insert the contents of the clipboard into the current window. 

Select All 

This option is a single-action command that causes all items in the active 
window to be highlighted. Select All is used to perform an operation such as 
moving or deleting all of the items in a window. Multiple items in a window 
can be selected by using Select All, and then deselecting specific items by 
clicking on them. 

The Query Menu 

Do Its ► 
lasks ► 
S earch T ext in Window   ► 

Last 20 Attachments Accessed 

The Query Menu contains options that enable you to search attachments, 
Do Its, tasks, and window text. 

Attachments 

This option displays a submenu containing options for searching 
Attachments. See Searching Attachments in Chapter 4, Attachments, for 
detail on this option. 

Attachment Search 

This option opens the Attachment Search Dialog Box, which 
provides options that enable you to locate attachments by specifying 
search criteria. 

Last 20 Attachments Accessed 

This option opens an Attachment window listing the last 20 
attachments accessed by the user. 

Do It Search 

Time-Contingent Do Its 

Dolts 

This option displays a submenu containing options for searching Do Its and 
Time-Contingent Do Its. See Do Its in Chapter 5, Do Its, for detail on this 
option. 

Do It Search 

This option opens the Do It Search Dialog Box, which enables you 
to locate Do Its by specifying search criteria. 



KWS Ver 3.6 Reference Guide 1-7 

Time-Contingent Do Its 

This option will start the KWS TimeAgent program. See Time 
Agents in Chapter 5, Do Its, for more detail on this program. 

Custom Queries 

Tasks 

This option displays a submenu containing all of the predefined and custom 
database queries available within KWS. Selecting a specific query will 
cause it to execute against the KWS database. The results of the query are 
displayed in a Task Window. 

Standard Queries 

This option displays a submenu containing all of the standard queries 
defined in KWS. 

Search Next-     Shift+K; 
Search Previous Alt+F2 

Custom Queries 

This option displays a submenu containing all of the database 
queries defined by the KWS administrator that are available within 
KWS. 

Search Text in Windows 

This option opens a submenu containing options to search for text strings 
within the active window. See Searching Windows for Text Strings in this 
chapter for more detail on using this option. 

Search 

This option opens a Search Dialog Box where you can enter text that 
you would like to find within the active window. 

Search Next 

This option searches for the next occurrence of the text string you 
last entered in the Search Dialog Box. 

Search Previous 

This option searches for the previous occurrence of the text string 
you last entered in the Search Dialog Box. 

The Task Menu 

graphical Task Manager 

Task Palette Manager 

Milestones 

The Task Menu contains options that enable you to view the processes and 
milestones defined for your organization in a textual or graphical format. 

Task Manager 

This option displays the processes defined for your organization in a split- 
screen window, or Multiple Document Interface (MDI). The MDI enables 
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you to browse through a textual representation of the entire task hierarchy 
by moving between the different levels. See The Task Manager in Chapter 
3, Tasks and Steps, for more detail on using this window. 

Task Palette Manager 

This option opens the Task Palette Manager window that allows you to edit 
the palette processes defined for your organization. See Task Palette 
Manager in Chapter 6, Task Palette, for more detail on this option. 

(1)        Graphical Task Manager 

This option displays the processes defined for your organization in a 
graphical format. See the Graphical Task Manager in Chapter 3, Tasks and 
Steps, for more detail on this option. 

Milestones 

This option opens the Milestones List Box. See Milestones in Chapter 3, 
Tasks and Steps, for more detail on this option. 

The ToDo Menu 

T oD o: Completed Items 

ToDo: Ongoing Items 

ToDo Calendar r; 

ToDo Graph 

ToDo Context Graph 

ToDo Browser 

Workload 

The ToDo Menu options enable you to list the tasks assigned to you that meet 
specific criteria. See Options for Viewing the ToDo List in Chapter 2 for more 
details on these options. 

ToDo 

This option opens a ToDo Window that lists tasks that have not been marked 
as Finished and that have been assigned to you and any work group(s) of 
which you are a member. 

ToDo: Completed Items 

This option opens a ToDo: Completed Items Window that lists tasks that 
have been marked as either Finished or Overcome by Events (OBE) and 
that have been assigned to you and any work group(s) of which you are a 
member. 

ToDo: Ongoing Items 

This option opens a ToDo: Ongoing Items Window that lists tasks that have 
not been assigned a due date. This type of task is also called an "Ongoing 
Item " and is displayed with a blank line in the Date Due field. 

ToDo Calendar 

This option opens a ToDo Calendar Window that unites your ToDo List and 
Appointment List with an interactive calendar. The ToDo and Appointment 
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List contents are dependent on the date(s) selected on the calendar. The 
tasks and appointments with a start date prior to or on the same day as the 
current date will appear in the ToDo List. In addition, any tasks with a due 
date earlier than the current date that have not been marked Finished or 
OBE will be displayed in red, which indicates that the tasks are late. 

ToDo Graph 

This option opens a ToDo Graph (TDG) Window that displays the tasks in 
your To Do List in a graphical Gantt chart format. 
ToDo Graph 

ToDo Context Graph 

This option opens a ToDo Context Graph Window that displays the tasks in 
your To Do List and the processes that contain these tasks in a graphical 
Gantt chart format. 

ToDo Browser 

This option opens a ToDo Browser Window that lists all tasks assigned to 
you. This window displays the task information in an MDI format. 

Workload 

This option opens the Workload Dialog Box that graphically displays your 
workload level. 

The Admin Menu 

Database&nnectibris 
: Mästet application List... 

Custom ToDoQuetiBS - 

'A[<rf^ Attachments j.<V] 
: Database. Egpott/lmportjj 

I Database Maintenance.^ 
: Database Setup -'/.j 

I listEntie Database '■/ ''- v 

Ust£etectedT-ask\; 
1 Reconcte Remote Changes 

: Archive Selected Task 
Archive Manager   • 

The Admin Menu contains several options that enable you to view and 
update information about the knowledge workers and work groups in your 
organization, modify your KWS database setup, setup the Master 
Application List, and generate a file that lists a selected task or the entire 
KWS Database. If you have System Administration Access rights, other 
options will also be available. 

Knowledge Workers 

This option opens a Knowledge Worker Window that displays a list of all 
KWS User IDs in an organization. From this window, User IDs can be 
added, deleted, and modified; Information Profiles can be viewed and 
updated; and a list of work groups containing a specific User ID can be 
generated. See Knowledge Workers and Work Groups in Chapter 7, 
Customizing KWS, for more detail on using this option. 

Work Groups 

This option opens a Work Groups Window. In the upper workspace, a list of 
organizations in the KWS Database is displayed. In the lower workspace, 
the Work Groups List for a selected organization is displayed. Work groups 
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can be viewed, edited, and deleted from this window. See Knowledge 
Workers and Work Groups in Chapter 7, Customizing KWS, for more detail 
on using this option. 

Database Connections 

This option creates the KWS Databases Window which is used for setting up 
a user's database and attachment connections. See KWS Database and File 
Storage Setup in Chapter 7, Customizing KWS, for more detail on using this 
option. 

Master Applications List 

This option enables a user with System Administrator access rights to set up 
the Master Application List used for accessing attachments within KWS. 

Custom ToDo Queries 

This option opens the Queries: ToDo Window used to define and edit custom 
queries for the organization. See Creating Queries in Chapter 7, 
Customizing KWS, for more information on this option. 

Archive Attachments 

This option starts the attachment archive function. This operation will search 
the database and archive or delete any attachments that meet the criteria you 
specify pertaining to the disposition of your attachments. See Archiving 
Attachments in Chapter 7, Customizing KWS, for more information. 

Database Export/Import 

This option displays a submenu which contains options for exporting and 
importing portions of the KWS database. See KWS Database and File 
Storage Setup in Chapter 7, Customizing KWS, for more detail on using this 
option. 

Database Maintenance 

This option displays a submenu which contains options which can be used by 
a system administrator to perform maintenance operations on the KWS 
database. See KWS Database and File Storage Setup in Chapter 7, 
Customizing KWS, for more detail on using this option. 

Database Setup 

This option displays a submenu which contains options for setting attributes 
of the current database or for creating a new database. See KWS Database 
and File Storage Setup in Chapter 7, Customizing KWS, for more detail on 
using this option. 
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Listing of Entire Database 

This option prints a hierarchical list of all public tasks for your organization. 
This list includes all processes, their subordinate tasks, and any steps, 
attachments, and Do Its associated with each task in this list. 

Listing of Selected Task 

This option prints a hierarchical list of a specific task that you have selected 
in the task window. This list includes all the subordinate tasks and any steps, 
attachments, and Do Its associated with each task. 

Reconcile Remote Changes 

This option reconciles all remote changes that have been made by the current 
user. See KWS Database and File Storage Setup in Chapter 7, Customizing 
KWS, for more detail on using this option. 

The Notes Command 
This command opens a Windows Notes file that has been created by KWS. 
It provides a quick scratch pad for recording information. See The Notes 
Command in this chapter for more detail on this command. 

The Tools Menu 

Task Palette 

lime Agent 

Do It Base 

Converter 

Notepad 

The Tools Menu contains options that enable you to access KWS-related 
applications. The Tools Menu always includes four options: Task Palette, 
the TimeAgent, DoltBase, and the Converter. In addition, you may add 
items to the menu. See Adding Items to the Tools Menu in Chapter 7, 
Customizing KWS, for more detail. 

Task Palette 

This option opens the KWS Task Palette application. See Chapter 6, The 
Task Palette, for more detail on this option. 

TimeAgent 

This option opens the KWS TimeAgent application. See Time Agents in 
Chapter 5, Do Its, for more detail on this option. 

DoltBase 

This option opens the KWS DoltBase application. See Dolt Base in Chapter 
5, Do Its, for more detail on this option. 

Converter 

This option opens the KWS Converter application. See KWS Converter in 
Chapter 7 for more detail on this option. 
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The Window Menu 

Jje 

Auange Icons 
Close 

Close 01 

Shifltf4 

Options 

fiispla)" Field Setip 
Erintet Field Setip 
fleftesh 

IKWSOipboard 

2 Graphical Task Manager 
«/ 3 ToDo Calendar. JONES M 

The Window Menu contains several options that enable you to change the 
arrangement of the open windows on the screen, customize data field 
arrangement, refresh the screen, and view a list of open KWS windows. 

Cascade 

This option rearranges all open KWS windows in overlapping order, starting 
from the top-left comer of the KWS Program Window workspace, with the 
Title Bar of each window visible. 

Tile 

This option rearranges all open KWS windows in a side-by-side, grid-like 
pattern, adjusting the size of each window accordingly. 

Arrange Icons 

This option arranges all KWS icons present in the workspace along the 
bottom edge of the workspace area. 

Close 

This option closes the currently active window. 

Close All 

This option closes all open windows in KWS and exits the program. 

Options 

This option displays a submenu that enables the user to set preferences for 
displaying information in the active window. 

Display Field Setup 

This option enables you to choose which data is displayed within the active 
window, the order of the data displayed, the width of the data displayed, and 
whether the text in a data field should wrap around to the next line. See 
Display Field Setup in Chapter 7, Customizing KWS, for more detail. 

Printer Field Setup 

This option enables you to decide which data is printed from the active 
window, the order of the data printed, the width of the data printed, and 
whether the text in a data field should wrap around to the next line. See 
Display Field Setup in Chapter 7, Customizing KWS, for more detail. 
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Refresh 

This option refreshes the contents of the active window. This action may be 
necessary for updating the contents of a window when you return to it after 
you have made changes to the KWS database in another active window. 

Save Changes 

This option saves any task modifications that have been made within a 
graphical task window. Because the graphical view does not immediately 
post data modifications to the database, it is necessary to manually instruct 
the system to save your work periodically. This option is only available 
when the active window is a graphical task window—the Graphical Task 
Manager or ToDo Graph. 

List of Open Windows 

A list of all the windows open within KWS is shown at the bottom of the 
Window Menu options. A check mark is displayed next to the active 
window. You can change the active window by clicking on the desired 
window title in this list. 

The Help Menu 

Search for Help oa. 
How to Use Help 

About KWS.. 

The Help Menu contains several options that enable the user to access on- 
line information about KWS and its operating environment. 

Contents 

This option displays a table of contents for on-line KWS help information. 
The user can click on a specific item within the table of contents to access 
more detailed information on that item. 

Search for Help on... 

This option opens a Search window that enables you to search for on-line 
KWS help information by entering a text string. 

How To Use Help 

This option provides information on how to use the KWS help feature. 

About KWS... 

This option is a single-action command that displays the About KWS 
Message Box, which contains information about the KWS developers, the 
KWS contract number, and the current version number. 
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Button Bar Options 
The Button Bar provides quick access to the KWS functions that are 
available for the active window. The options available in the Button Bar 
depend on the type of window that is active. 

Task Window Button Options 

When the active window is a Task Window, a button bar is displayed with 
buttons titled: Insert, Delete, Modify, Steps, Attach, Do It, Pred, and Succ. 
See Chapter 3, Tasks and Steps, for more detail on these options. 

Insert 

This button opens a Task Dialog Box, which enables you to add a new task 
to the KWS Database. 

Delete 

This button enables you to remove a task from the KWS Database. 

Remember that deleting a task deletes all of its children, Attachments, Steps 
and Do Its. Use this command with caution. 

Modify 

This button opens the Task Dialog Box, which enables you to edit task 
information. 

Steps 

This button opens a Steps Window, which enables you to access the steps 
you should complete in order to perform the selected task. 

Attach 

This button opens the Attachment Window and enables you to access 
attachments linked to the selected task. 

Dolt 

This button opens a Do Its Window and enables you to access Do Its linked 
to the selected task. 

Pred 

This button opens a Predecessor Window and enables you to access the tasks 
that must be completed before the selected task may be started. 

Succ 

This button opens a Successor Window and enables you to access the tasks 
that may not be started until the selected task has been completed. 
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Notifications Window Button Options   

When the active window is a Notifications Window, a Button Bar is 
displayed with buttons titled: Send, Delete, Modify, and Received. See The 
Notifications Option in this chapter for more detail. 

Send 

This button opens the Notification Dialog Box, which enables you to send a 
KWS-related message to another KWS user. 

This option is not intended to replace E-mail messaging. It should only be 
used for KWS-specific messages. 

Delete 

This button enables you to remove a message from the Notifications 
Window. 

Modify 

This button opens the Notification Dialog Box, which enables you to edit an 
existing message. 

Received 

This button enables you to mark a message received, which changes the 
display color of the message 

Attachments Window Button Options 

When the active window is an Attachments Window, a button bar is 
displayed with buttons titled: Insert, Delete, Profile, View, Edit, Export, 
Copy, Version, Check Out, and Check In. See Chapter 4, Attachments, for 
more detail on these options. 

Insert 

This button opens the Attachment Insert Dialog Box, which enables you to 
create or import an attachment. 

Delete 

This button enables you to remove the selected attachment from the 
Attachment Window. 

Profile 

This button opens an Attachment Profile Window for the selected 
attachment, which enables you to view or update information for an 
attachment. 
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View 

This option enables you to view the contents of a selected attachment by 
launching your file viewer application with the attachment file. 

Edit 

This button enables you to edit the contents of a selected attachment by 
launching the application defined in the attachment's profile with the 
attachment file. 

Export 

This button opens a File Save Dialog Box, which enables you to save the 
attachment to a user-specified file name and location. 

Copy 

This button enables you to make a new copy of the selected attachment and 
link it to the selected task within the active Attachment Window. 

Version 

This button enables you to make a new copy of the selected attachment with 
the same name and link it to the selected task. 

Check Out 

This button opens the Check Out Attachment Dialog Box, which enables you 
to check out an attachment document. 

Check In 

This button opens the Check In Attachment Dialog Box, which enables you 
to check in a previously checked out attachment document. 

Do Its Window Button Options 

When the active window is a Do Its Window, a button bar is displayed with 
buttons titled: Insert, Delete, Modify, and Execute. See Chapter 5, Do Its, 
for more detail on these options. 

Insert 

This button opens the Do It Dialog Box, which enables you to link a Do It to 
the selected task. 

Delete 

This button enables you to remove the selected Do It from the active Do It 
Window. 
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Modify 

This button opens a Do It Dialog Box, which enables you to edit information 
pertaining to the selected Do It. 

Execute 

This button launches the selected Do It. 

Knowledge Worker Window Button Options  

When the active window is a Knowledge Worker Window, a button bar is 
displayed with buttons titled: Insert, Delete, Modify, and Work Groups. See 
Knowledge Workers and Work Groups in Chapter 7, Customizing KWS, for 
more detail on these options. 

Insert 

This button opens a Knowledge Worker Dialog Box, which allows you to 
add a new User ID to the KWS Database. This option is only available to 
users with System Administrator privileges. 

Delete 

This button will remove the selected User ID from the KWS Database. This 
option is only available to users with System Administrator privileges. 

Modify 

This button opens a Knowledge Worker Dialog Box, which enables you to 
view and edit User ID information. Only a user with System Administrator 
privileges can modify all User ID information. 

Work Groups 

This button opens a Work Groups Window that displays a list of all the work 
groups to which the selected User ID has been assigned. 

ToDo 

This button opens the ToDo list for the selected User ID. 

Reassign 

This button opens the Reassign Dialog Box, which enables you to reassign 
all of a user's tasks. This option is available only to KWS Administrators. 

[Use the ToDo list available through the Knowledge Worker Window when 
j reassigning tasks.    
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KWS Database Window Button Options 

When the active window is a KWS Database Window, a button bar is 
displayed with buttons titled: Insert, Delete, and Modify. See KWS 
Database and File Storage Setup in Chapter 7, Customizing KWS, for more 
detail on these options. 

Insert 

This button opens the KWS Database Setup Dialog Box, which enables you 
to insert a new KWS database definition. 

Delete 

This button enables you to remove the selected KWS database definition 
from the KWS Database Window. 

Modify 

This button opens the KWS Database Setup Dialog Box, which enables you 
to edit the selected KWS database definition. 

The Available Options Menu 
The Available Option Menu is a pull-down menu enables you to access the 
KWS functions available for the active window. Most options in the 
Available Options Menu duplicate options in the Button Bar. Occasionally, 
however,, additional options may be included in the Available Options 
Menu that are not in the Button Bar. These exceptions are made based on 
display space constraints. 

The Available Options Menu is accessible from the Task, Task Manager, 
Steps, Attachment, Do It, Milestone, Appointment, and Messages windows 
in KWS. The options included in the menu are dependent on the window 
type. 

Opening the Available       To open the Available Options Menu: 
Options Menu 

Select an item in the window and click once on the right mouse button. 

or.. 

Select an item in the window and press the [Enter] key. 
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Task Window Available Options 

Attachment...   ► 

Dolt.. ► 
Predecessors 

Successors 

Parent 

Siblings 

Description 
Reassign 

Modify 
Delete 
Graph 

The options in the Available Options Menu for a Task Window include 
Steps, Attachment..., Do It..., Predecessors, Successors, Parent, 
Siblings, Description, Modify, Delete, and Graph. Parent, Siblings, 
Description, and Graph are additional options not included in the Button 
Bar for the Task Window. The Attachment... and Do It... options also 
provide the capability to search Attachments and Do Its. 

Steps 

This option opens a Steps Window and enables the user to access Steps 
associated with performing the selected task. See Steps in Chapter 3, Tasks 

and Steps, for more detail on this option. 

Attachment Manager 

Search Attachments 

Workflow ► 

Attachment... 

This option displays a pull-down menu that lists the options: Attachment 

Manager, Search Attachments, and Workflow. 

Attachment Manager 

This option opens the Attachments Window, which enables you to 
access Attachments associated with the selected task. 

Search Attachments 

This option opens the Attachment Search Window, which enables 
you to enter search criteria for locating attachments. This option is 
also available from the Query Menu, Attachment Search option. 
See Searching Attachments in Chapter 4, Attachments, for more 

detail. 

Workflow 

This option displays the Workflow pull-down menu where you can 
select a graphical view of workflow between attachments. See 
Chapter 4, Attachments, for more information on this option. 

Edit Do It List 

Search Do Its 

Do It... 

This option displays a pull-down menu with the options: Edit Do It List, and 

Search Do Its. 

Edit Do It List 

This option opens the Do It Window, which enables you to access 
Do Its associated with the selected task. 
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Search Do Its 

This option opens the Do It Search Window, which enables you to 
locate Do Its by entering search criteria. This option is also available 
from the Query Menu, Do It Search option.   See Chapter 5, Do Its, 
for more detail on this option. 

Predecessors 

This option opens a Predecessor Window, which enables you to access 
Predecessor tasks associated with the selected task. 

Successors 

This option opens a Successor Window, which enables you to access 
successor tasks associated with the selected task. 

Parent 

This option opens a Task Window that contains the task's parent and the 
parent's sibling tasks. The parent task will be highlighted. 

Siblings 

This option opens a Task Window that contains a list that includes the task 
and its siblings. 

Description 

This option displays the Description Dialog Box and enables you to view, 
enter, or edit a short description of the selected task. 

Reassign 

This option displays the Reassign Tasks Dialog Box and enables you to 
reassign the selected task. 

Modify 

This option opens the Task Dialog Box, which enables you to edit task 
information. 

Delete 

This option enables you to remove a task from the KWS Database. 

Remember that deleting a task deletes all its children, attachments, steps, and 
Do Its. Use this command with caution. 

Graph 

This option opens a Graphical Task Manager Window with the selected task 
displayed. 
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Attachment Window Available Options 

Attachment... 

Dolt.. 
Predecessors 
Successors 
Parent 
Siblings 
Description 
Reassign 

Modify 
Dejete 
Graph 

The options in the Available Options Menu for an Attachment Window 
include View, Edit, Export, Copy, Version, Check Out/Check In, Links, 
Profile, Delete, and Define Workflow. The Define Workflow option is the 
only additional option not included in the Button Bar for the Attachment 
Window. See Chapter 4, Attachments, for more details on these options. 

View 

This option enables you to view the contents of a selected attachment by 
launching your file viewer application with the attachment file. 

Edit 

This option enables you to edit the contents of a selected attachment by 
launching the application defined in the attachment's profile with the 
Attachment file. 

Export 

This option opens a File Save Dialog Box, which enables you to save the 
attachment to your specified filename and location. 

Copy 

This option enables you to make a new copy of the selected attachment and 
link it to the selected task. 

Version 

This option enables you to make a new copy of the selected attachment with 
the same title, link it to the selected task, and increment the version number 
by one. 

Check Out 

This option opens the Check Out Attachment Dialog Box, which enables you 
to register an attachment document as "checked out." 

Check In 

This option opens the Check In Attachment Dialog Box, which enables you 
to register a previously checked out attachment document as "checked in." 

Links 

This option opens the Attachment Links Dialog Box, which list all tasks that 
have attachment links to the currently selected attachment. It also allows you 
to move directly to the tasks in which the document is linked. 
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Profile 

This option opens an Attachment Profile Window for the selected task, 
which enables you to view or update information for the attachment. 

Delete 

This option enables you to remove the selected attachment from the 
Attachment Window. 

Define Workflow 

This option opens the Workflow Definition Dialog Box and enables you to 
setup a workflow path for the selected attachment. 

SELECTING MULTIPLE WINDOW ITEMS 
At times you may want to perform an action (e.g., Move, Copy, Delete) on 
more than one item in a window. KWS provides this capability through the 
Multiple Item Select Feature. 

***  Selecting Multiple Items     To select multiple items in a window: 
in a Window 

1. Open the window from which you want to select multiple items. 

2. While holding the [Ctrl] key down, click on each item that you want to 
select. As you select each item, it will be highlighted. Alternatively, 
holding down the [Shift] key and clicking on an item will select a 
contiguous block of items from the last item selected to the current item. 

To select all items in a window: 

1. Open the window from which you want to select all items. 

2. Select the Edit Menu and then the Select All option. All items in the 
window will be highlighted. 

To deselect items in a window: 

While holding the [Shift] key down, click on the item that you want to 
deselect. The item will no longer be highlighted. 

Performing Actions on 
Multiple Items in a 
Window 

When multiple items are selected, the Multiple Item Indicator, a small red 
square, appears in the upper left corner of the active window. 

To perform actions on multiple items in a window: 

1. Select the multiple items to which you want to perform an action. 

2. Select the action you want to perform. 
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To drag multiple items to another window: 

1. Select the multiple items that you want to drag. 

2. Click on the Multiple Item Indicator and while holding the mouse button 
down drag it to the desired location. 

When performing a multiple-item delete, KWS will warn you that multiple 
items are selected and will ask for confirmation of the deletion. Multiple- 
item deletes are available in all windows except the Organization window 
and the Knowledge Worker window. Use cautiously! 

SEARCHING WINDOWS FOR TEXT STRINGS 
KWS enables you to search for text strings contained within the active 
window. This capability is useful when you need to find a specific item or 
items in a window quickly without having to scroll through the window to 
locate it. 

Searching for Text 
Strings in a Window 

Search Next       Shift+F2 
Search Previous AII+F2 

To search for text strings in a window: 

1. From the Query Menu, select the Search Text in Window option. A 
pull-down menu will display with the options Search..., Search Next, 
and Search Previous. 

2. To begin your search, select the Search... option. The Search Dialog 
Box will display (Figure 1-2). 

Search 

Search For: 

Search Fields: 

F All Fields 

Title 
Version 
Storage 
Sensitive 
Application 
Original File 
Created By 
Date Created 
Last Edit By 
Last Edit Date 
Nurn 

• Find  

C Next Match 

C Previous Match 
<• All Matches In Window 

I"" Select Items With Match 

R Clear Previous Searches 

P Match Case 

OK Cancel 

Figure 1-2: Search Window 
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3. Enter the text string for which you want to search in the Search For 
data field. 

4. Select the data fields from which you want to search by clicking on the 
field name in the Search Fields list. To search all fields click within the 
All Fields checkbox. 

5. Limit your search by selecting your desired option in the Find area of 
the Dialog Box where the options are defined as follows: 

Next Match Search those items listed after a selected 
task. 

Previous Match Search those items listed prior to a selected 
task. 

All Matches in Search all items in the window that contain 
Window the text string. 

6. (Optional) Specify whether you want to select the item(s) that contain 
matching text strings by checking the Select Items With Match 
checkbox. 

7. (Optional) Specify whether you want to clear all previous searches 
within the window by checking the Clear Previous Searches checkbox. 

8. (Optional) Specify whether the search is to be case-sensitive by checking 
the Match Case checkbox. 

9. Click OK. Search results will display in the current window by 
highlighting the specified text string within the item's title. If you 
checked the Select Items With Match option, each item with a match 
will be selected. 

THE NOTIFICATIONS OPTION 
KWS automatically notifies you through the Notifications option when there 
has been a change to the database that may affect you. These system- 
generated messages let you know when another user has assigned a task to 
you, deleted an assigned task, or performed some similar action. In addition, 
you may use the Notifications option to send KWS-related messages to 
another user. 

Each time you log in to KWS, the system Ghecks your message list. If you 
have new notifications, the Notifications Window will open (Figure 1-3). 

Accessing Notifications      To access Notifications: 

1.   Select File from the KWS Menu Bar. 
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2.   In the File Menu, select Notifications. The Notifications Window will 
display (Figure 1-3) along with its associated button bar (Figure 1-4). 

ft Notifications:  KAPPES_S 

Date Sent From 

16Mar98 
16Mar98 

To 

THOMAS B 

Figure 1-3: The Notifications Window 

Subject 

KAPPES S Task Reassignment 
THOMAS B        KAPPES S Revised Due Date 

Jj 

The Notifications Window contains the following data fields. 

Reading Notifications 

Date Sent 

From 

To 

Subject 

Message 

The date the message was generated. 

The KWS User ID that generated the message. 

The KWS User ID to receive the message. 

A short description of the message contents. 

The text of the message. 

Unread messages are listed in the order of Date Sent and are displayed 
in red. Notifications that have been marked Received are at the bottom 
of the list in the order of Date Sent and are displayed in black. 

!*Send, Delete Modify Received      ■   '"\ 

Figure 1-4: The Notifications Window Button Bar 

The Notifications Window button bar contains the options Send, Delete, 
Modify, and Received. These options are available whenever the 
Notifications Window is active. 

The Notifications Window also has an associated Available Options 
Menu, which can be accessed by clicking the right mouse button. The 
menu options are Modify and Delete. 

To read Notifications: 

1. Select the message you want to read. 

2. Click the Modify button. The Notification Dialog Box will be displayed 

3. Click OK. 

Marking a Notification      To mark a Notification received: 
Received 
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Select the notification to be marked received and click the Received button. 

or... 

While reading the message, check the Received box in the upper left area of 
the Notification Dialog Box and click OK. 

*> Modifying a Notification    To modify a Notification: 

1. Select the notification to be modified. 

2. Click the Modify button. The Notification Dialog Box will display. 

3. Enter your desired modifications. 

4. Click OK to save. 

*> Deleting a Notification      To delete a Notification: 

1. Select the notification to be deleted. 

2. Click the Delete button. The Delete? Dialog Box will display. 

3. Click Yes. The Notification will be removed from the Notifications 
Window. 
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Sending a Notification       To send a Notification: 

1. Select File, Notifications from the KWS Menu Bar to open the 
Notifications Window. 

2. Click the Send button. The Notifications Dialog Box will be displayed. 

Canceli 

Notification 
r Received ..I"" Send As Email. 

from KAPPES_S-';-f.  ■'■■''■'...DateSent/03Nov39 

Knowledge Workers    ■•   ■   Groups Ema3 Addresses  Addr Book 
To: CINDY 

CINDY4 
A. 

KAPPES S 
KWS1 
MIKE2 _J 

MIKE3 d MIKFi 

GR0UP6 Si 
GR0UP7 
GR0UP8 
GROUPS 
IDS 
TESTGRP — 

\M. smith@edi. gatech. edlaj 

Attachments: 

Subject 

Figure 1-5: The Notifications Dialog Box 

a 

51 

Sending a Notification 
as E-mail 

3. Enter values for the To, Subject, and Message data fields into the 
Notifications Dialog Box. 

4. Click OK. 

To send a Notification as email: 

1. Select File, Notifications from the KWS Menu Bar to open the Notifications 
Window. 

2. Click the Send button. The Notifications Dialog Box will display. 

3. Enter values for the To, Subject, and Message data fields into the 
Notifications Dialog Box. 
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4. Click the Send as Email check box. 

5. Click OK. 

To send a notification as email, two conditions are required: you must have 
(1) a MAPI compliant email program currently running, and (2) an email 
address for the knowledge worker defined through the Knowledge Worker 
Admin menu. Check with your KWS Administrator for help in setting up 
this option. 

This option is not intended to replace email messaging. It should only be 
used for KWS-specific messages. 

Sending a Notification 
To Multiple Recipients 

The Notifications dialog box allows multiple knowledge workers, 
workgroups, and email addresses to be specified as recipients. 

To send a Notification to multiple recipients: 

1. In the Notifications dialog box, press Ctrl and click on each knowledge 
worker in the Knowledge Workers list who is to receive the 
Notification. 

2. Press Ctrl-Click to select each workgroup in the Groups list to receive 
the Notification. 

3. Enter one or more email addresses in the Email Addresses edit box. 

4. Enter your subject and text. 

5. Click OK. 

Attaching Files to a 
Notification 

One or more files can be attached to a Notification being sent to an email 
address or to a knowledge worker who receives Notifications as email. Files 
cannot be attached to Notifications sent strictly within KWS. 

To attach one or more files to a Notification: 

1. In the Notifications dialog box, enter a full path and file name in the 
Attachments edit box. Multiple file names can be entered if a comma 
separates each. A file can be selected by clicking on the File Selection 
button to the right of the edit box. 

2. Complete the remaining fields of the Notification and click OK. 
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*!* Selecting Email 
Recipients Using the 
Address Book 

Clicking the Addr Book button on the Notifications Dialog box allows you 
to use the Address Book feature of your email system to select email 
recipients. This feature is only available if your email system is MAPI 
compliant. 

To select email recipients using the Address Book: 

1. In the Notifications dialog box, click the Addr Book button. The address book 
window for your email system will appear. 

2. After specifying the list of recipients using the address book, click OK. 

3. The list of recipients will appear in the Email Addresses box of the 
Notifications dialog box. 

THE NOTES COMMAND 

Accessing Notes 

Modifying Notes 

KWS provides quick access to a Windows Notepad document via the Notes 
command. This feature is useful when you need a quick scratchpad to record 
information while working within KWS. This document will not be linked to 
a specific task; the Attachment option is available for that purpose. 

To access the Notes option: 

Select Notes from the KWS Menu Bar. Windows Notepad will open. 

If this is the first time you selected the Notes command, a new file will be 
created for you and given a name generated from your KWS User ID. 
Otherwise, your previously created file will be displayed. This file is stored 
on your workstation and is only accessible from that workstation when you 
log in using your KWS User ID. 

Because the Notes command uses the Windows Notepad, if you have a 
Notes file open and then click any KWS window, your Notes file will be 
placed behind the KWS Program Window but will remain open. If you 
select the Notes command in KWS again while your Notes file is still open, 
Notepad will open your last saved version of your Notes file. So be careful 
not to open multiple instances of Notepad with the Notes command. To 
determine if you already have Notepad open, you can use the standard 
Windows key sequence [CTRL-ESC] to view a list of open applications. 

You may enter and edit text into your Notes file using the Windows Notepad 
commands and features. When you want to exit, save your information by 
using the File, Save command within Notepad and exit by using the File, 
Exit command. If you attempt to exit Notepad without saving your file, 
Notepad will display a message that asks if you want to save your text 
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LOGGING IN TO KWS 

* Starting KWS 

*> Logging in to KWS 

To start KWS: 

Double-click the KWS icon in your Windows Program Manager. The KWS 
application will open with the Knowledge Worker System Login Dialog Box 
displayed in the KWS Program Window. 

You must have a KWS User ID and password before you can log in to 
KWS. If you do not have these, see your KWS System Administrator. 

To login to KWS: 

1. Start KWS. The KWS Login Dialog Box will be displayed. 

2. Select the KWS database to which you want to log in by clicking the small right 
arrow to the left of the Database field and selecting from the list provided. 

3. Enter your User ID and Password. 

4. Click OK. 

Letting Another User 
Login to KWS 

| Your System Administrator can enable you to automatically log in to KWS 
j when you start the application. For security reasons, this is generally not 
| recommended since anyone will be able to log in with your User ID by 
i starting KWS from your workstation. 

You may let someone else log in to KWS from your workstation without 
exiting KWS. By doing this, you will no longer be logged in, but you may 
log in again in the same manner. 

When you are logged in to KWS and you then let another user log in, all of 
the KWS windows that you have open will remain open after the new login. 
Any windows opened by the new log in User ID will be associated with the 
new User ID. However, your remaining windows will still be associated 
with your User ID. If the new user accesses your open windows, the 
information retrieved in them will be the same as if you were logged in. For 
example, suppose you are logged in with your User ID and have your ToDo 
Calendar Window open. If you let another user log in and they open their 
ToDo Calendar window, the ToDo items assigned to them will be listed. If 
the new user then opens a Task Window; assigns a task to your ID; accesses 
your open ToDo Calendar; and refreshes the list, the new task will appear in 
your ToDo list. This capability is very useful when building process 
models. However, at any other time it is recommended that you close all of 
your open windows before allowing another user to login. 
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To log in as another user while KWS is open: 

1. Select File from the KWS Menu Bar. 

2. Select Login from the File Menu. The KWS Login Dialog Box will display. 

3. Select the KWS database to which you want to log in by clicking the small right 
arrow to the left of the Database field and selecting from the list provided. 

4. Enter your User ID and Password. Click OK. 

REFRESHING INFORMATION IN KWS WINDOWS  
At times, you may need to update the information displayed in an open KWS 
window. For example, if you assign a new task to yourself in the Task 
Manager and then return to your ToDo List, the new task will not be 
displayed until you update the information. This update is referred to as 
"refreshing" information. 

Refreshing Windows To refresh information in an active KWS window: 

1. Select the Window Menu in the KWS Menu Bar. 

2. Select Refresh from the Window Menu. 

PRINTING FROM KWS   
You can print from any window within KWS. You may also change your 
print font, the data fields to be printed, and your page setup. See Chapter 7, 
Customizing KWS, for more details on setting these options. 

*> Printing Text From a To print text from a KWS window: 
KWS Window 

1. Select the window from which you want to print. 

2. Select File from the KWS Menu Bar. 

3. Select Print from the File Menu. The contents of the active window will be 
printed on the default printer specified in the Windows Control Panel. 

* Printing the Graphical       The contents of the Graphical Task Manager window can be printed by 
Task Manager Window      selecting Print from the File menu. The printout will conform to the page 

formatting defined for the current user. 
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To print contents of the Graphical Task Manager window: 

1. Open the Graphical Task Manager window and scroll the tasks to be 
printed into view. 

2. Adjust the date scale by clicking on the date bar at the top of the window 
and dragging the cursor left or right. 

3. Adjust the size and shape of the window so the portion of the graph to be 
printed is in view. Note that whatever appears in the window will be 
stretched to fit the page when printed. 

4. Select Print from the File menu. The Print dialog box will appear. 
Click OK. 

LISTING THE CONTENTS OF THE KWS DATABASE 
You may print a hierarchical list of all the tasks in your database or a 
selected task. This list includes all the subordinate tasks and any steps, 
attachments and Do Its associated with each task. The list is printed using 
the current KWS page format settings. 

Listing All Tasks in the       To list all the tasks in your KWS database: 
KWS Database 

1.    Select Admin from the KWS Menu Bar. 

2. Select Listing of the Entire Database from the Admin Menu. A message 
box will warn you that, if you have a large database, this action might take a 
long time and ask you if you want to continue. 

3. Click Yes. The Print Dialog Box will display. Click OK. 

Listing a Selected Task 
in the KWS Database 

To list a selected task in the KWS database: 

1. Select the task that you want to list. 

2. Select Admin from the KWS Menu Bar 

3.   Select Listing of a Selected Task from the Admin Menu. 
The Print Dialog Box will display. Click OK. 
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OVERVIEW 
The window used most often within KWS is the ToDo List Window. This 
window provides a personalized list of all the tasks you need to perform. 
The tasks listed in your ToDo List are entered into KWS via the Task 
Manager as part of your organization's process model. The tasks displayed 
in your ToDo List depict the subset of your organization's process model 
assigned to you. The ToDo List is dynamic, with the contents changing as 
tasks are completed, time progresses, and new tasks are added. 

This chapter describes the features of the ToDo List window, how to 
manipulate tasks in the ToDo List, and the various methods for displaying 
your ToDo List. 

TODO WINDOW 
The tasks assigned to you are displayed in a ToDo Window (Figure 2-1: 
ToDo Window). 

IHTODO: KAPPES_S 27Feb98 mmm\ 
Date Due Title <na^^J 

S$      •26Jan98 Midpoint Tapes objectives review 
P   •05Feb98 Insurance review _J 

S         •14Feb98 Attachments Review a 
O      ©27Feb98 Complete TAPES for GS9 

©27Feb98 Prepare for Midpoint TAPES objectives 
review 

4 r 

O03Mar98 Do Its Review 
O06Mar98 Write Proposal m 

O     ©12Mar98 Budget Report 
0 22Mar98 

<l   I 
Write Cover Letter 

±Ui 
Figure 2-1: ToDo Window 

By default, the tasks in the ToDo Window are organized by their Date Due 
value, with the earliest dates listed first. The order of the tasks can be 
changed by selecting Sort... from the Window Options menu. They are 
also color-coded to indicate tasks that are late or of critical priority. Critical 
priority tasks are red. High priority tasks are blue. All other tasks are black. 

The ToDo Window displays information also about each task's type and 
status via the Symbol Fields. Access to the resources required to perform the 
tasks is provided through icons in the Indicator Columns or buttons in the 
ToDo Window button bar. These features are described in the following 
sections. 
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The Symbol Fields 
On the left side of the ToDo List Window are five Symbol Field columns 
that indicate the Task Completion Status, Task Type, Predecessor Waiting 
Status, and Start Status of each task. 

Task Completion Status Symbols 

The Task Completion Status Symbols indicate the completion status of a 
task: Started, Finished, or OBE. If none of these symbols appears, the task 
status is, by default, Not Started. 

S Started 

• Finished 

O Overcome By Events 

! A grayed S, ^, or O can appear next to a task. When a Task Completion 
I Status Symbol appears in gray, it indicates that the task is a Work Group task 
I (one assigned to more than one User ID). A grayed symbol will appear next 
i to the task if at least one group member, but not all, have marked the task 
i status. If all User IDs in the Work Group mark the task with the same status, 
I the symbol will appear in black. 

Task Type Symbols 
The Task Type Symbols indicate special categories of a task as follows: 

P Private Tasks 

<$ Cyclic Tasks 

T Tasks Transferred to me by another User ID 

^ Tasks Transferred by me to another User ID 

Predecessor Waiting Symbol 

W is the Predecessor Waiting Status symbol and indicates that the task can 
not be started because it is waiting for a predecessor to be completed. 

Start Status Symbols 

The Start Status Symbols indicate how soon the task needs to be started. 
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Red       •       Late 

Yellow  O        In danger of becoming late 

Green   ©       The task is ready to be started 

Indicator Columns 

On the right side of the ToDo Window, four Indicator Columns may contain 
icons. These icons are graphical references that, when present, indicate that a 
task has additional resources associated with it. You may click on the icon to 
access the resource. These additional resources are child tasks, attachments, 
Do Its, and steps. The icons that represent these resources are as follows: 

<        Task has one or more child Tasks 

1        Task has one or more Attachments 

13        Task has one or more Do Its 

Task has Steps 

The Symbol Menu 
Not Started 

Started 

Finished 

OBE 

Percent Complete 

This pull-down menu enables you to change task completion status directly 
from the ToDo Window. 

Accessing the Status 
Symbol Menu 

To open the Status Symbol Menu: 

1. Select the desired task and place your cursor in the Status Symbol 
column on the left side of the ToDo List. 

2. Click the left mouse button. The Symbol Menu will appear with the 
options Not Started, Started, Finished, OBE, and Percent Complete. 

3. Select the desired option or click anywhere outside of the Status Symbol 
Menu to exit without setting the Task Completion Status. 



KWS Ver 3.6 Reference Guide 2-5 

MANIPULATING TASKS IN THE TODO WINDOW 
You should execute all of your tasks from the ToDo Window. Even though 
it is possible to access the same information from the Task Managers, these 
should only be used for building and updating the organization's process 
model. From the ToDo Window, you can change task status, access task 
resources, add tasks, and modify task information. 

*> Accessing Child Tasks,      To access child tasks, steps, attachments, and Do Its: 
Steps, Attachments, and 
Do ]ts Click the right mouse button on the desired resource icon in the Indicator 

Column of the ToDo Window. 

or.. 

Modifying Tasks 

Changing Task Status 

Select the desired task and click the appropriate button from the ToDo 
Window Button Bar. 

With either method, the window for the desired resource will be displayed. 

A user may change task information for the tasks in their ToDo List. 
However, the information that can be changed depends on the task 
permissions assigned to the user. 

To modify a task from the ToDo Window: 

1. Select the desired task and click the Modify button from the ToDo 
Window Button Bar. The Task Dialog Box for the task will be displayed. 

2. Make the desired changes in the Task Dialog Box and click the OK 
button. 

Two methods change Task Status from the ToDo Window. The quickest 
method uses the Status Symbol Menu. The other uses the Task Dialog Box. 

To change Task Status using the Status Symbol Menu: 

1. Select the desired task and place the cursor over the Status Symbol 
Column on the left side of the ToDo List. 

2. Click the left mouse button once, and the Status Symbol Menu will be 
displayed with the options Not Started, Started, Finished, or OBE. 

3. While holding the mouse button down, move the cursor over the 
appropriate status option and release the mouse. 

When changing status using the Status Symbol Menu, the current date will 
automatically be entered into the applicable date field (Date Started and/or 
Date Finished).  
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To change Task Status using the Task Dialog Box: 

1. Selecting the desired task and click the Modify button from the ToDo 
List Window Button Bar. The Task Dialog Box for the task will be 
displayed. 

2. Mark the appropriate status option in the Status area of the dialog box, 
and then click the OK button. 

Modifying the Percent 
Complete Value of a 
Task using the Status 
Symbol Menu 

Change the Percent Complete value for a task by selecting Percent 
Complete from the Status Symbol Menu for the task. This action displays a 
dialog box, which contains a slider bar that can be used to set the Percent 
Complete value. 

To modify the Percent Complete value of a task using the Status Symbol 
Menu: 

a) In any task window, position the mouse pointer within the left margin next to a task and click the left 
mouse button. The Status Symbol Menu will appear. 

b) Select Percent Complete. The Percent Complete Dialog Box appears, including a slider bar that 
indicates the current Percent Complete value for the task. 

c) Click the slider button and drag it left or right to the desired Percent Complete value. 

d) Click OK. 

Adding Private Tasks Private tasks exist only in your ToDo List and are not included in your 
organization's KWS process model. Only the user who creates a private task 
can access it. 

To add a private task from the ToDo Window: 

1. Click the Insert button. A Task Dialog Box will appear. 

2. Enter the information for the task into the Task Dialog Box. 

3. Click OK. The new task will be displayed in your ToDo List with a P in 
the Symbol Column to the left of the task. 

Adding Public Tasks Public tasks are those tasks that are part of the organization's KWS process 
From the ToDo Window    model. Any task that is inserted via a Task, Task Manager or Graphical 

Task Manager Window is automatically a public task. A task inserted from 
within the ToDo Window is public only if it is inserted as a child of a public 
task. Otherwise, it is a private task. 
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To add a public task from the ToDo Window: 

1. Select the public task under which you want to insert children and 
double-click the mouse button. A Task Window will be displayed with 
its associated button bar. 

2. Click the Insert button. A Task Dialog Box will be displayed. 

3. Enter the information for the task into the Task Dialog Box. 

4. Click OK. 

Deleting Tasks From the    Deleting a task from your ToDo List also deletes it from the KWS database. 
ToDo Window You may delete a task only if you have been given Delete permission for the 

task by the task owner. 

To delete a task from the ToDo Window: 

1. Select the desired task and click the Delete button. The Delete? Dialog 
Box will be displayed. 

2. Click Yes to delete the task, or click No to cancel. 

I Remember that deleting a task deletes all its children, attachments, steps, and 
t Do Its. Use this command with caution. 

OPTIONS FOR VIEWING THE TODO LIST 

ToDo: Completed Items 

ToDo: Ongoing Items 

ToDo Calendar 

ToDo Graph 

ToDo Context Graph 

ToDo Browser 

Workload 

Several options are available for viewing your ToDo List in KWS.   These 
options are accessed from the ToDo Menu in the KWS Menu Bar. The 
options are: ToDo, ToDo: Completed Items, ToDo: Ongoing Items, ToDo 
Calendar, ToDo Graph, ToDo Context Graph, and ToDo Browser. The 
contents of the ToDo List depend on which option you have chosen. Each 
option is described further in the following sections. 

ToDo 
The ToDo option displays all tasks assigned to you that have not been 
marked Finished or OBE (Figure 2-2). Tasks that have been marked 
Finished or OBE with a due date later than the current date will also be 
displayed on the ToDo List until the due date is later than the current date. 
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lüToDo: KAPPES_S 27Feb98 HÜB 
Date Due Title <mmjAjtl 

S$     ©26^98 Midpoint Tapes objectives review 
P   «05Feb98 Insurance review J 

S         *14Feb98 Attachments Review a 
O     8 27Feb98 Complete TAPES for GS9 

©27Feb98 Prepare for Midpoint TAPES objectives 
review 

A 

O03Mar98 Do Its Review 
O06Mar98 Write Proposal m 

V     ©12Mar98 Budget Report 
0 22Mar98 Write Cover Letter 

*TA 
Figure 2-2: ToDo Window 

ToDo: Completed Items 
The ToDo: Completed Items option displays an archived list of all tasks 
assigned to you that have been marked Finished or OBE (Figure 2-3). 
Tasks with a due date later than the current date will not be displayed on the 
ToDo: Completed Items List until the current date is later than the due date. 

ToDo: Completed 
Window Date Ranges 

ToDo: KAPPES_S   Completed Items   01Jan98-01Mav98 
Date Due    Title 

ma 
<mm^ 

v p 
V 
V* 

05Feb98     Insurance review 
14Feb98     Attachments Review 
09Apr98      Midpoint Tapes objectives review 

11 

Jl ±1 
Figure 2-3: ToDo Completed Items Window 

A date range can be specified for the ToDo: Completed window. Only 
tasks due within this date range will be displayed. 

To specify a date range for the ToDo: Completed window: 

1. Select ToDo: Completed Items from the ToDo menu. 

2. The Select Date Range dialog box will appear. Enter a date in the Start 
Date field. Only tasks due on or after this date will be selected. 

3. Enter a date in the End Date field. Only tasks due on or before this date 
will be selected. 

4.   Click OK. 



KWS Ver 3.6 Reference Guide 2-9 

ToDo: Ongoing Items 
The ToDo: Ongoing Items option displays all tasks assigned to you that 
have not been assigned a Date Due value (Figure 2-4). 

ÜToDo: KAPPES_S    Ongoing Hems   27Feb98 

Date Due    Title 

mmm 
<mm4 

FedEx Packaqe 
UPS Package 
Yellow Freight Package 

Jd 
Figure 2-4: ToDo Ongoing Items Window 

1 It is recommended that you assign a Date Due value to every task. The 
I Ongoing Task option was originally provided in KWS to enable users to 
| quickly access repetitive tasks that are difficult to assign a specific due date. 
| A better method for defining these tasks is now available. See Chapter 6, 
Task Palette, for more detail on this method. 

ToDo Calendar 
The ToDo Calendar option unites an interactive Calendar with a ToDo 
Window and an Appointment Window (Figure 2-5). The Calendar displays 
the months across the top section of the window. The ToDo Window is 
below the Calendar on the left side, and the Appointment Window is below 
the Calendar on the right side. 
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ToOo Calerafaf: KAPPES S l-jnixj 
 February'139E_ 
'   -2    3   ■*■;     S~ 

_::_i;  MBrch^998. vvi^7-^-;:Ä^rin99BV  v_;  ■'       . May1998    1_ 

-. > ■" '.£.16 IJ-IB -13 ■».! :■ £:•' -:-.i3'l4-iS:'!i/.'*?'i ?••••• -i-ji-'-.i 1?..'i< IS 'S •i:*.'5   17  13   13   JQ~ 
:•:  23 24 25.25(73! »■ 22>i».^*^*SJa?ä 2S"tfe -S ~^M2J~22>.23'»24: 25 *&• "7 Wl$~2072t 22j 238 

%- f-x 23 r» «*>«£«3*.' .-SsN>5 2S ,57 28-,23 39» *«»? V 24 '.2S%-28i2V2e-29* 30 ■ • 
" , &?  *-    »  ■*        * 

<l    .... ±1 
ToDo Appointments 

Date Due Title                        4111114 Date            Start           End            AppiUü 

IE51^n?fi.lanflR Midpoint Tanp« obiH ^?7FphQH     i?nnpu     n9-nnpu     UP>HI 

V   P      05Feb98 Insurance review 
V            14Feb98 Attachments Reviev      HI 

O     ©27Feb98 Complete TAPES fo 
©27Feb98 Prepare for Midpoir         A 

review 
O03Mar98 Do Its Review 
O06Mar98 Write Proposal          H 
022Mar98 Write Cover Letter 
025Mar98 Cyclic Revew                  A 

S           25Mar98 KWS Testing, ver 3 < 
S           26Mar98 Identify SMEs to de   iUH 
•*        09Apr98 Midpoint Tapes obj 

012May98 Acquire Funds         < 

iLJ T 10                                         -■'    ■ >1 

Figure 2-5: ToDo Calendar Window 

Opening the ToDo 
Calendar Window 

To open the ToDo Calendar Window: 

1.   Select the ToDo Menu in the KWS Menu Bar. 

2.   Click on the ToDo Calendar option. 

Resizing the ToDo List 
and Appointment List 
Windows 

i The ToDo Calendar Window typically is displayed in the KWS workspace 
; when a user first logs in. 

The ToDo Window can be expanded to cover the Appointment Window, or 
the Appointment Window can be expanded to cover the ToDo Window. 
This capability gives you a large window in which to view the information. 
Either of these expanded windows can be contracted to display both 
windows again. 

To expand the ToDo or Appointment Window: 

Double-click on the Title Bar of the window to be expanded. The expanded 
window will cover the other window. 

To contract an expanded ToDo or Appointment Window: 

Double-click on the Title Bar of the expanded window. Both windows will 
be displayed at their original size. 
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The Calendar 

*!* Selecting Items in the 
Calendar 

*!* Non-working days 

When the ToDo Calendar Window initially opens, the Calendar displays the 
months starting with the current month on the left side with the current date 
selected. You can scroll through the months displayed in the Calendar by 
using the scroll bar located immediately below the Calendar. 

The Calendar interacts directly with the ToDo List and Appointment List. 
The tasks displayed in the ToDo List or appointments in the Appointment 
List are determined by the date(s) selected in the Calendar. Dates marked in 
red indicate that a task is due or an appointment is scheduled for that date. 
Dates marked in gray indicate that the day is a non-working day. 

You can select any day, week, or month from the Calendar to view your 
ToDo List items for the selected period. 

To select a specific day in the Calendar: 

1. Move the cursor over the date to be selected. A red box will surround 
the date. 

2. Click the mouse button. A black box will surround the selected date. 

To select an entire month in the calendar: 

1. Move the cursor over the title of the month to be selected. A red box 
will surround the dates for the month. 

2. Click the mouse button. A black box will surround the selected month. 

To select an entire week in the calendar: 

1. Move the cursor over any date in the week to be selected. A red box will 
surround the dates for the selected week. 

2. Press the [Ctrl] key while clicking the mouse button. A black box will 
surround the selected week. 

To select multiple days, weeks or months: 

1. Select the first day, week, or month. 

2. While holding the shift-key down, select the second day, week or month. 
Both selections will now have a black box surrounding the dates. Repeat 
to include any additional dates you wish to select. 

Days when a knowledge worker is not working are denoted in KWS as non- 
working days. KWS automatically denotes weekends to be non-working 
days. Note: Holidays are not automatically marked as non-working. 
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To make a date a non-working day: 

1. Move the cursor over the date to be designated as non-working. 

2. Click the right mouse button. The background of the day will change to 
light gray. 

To change a date from non-working to working: 

1. Move the cursor over the date to be made working. 

2. Click the right mouse button. The background of the day will change 
from light gray to gray. 

ToDo List 

The ToDo window displays a ToDo List that contains all the tasks assigned 
to you that should be started by the selected date and have not been marked 
Finished or OBE. KWS calculates that a task should be started by the 
selected date when the Date Due value for that task minus the Duration 
equals that selected date. Tasks that have been marked Finished or OBE 
with a due date later than the current date will also be displayed on the ToDo 
List until the due date is later than the current date. 

The Appointment List 

The Appointment Window enables the user to enter appointments within 
KWS. The appointments entered for the date(s) currently selected in the 
Calendar will be displayed in the Appointment List. The following data 
fields are used by KWS to describe Appointments: 

Appointment        A textual description of the appointment 

Date The date of the appointment entered in DDMMMYY 
format. The default value is the currently selected date 
in the Calendar. 

Start Time The time when the appointment is scheduled to begin 
entered in the 12-hr-clock format: e.g., 02:15PM. 

End Time The time when the appointment is scheduled to end 
entered in the 12-hr-clock format as above. 

Entering Appointments      To enter an appointment: 

1.   Activate the Appointment Window by clicking on it anywhere. 
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2. Press the Insert button on the Button Bar. The Appointment Dialog Box 
will appear (Figure 2-6). 

3. Enter the information into each field of the dialog box and click OK to 
save the appointment. Note that the date and time fields can be entered 
by clicking the arrows next to the data fields. 

[Appointment Mx| 

Appointment 

Cancel I OK |±||27Feb98    |£   J±||1200PM    W   LUi^OOPM    |£|   [ 

Figure 2-6: Appointment Dialog Box 

<* Modifying Appointments    To modify an appointment: 

1. Activate the Appointment Window by clicking on it anywhere. 

2. Select the appointment to be modified from the Appointment List and 
press the Modify button on the Button Bar. The Appointment Dialog 
Box will appear. 

3. Enter the desired changes to each field in the dialog box and click OK. 

<» Deleting Appointments       To delete an appointment: 

1. Make the Appointment Window active by clicking on it anywhere. 

2. Select the appointment to be deleted from the Appointment List and 
press the Delete button. The Delete? Dialog Box will be displayed 
(Figure 2-7). 

3. Click Yes to delete the appointment, or click No to cancel. 

1 Delete? |"x| 

§>■ 27Feb98 12:00PM 0200PM Meet with Beverly Thomas 

Yes           ('"" No       jj 

Figure 2-7: Delete? Dialog Box 
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*** Linking Attachments to      To link an attachment to an appointment: 
Appointments 

1. Activate the Appointment Window by clicking on it anywhere. 

2. Select the appointment to be linked to an attachment from the 
Appointment List and press the Attach button in the Button Bar. An 
Attachment Window will appear. 

3. Link the attachment in the usual manner. See Chapter 4, Attachments, 
for detail on linking Attachments. See Chapter 5, Do Its, for details on 
linking Do Its. 

ToDo Context Graph 

The ToDo Context Graph option displays the complete process hierarchies 
to which the ToDo items belongs in a Graphical Task Manager Window. 
Your ToDo items are indicated in bold type. Tasks that have been marked 
Finished or OBE and Ongoing Tasks are not displayed. See The Graphical 
Task Manager in Chapter 3, Tasks and Steps, for more details on using the 
Graphical Task Manager Window. 

ToDo Graph 

The ToDo Graph option displays your ToDo list in a Graphical Task 
Manager Window. Your ToDo items are indicated in bold type. Tasks that 
have been marked Finished or OBE and Ongoing Tasks are not displayed. If 
you modify a ToDo item in this window, the entire task hierarchy containing 
the ToDo item will be loaded. See The Graphical Task Manager in Chapter 
3, Tasks and Steps, for more details on using the Graphical Task Manager 
Window. 
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ToDo Browser 
The ToDo Browser option displays all the tasks assigned to you within a 
split-screen window (Figure 2-8). This browser allows you to view two 
levels of the task hierarchy simultaneously. Using this option, you can 
access all the levels of the ToDo List without opening multiple task 
windows. 

ToDo Browser: KAPPES_S HEB II 
H                                                                      ToDo                                                                      II 

s 
s 

<l 

Date Due Title *zm&z±, 

4 
022Mar98 
025Mar98 

Write Cover Letter 
Cyclic Revew 

|<         — 
mm . ■ 

25Mar98 KWS Testing, ver 3.0 

[^ 

26Mar98 Identify SMEs to decompose tasks 

3.0 Tasks for: KWS Testinq, vei 

• 

«I 

Date Due Title ID ■<W&A 

14Feb98 Attachments Review kws ■       ® 
► O 

o 
03Mar98 
25Mar98 

Do Its Review 
Cyclic Revew 

kws 
kws 

► : 

Figure 2-8: ToDo Browser Window 
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OVERVIEW 
Tasks are the basic building blocks of a KWS process model. KWS provides 
the ability to build process models via the Task Manager and Graphical Task 
Manager. In addition, users may add to the KWS process model by inserting 
tasks within Task Windows accessed from their ToDo Lists. 

This chapter describes how to define tasks within KWS, manipulate tasks for 
building process models, define cyclic tasks, create predecessor and 
successor relationships between tasks, use the Graphical Task Manager, and 
define steps. 

TASK DEFINITION 
Each task has a specific set of information or data fields associated with it. 
To build a KWS process model, it is necessary to enter the information that 
defines each task into KWS. The following sections describe the 
information required for defining tasks within the KWS database. 

The Task Dialog Box 
Tasks are entered into the KWS database through the Task Dialog Box 
(Figure 3-1: The Task Dialog Box). The Task Dialog Box contains a set of data 
fields that capture user-specified values for defining tasks within KWS. In 
addition, the Task Dialog Box contains buttons used to access dialog boxes for 
capturing or viewing additional task information. The following sections describe 
the data fields contained within the Task Dialog Box as well as the data fields 
accessed from the Task Dialog Box. 
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Title: | [|"~ Milestone |7-ToDo Item 
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Figure 3-1: The Task Dialog Box 

Task Dialog Box Data Fields 
The following data fields in the Task Dialog Box are entered by the user 
when defining tasks within KWS. 

Milestone 
Designating a Milestone    To designate a task as a Milestone: Check the Milestone box by clicking 

on it. If the box is already checked, clicking on it will uncheck it and vice 
versa. 

Description: Indicates whether an item is a milestone. 

Type: An option-box field that indicates the tasks is actually a milestone. 

Default Value: Unchecked 

Usage: When building KWS process models, it is useful to have milestone 
tasks to provide an absolute division between task structures. 

ToDo 

Designating a ToDo 
Item 

To designate a task as a ToDo item: Check the ToDo box by clicking on 
it. If the box is already checked, clicking on it will uncheck it and vice 
versa. 

Description: Indicates whether a task should be displayed in the ToDo List. 
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Type: An option-box field that indicates a task should appear in the ToDo 
List when the box is checked and should not appear in the ToDo List when 
the box is not checked. 

Default Value: Checked 

Usage: When building KWS process models, some higher-level tasks are 
defined to provide organizational structure to the task hierarchy. It may not 
be appropriate for these tasks to appear as ToDo items. Typically, ToDo 
items are the lower-level tasks that are actually performed by a knowledge 
worker. 

Title 

*t* Entering Task Title To enter Task Title: Type the desired value into the Title field. 

Description: The name of the task. 

Type: A 240-character text field that can include any combination of 
alphanumeric characters, punctuation marks, and standard ASCII symbols. 
It is a required field. 

Default Value: Blank 

Usage: The Title value should contain an abbreviated description of the 
central activity that defines the task. It is recommended that a task be named 
with an active verb phrase (Verb + Noun Phrase). For example: Conduct 
Meeting. The KWS convention is to capitalize each key word in the task 
name, just as you would the title of a book. 

ID 

*!*  Entering the Task ID To enter the task ID: Type the value into the ID field. 

Description: An identifier used to classify tasks. 

Type: A 20-character text field that can include any combination of 
alphanumeric characters, punctuation marks, and standard ASCII symbols. 
It is a required field. 

Default Value: The ID value of the parent task. 

Usage: The ID value should contain information that enables you to quickly 
associate the task with a specific project or assignment. For example, an ID 
field containing the project number 001CS4 for the task Conduct Status 
Review Meeting reminds the user which project the task pertains to without 
the user having to include the project name in the Title field. Also, marking 
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tasks with ID values ensures they will be found when a user makes a 
database query to retrieve all the tasks that contain that specific ID value. 

Date Due 

Entering Date Due To enter Date Due: Type the value into the Date Due field using the 
DDMMMYY format, or set the value by clicking on the ... button to the 
right of the field and select the date from the calendar. 

Description: The scheduled date of completion for a task. 

Type: A date field entered using the format DDMMMYY, where DD is the 
2-character number for the day of the month, MMM is the first three letters 
of the name of the month, and YY is the 2-character number for the year. 
For example, August 3, 1999 is entered as 03aug99. 

Default Value: The Date Due value of the parent task. If the task does not 
have a parent, the default value is the current date. If the task is being 
entered as a private task from the ToDo List in the ToDo Calendar Window, 
the default value is the date selected in the calendar. 

Usage: The Date Due value of a task is based on the Date Due values of its 
children. If a task has children, its Date Due value is set to the Date Due of 
its earliest child. If a task does not have children, its Date Due value is set 
by the user. Therefore, you cannot change the Date Due value of a parent 
task; you can only change the Date Due value of leaf-level tasks. Because a 
parent task inherits its Date Due value from its children, when you are 
building a task structure it is often simpler to accept the default value until 
you reach the leaf level of the hierarchy. At the leaf level, assign Date Due 
values, and the parent task's values will be set automatically. 

It is recommended that all tasks be assigned a Date Due. If the Date Due 
field is deleted and left blank, the task is designated as an Ongoing Task 
within KWS. The Ongoing Task option was originally provided in KWS to 
enable the user to have quick access to tasks of a repetitive nature that are 
difficult to assign a specific due date. A better method for defining these 
tasks is now available. See Chapter 6, Task Palette, for detail on this 
method. 

Include Weekends 

Setting Include 
Weekends 

To select Include Weekends: Select this option by clicking the Include 
Weekends checkbox. 

Description: Specifies whether weekends are included as working days 
when calculating the late start date of a task. 
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Type: An option box field that indicates that weekends are working days for 
this task. 

Default Value: Unchecked 

Usage: KWS uses this information to compute the Late Start Date for a 
Task (See Late Start Date, this section). If the option is checked, weekends 
are considered to be working days and are included as part of the task 
duration when calculating the Late Start Date. Also, if this option is 
checked, the user is allowed to drag the duedate to a weekend day in the 
GTM. 

Duration 

*** Entering Duration To enter Duration: Type the value into the Duration field, or set the value 
by clicking on the up and down arrows to the right of the field. 

Description: An estimate of the number of work days and hours it will take 
to complete the task. 

Type: A numeric field that is divided into days and hours. 

Default Value: 0 days, 0 hours 

Usage: KWS uses the information stored in the Duration field to compute 
the Late Start Date for a Task (See Late Start Date, this section). Work days 
are formulated as 8 hours, and exclude Saturdays and Sundays. 

The Duration value of a parent task is equal to the difference between the 
latest Date Due value and earliest Start Date value of its children. If a task 
does not have children, its Duration value is set by the user. Therefore, you 
cannot change the Duration value of a parent task; you can only change the 
Duration value of leaf-level tasks. Because a parent task inherits a Duration 
value from its children, when you are building a task structure, it is often 
simpler to accept the default value until you reach the leaf level of the 
hierarchy. At the leaf level, assign Duration values and the parent task's 
values will be set automatically. 

Date Started 

*** Entering Date Started To enter Date Started: Type the value into the date field using the 
DDMMMYY format, or set the value by clicking on the ... button to the 
right of the field and select the date from the calendar. 

Description: The date that work on a task is initiated. 

Type: A date field entered using the format DDMMMYY, where DD is the 
2-character number for the day of the month, MMM is the first three letters 



KWS Ver 3.6 Reference Guide 3-7 

of the name of the month, and YY is the 2-character number for the year. 
For example, August 3, 1999 is entered as 03aug99. 

Default Value: Current date 

Usage: The Date Started field indicates that a task is in progress. This 
information is valuable for users who need to know the status of a task. 
Also, it can be used in conjunction with the Date Finished field value to 
compute the actual completion time for a task. 

Date Started is set to the current date when the user marks a task Started 
from the Status Symbol Menu. The user may change this value from the 
Task Dialog Box if, for some reason, the Task Status was not set on the 
actual start date. If a task is not marked Started before it is marked 
Finished, the Date Started is set to the current date. 

Date Finished 

Entering Date Finished To enter Date Finished: Type the value into the date field using the 
DDMMMYY format, or set the value by clicking on the ... button to the 
right of the field and select the date from the calendar. 

Description: The date that work on a task is completed. 

Type: A date field entered using the format DDMMMYY, where DD is the 
2-character number for the day of the month, MMM is the first three letters 
of the name of the month, and YY is the 2-character number for the year. 
For example, August 3, 1999 is entered as 03aug99. 

Default Value: Current date 

Usage: The Date Finished field is used to indicate that a task is completed. 
A completed task will be displayed on your ToDo List (with a check mark 
next to it) until the Date Due value is less than the current date. This value is 
also used in conjunction with the Date Started value to compute the actual 
completion time for a task. Date Finished is set to the current date when the 
user marks a task Finished from the Status Symbol Menu. You may change 
this value from the Task Dialog Box if, for some reason, the Task Status 
was not set on the actual completion date. 

% Effort 

*t* Entering % Effort To enter % Effort: Type the value into the % Effort field or select the 
value by clicking on the up and down arrows to the right of the field. 

Description: An estimate of the percentage of effort a user will spend on 
completing a task. 
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Type: Integer with a maximum value of 100. 

Default Value:  100 

Usage: The % Effort field gives users an estimate of how much of their total 
effort should be spent on a task. 

% Complete 

*t*  Entering % Complete To enter % Complete: Type the value into the % Complete field or select 
the value by clicking on the up and down arrows to the right of the field. 

Description: An estimate of what percentage of the task has been 
completed. 

Type: Integer with a maximum value of 100. 

Default Value: 0 

Usage: The % Complete field provides users with a measure of the progress 
that has been made on a task. 

Assigned To 

*!* Entering Assigned To To enter Assigned To: Type any valid KWS User ID in the Assigned To 
field, or click the small arrow located to the right of the field and select the 
desired value from the list provided. You may also enter the beginning 
characters of the User ID into the field to quickly locate a value in the list. 
For example, entering the value "ka" will automatically place you at the first 
User ID in the list beginning with "ka." 

Description: The KWS User ID of the user (or Work Group) responsible 
for completing the task. 

Type: A 20-character text field. The value must be a valid KWS User ID or 
Work Group. It is a required field. 

Default Value: The KWS User ID of the user entering the task. 

Usage: All tasks indicated as ToDo items and assigned to your KWS User 
ID or any Work Groups containing your User ID are displayed in your ToDo 
List. 

Defining New 
Workgroups When 
Assigning Tasks 

A new workgroup can easily be defined when assigning a task. If multiple 
knowledge workers are selected when assigning a task, KWS prompts the 
user for the ID of a new workgroup and creates it automatically. 
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To define a new workgroup when assigning a task: 

1. Open the Task Dialog Box. 

2. Select the ... button next to the Assigned To, Performed By, Assigned By, or 
Task Owner field. The Knowledge Worker/ Workgroup Selection dialog box 
appears (Figure 3-2). 

Select KW or Group l~x] 

Organization: 

Groups: 

|    OK 

|GMT                 zl Cancel 

KWs: 

1 BROWN C                      I ACCT 
OPS JONES M 

KELLY G 
WENTJ. 

Group/KW: |BR0WN_C 

Figure 3-2: KW/ Workgroup Selection Dialog Box 

3. Select multiple knowledge workers from the KW list by holding down the Ctrl 
key and clicking on items in the list. 

4. Click OK. A Workgroup Dialog Box appears. 

5. Enter the ID and Title of a new workgroup. 

6. Click OK. The name of the new workgroup appears in the appropriate 
Assigned To, Performed By, Assigned By, and/or Task Owner field(s). 

Performed By 

*t* Entering Performed By To enter Performed By: Type any valid KWS User ID in the Performed 
By field, or click the small arrow located to the right of the field and select 
the desired value from the list provided. You may also enter the beginning 
characters of the User ID into the field to quickly locate a value in the list. 
For example, entering the value "ka" will automatically place you at the first 
User ID in the list beginning with "ka." 

Description: The KWS User ID of the user (or Work Group) who will 
perform the task. 
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Type: A 20-character text field. The value must be a valid KWS User ID or 
Work Group. It is a required field. 

Default Value: The KWS User ID of the user entering the task. 

Usage: The Performed By field enables a user to reassign a task to another 
user for actual completion, while still maintaining the responsibility for 
ensuring it is completed. When the Performed By value is different than the 
Assigned To value, the task will appear in the ToDo Lists of both User IDs. 
The task will appear in the ToDo List of the User ID contained in the 
Assigned By field with the transferred symbol next to it. 

Whenever the Assigned To value is changed, Performed By is set to the 
same value as Assigned To. The Performed By field can then be set to a 
value different than the Assigned To value. 

Assigned By 

***  Entering Assigned By To enter Assigned By: Type any valid KWS User ID in the Assigned By 
field, or click the small arrow located to the right of the field and select the 
desired value from the list provided. You may also enter the beginning 
characters of the User ID into the field to quickly locate a value in the list. 
For example, entering the value "ka" will automatically place you at the first 
User ID in the list beginning with "ka." 

Description: The KWS User ID of the user who assigned the task. 

Type: A 20-character text field. The value must be a valid KWS User ID 
(not a Work Group). It is a required field. 

Default Value: The KWS User ID of the user entering the task. 

Usage: The Assigned By value should contain the User ID of the person 
within the organization responsible for assigning the task. Typically, this 
person would be the supervisor of the user specified in the Assigned To 
field. 

Task Owner 

***  Entering Task Owner To enter Task Owner: Type any valid KWS User ID in the Task Owner 
field, or click the small arrow located to the right of the field and select the 
desired value from the list provided. You may also enter the beginning 
characters of the User ID into the field to quickly locate a value in the list. 
For example, entering the value "ka" will automatically place you at the first 
User ID in the list beginning with "ka." 
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Description: The KWS User ID of the user who owns the task (i.e., the 
knowledge worker with administrative rights for managing the task. 

Type: A 20-character text field. The value must be a valid KWS User ID 
(not a Work Group). It is a required field. 

Default Value: The KWS User ID of the user entering the task. 

Usage: The Task Owner is considered to be the owner of the task and has 
full security rights for the task. Hence, the Task Owner value should be set 
to the User ID of the knowledge worker who should have ultimate authority 
on any modifications made to the task's definition. In many cases, this value 
is the same as the Assigned By value. 

Status Change 

Entering Status Change     To enter Status Change:   Click the small arrow to the right of the field and 
select the desired value from the list provided. 

Description: The User ID within the Work Group assigned a task that has 
ultimate responsibility for indicating when a task is finished. 

Type: A text field selected from a list containing the values All Members, 
Any Member, and all User IDs of the members of the Work Group to which 
the task is assigned. 

The Status Change field is only active when the Assigned To value is set 
to a Work Group. 

Default Value: Any Member 

Usage: When a task is assigned to a Work Group, the final Task Status 
value is determined by the completion status of each member of the Work 
Group. As each member of the Work Group completes a task, they set their 
individual Task Status value. The final Task Status is set by KWS 
depending on the value of the Status Change field as follows: 

AH Members Only when all members of the Work Group have set their 
individual Task Status values to Finished, KWS sets the 
final Task Status to Finished. 

Any Member    When any member of the Work Group sets their Task 
Status value to Finished, KWS sets the final Task Status 
to Finished. 

User ID Only when the specified User ID within the Work Group 
marks their individual Task Status value to Finished, 
KWS sets the final Task Status to Finished. 
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Status 

*!* Entering Task Status To enter Status: Click on the box next to the desired value within the 
Status box. If one box is already checked, clicking on another box will 
uncheck it and set the new value. 

Description: An indicator of the progress made towards task completion. 

Type: A text field selected from the values Not Started, Started, Finished 
or OBE. 

Default Value: Not Started 

Usage: The task Status value should always reflect the current status of the 
task. The user should set Status to one of the following values as the status 
changes: 

Not Started The task has not been started. 

Started The task has been started. 

Finished The task has been completed. 

OBE The task has been overcome by events. 

Setting the Status to any value other than Not Started will automatically 
cause the current date to be entered into the Date Started or Date Finished 
fields as appropriate. 

Cyclic 

*!*  Marking a Task as 
Cyclic 

To mark a task cyclic: Click on the Cyclic box to change the value. If the 
box is already checked, clicking on it will uncheck it and vice versa. If the 
task has previously been saved with the Cyclic box checked, the value 
cannot be unchecked. 

Description: Indicates that a task is repeated at regular intervals. 

Type: An option box field that indicates a task is Cyclic when the box is 
checked and Not Cyclic when the box is not checked. 

Default Value: Unchecked 

Usage: See Cyclic Tasks, in this section, for more detail. 
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Cycle Type 

♦/♦ Entering Cycle Type To enter Cycle Type: Click on the box next to the desired value within the 
Cyclic area. If one box is already checked, clicking on another box will 
uncheck it and set the new value. 

Description: An indicator of how often a cyclic task occurs. 

Type: A checkbox field selected from the values Weekly, Monthly, 
Quarterly, and Yearly. 

Default Value: Weekly 

Usage: The value assigned to this field indicates to KWS how often the task 
should be repeated in the database. For example, if a cyclic task is assigned 
a Cycle Type of Weekly, then KWS will create an instance of the task that is 
due every week. This field is tied directly with the Last Cycle field, which 
indicates to KWS the last date to create an instance of the task. 

This field is active only if the Cyclic option box is checked. 

Last Cycle 

Entering Last Cycle To enter Last Cycle: Increment or decrement the value using the arrow 
box to the right of the Last Cycle field. KWS increments the date based on 
the due date and the number of days in the selected cycle. 

Description: The due date of the last instance of a cyclic task. 

Type: A date field of the format DDMMMYY, where DD is the 2-character 
number for the day of the month, MMM is the first three letters of the name 
of the month and YY is the 2-character number for the year. For example, 
August 3, 1999 is entered as 03aug99. 

Default Value: None 

Usage:   Assigning a value to this field indicates to KWS that the task should 
be repeated in the database until the date specified. For example, if a weekly 
task with a Date Due value of 05jan99 is assigned a Last Cycle Date of 
19jan99, three instances of the task would be added to the KWS database 
with due dates of 05jan99, 12jan99, and 19jan99. You must enter a Last 
Cycle value or the task will not be projected. 

j This field is active only if the Cyclic option box is checked. 
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Priority 

Entering Priority To enter Priority: Click on the box next to the desired value within the 
Priority area. If one box is already checked, clicking on another box will 
uncheck it and set the new value. 

Description: Indicates the importance of the task. 

Type: A text field selected from the values Normal, High, or Critical. 

Default Value: Normal 

Usage: The color of a task in the ToDo List is determined by the value of 
the Priority field. Critical tasks are displayed in blue, and high priority and 
normal tasks are in black. Assigning a value to this field quickly indicates 
which task(s) to work on first. 

*> Changing the priority of   If the priority of a task is changed, the user is given the option of changing 
a task and all of its the priority of all descendants of the task. 
descendants 

To change the priority of a task and all of its descendants: 

1. Modify the priority of the task in the Task Dialog box. Click OK. 
After clicking OK, if the task has subtasks you will be asked whether you wish 
to modify the priority of the subtasks. 

2. Select Yes to change all descendants of the task to the new priority. 

3. Select No to retain the current priority for all descendants of the task. 

Task Dialog Box Security Button 

Security., The Security... button on the Task Dialog Box is used to access the dialog 
box for assigning user access rights for modifying task data field values. 
Clicking the Security... button displays the Task Security Dialog Box 
(Figure 3-3). 
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Task Security 

User/Group: PUBLIC 

r Assigned Permissions- 

Organization: iGMT 

V Children inherit permissions 

II 

f Delete 

F Update 

Permission To Update: — ~— 

F Assignment R Status     F All Other Attributes 

F DateDue/Duration      W Steps 

F Save as my default PUBLIC permissions for new tas 

User/Group Description 

BR0WN_C 
J0NES_M 
KELLY_G 
WENTJ. 
ACCT 
OPS 

Chuck Brown 
Mike Jones 
George Kelly 
Lyn Went 
Group 
Group 

OK 

Cumulative Permissions 

update (all) 
update (DS) 

Cancel 

Figure 3-3: Task Security Dialog Box 

The following values may be assigned by Knowledge Worker and Work 
Group within the Task Security Dialog Box. 

Org 

Selecting an 
Organization 

To select the Org: Click on the desired Organization in the drop down list 
provided in the Org box. 

Description: The Organization of the User ID or Work Group being 
assigned security rights for a task. 

Type: A 20-character text field containing a valid KWS Organization. 

Default Value: Current organization. 

Usage: Access rights are assigned by first selecting an organization and then 
selecting the User IDs and Work Groups in the selected organization. This 
options allows you to grant permissions to workers in other organizations. 

KW/Group 

Selecting KW/Group To select the KW/Group: Click on the desired User ID or Work Group in 
the list provided in the KW/Group box. 
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Description: The User ID or Work Group being assigned security rights for 
a task. 

Type: A 20-character text field containing a valid KWS User ID or Work 
Group. 

Default Value: PUBLIC 

PUBLIC is a KWS generated Work Group that contains all KWS users 
within your organization. 

Usage: Access rights are assigned by selecting from the list of User IDs and 
Work Groups. The currently assigned rights for the selected user are 
displayed in the fields to the right of the KW/Group box. 

Delete 

Assigning Task Delete 
Permission 

To assign task delete permission: Click on the box next to the Delete 
field. If the box is already checked, clicking on it will uncheck it and vice 
versa. 

Description: Indicates whether a user has permission to delete the task. 

Type: An option-box field that indicates a user has delete rights when the 
box is checked and does not have delete rights when the box is not checked. 

Default Value: Checked for the task owner's User ID and unchecked for all 
other users. 

Usage: Enables a user to delete a task from the KWS database. Only the 
task owner can assign delete permission on a task. This option safeguards 
against the erroneous deletion of tasks from the KWS database. 

Update 

Assigning Task Update 
Permission 

To assign task update permission: 

1. Click on the box next to the Update field. If the box is already checked, 
clicking on it will uncheck it and vice versa. 

2. Set the scope of the update permission by clicking on the box next to the 
specific permissions available in the area below the Update box 
(Assignment, Due Date/Duration, Status, All Other Attributes). 

Description: Indicates whether a user has permission to modify the Task 
Data field values. 
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Type: An option-box field that indicates a user has update rights when the 
box is checked and does not have update rights when the box is not checked. 

Default Value: Update rights for Status field 

Usage: Users with update permission can be assigned specific permissions 
for each data field they may update. When the Update checkbox is checked, 
one or more of the following Update Permissions may be assigned: 

Assignment 

Due Date/Duration 

The user may change the Assigned To and 
Performed By fields of the task. 

The user may modify the Date Due and Duration 
of the task. 

Status The user may modify the Task Status. 

All Other Attributes     The user may modify all the other attributes of the 
task. 

Task Dialog Box Status Button 

Status... 
Use the Status... button on the Task Dialog Box to obtain the individual user 
status of a task assigned to a Work Group. Clicking the Status... button 
displays the Task Group Status Window (Figure 3-4), which displays the 
individual Task Status values for each member of the Work Group. 
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Task Group Status 

T ask status for members of group: IDS 

iNot Started    JONES' ike Jones 
Not Started    KAPPES S       Sandie Kappes 
Not Started     TH0MAS~_B      Beverly Thomas 

OK 

Figure 3-4: Task Group Status Window 

| The Status... button is only available when the value in the Assigned To 
| field is a Work Group. 

Task Group Status 

Description: Provides a list of User IDs within the Work Group and their 
individual task status values. 

Type: List of valid Work Group members and associated Task Status 
values. 

Default Value: None 

Usage: The Task Group Status List enables you to determine the overall 
status of a task by displaying the status of the individual members of the 
group. 

Task Dialog Box Description Button 

Description. The Description... button on the Task Dialog Box is used to access a textual 
description of a task. Clicking the Description... button displays the Task 
Description Dialog Box (Figure 3-5), which contains the Task Description 
data field. 
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Task Description 

Develop Ver 3.5 Intermediate Deliverables OK Cancel 

This task contains a schedule for all KWS Version 3.5 Deliverables including       jj 
documentation, help files, and prerelease executablesj 

Figure 3-5: Task Description Dialog Box 

Task Description 

Entering the Task 
Description 

To enter a task description: 

1. Click the Description... button on the Task Dialog Box. The Task 
Description dialog box will appear. 

2. Enter text into the Task Description field. 

3. Click OK. 

Description: A textual description of a task. 

Type: A 32,000-character text field that can include any combination of 
alphanumeric characters, punctuation marks, and standard ASCII symbols. 

Default Value: Blank 

Usage: Enables the task owner to enter or modify a textual description that 
provides more detail about the task. Users with Update, All Other 
Attributes permission may also modify the Task Description. Other users 
may only view the Task Description. 

KWS-Generated Data Fields 
When a user defines a task, KWS generates some additional data field 
values. With the exception of Org ID, these values do not appear in the Task 
Dialog Box but do appear in the task listings within the ToDo, Task, and 
Task Manager Windows. 
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OrgID 

Description: Indicates the user's organization. 

Type: 20-character text field assigned by the KWS administrator. 

Default Value: The organization of the user inserting the task. 

Usage: KWS allows more than one organization to share a database. The 
KWS System Administrator assigns an Org ID to every User ID. Only those 
tasks assigned to the user's Org ID will be displayed within the Task 
Manager. 

Task Type 

Description: Indicates whether a task is part of the organization's task 
hierarchy or is a user's personal task. 

Level 

Type: A text field containing the value Private or Public. 

Default Value: Public if the task is inserted in a Task Manager, Graphical 
Task Manager, or Task Window; Private if entered in a ToDo Window. 

Usage: Public tasks are official activities performed by an organization. 
Private tasks are activities that are not official and, therefore, not necessary 
to include in the organization's process model. Most tasks within KWS 
should be public. 

Description: Indicates the position of a task within the task hierarchy. 

Type: Integer 

Default Value: Not applicable 

Usage: The value in the Level data field provides the user with an indication 
of where a task occurs in the organization's process model. A top-level task 
(or process) is assigned Level 1, children of a process are assigned Level 2, 
and so on. 

Attachments 

Description: Indicates the number of attachments associated with a task. 

Type: Integer 

Default Value: None 
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Dolts 

Task Number 

Usage: This value quickly indicates how many attachments are associated 
with a task without having to open the Attachment Window. When the value 
of the Attachments data field is greater than zero, then an attachment icon 
will appear in the Indicator Column on the right-hand side of the ToDo List, 
Task, Task Manager, Steps, Attachments, Do Its, Appointment, and 
Milestone windows. 

Description: Indicates the number of Do Its associated with a task. 

Type: Integer 

Default Value: None 

Usage: This value quickly indicates how many Do Its are associated with a 
task without having to open the Do Its Window. When the value of the 
Do Its data field is greater than zero, then a Do It icon will appear in the 
Indicator Column on the right-hand side of the ToDo List, Task, Task 
Manager, Steps, Attachments, Do Its, Appointment, and Milestone 
Windows. 

Description: A unique number assigned to each task within the KWS 
database. 

Type: Integer 

Default Value: None 

Usage: The Task Number is assigned sequentially by KWS when a task is 
inserted into the database. This value is used primarily by the KWS System 
Scheduler to differentiate between items that may have the same Title or ID 
value. Typically, the Task Number has no significance for the user but may 
be useful for the System Administrator should task record corruption occur 
within the database. 

Late Start Date 
Description: The latest date on which a task can be started to complete the 
task by the scheduled due date. 

Type: A date field entered using the format DDMMMYY, where DD is the 
2-character number for the day of the month, MMM is the first three letters 
of the name of the month, and YY is the 2-character number for the year. 
For example, August 3, 1999 is entered as 03aug99. 



3-22 KWS Ver 3.6 Reference Guide 

Default Value: Not applicable 

Usage: The KWS Scheduler computes this date by subtracting the number 
of days entered in the Duration field from the date listed in the Date Due 
field. In the calculations, KWS excludes Saturdays and Sundays and rounds 
any hours up to 1 day. If a task's status is not set to Started by the end of the 
Late Start Date, then it is considered "In Danger of Becoming Late." 

THE TASK WINDOW 

The Task Window (Figure 3-6) displays a list of tasks. The contents of the 
Task Window depend on the method used to open the window. When you 
request to view child tasks by double-clicking on a task in your ToDo List or 
another Task Window (or by clicking on the task icon in the Indicator 
Column), the Task Window contains a list of the selected task's child tasks. 

When you execute a task query from the Query/ Tasks menu option, the 
Task Window contains a list of the tasks matching the selected query. 

The functionality of the Task Window is exactly the same as the ToDo 
Window. They differ in that the Task Window contains more than just the 
tasks assigned to you. See Chapter 2, The ToDo List, for details on using the 
Task Window. 

Tasks for: KWS Testing, ver 3.0 
Date Due    Title 

14Feb98     Attachments Review 
O03Mar98 
0 25Mar98 

Do Its Review 
Cyclic Revew 

Figure 3-6: Task Window 

THE TASK MANAGER 
The Task Manager displays the public tasks defined for an organization 
within a Multiple document Interface (MDI) Window (Figure 3-7). The 
split-screen MDI Window allows you to view two levels of the task 
hierarchy simultaneously. Using this option, you can access all the levels of 
the task hierarchy without opening multiple Task Windows. The task 
information contained in each of the levels within the Task Manager 
Window is the same as that displayed in the Task Window and the ToDo 
Window. See The ToDo Window for detail on the task information 
displayed. 
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Task Manager BEE 
Processes: FF 

Date Due    Title <mm4± 
m 27Feb98     Prepare for Midpoint TAPES 

objectives review 
O     €>12Mar98     Budget Report 

25Mar98     KWS Testinq, ver 3.0 
26Mar98     Identify SMEs to decompose tasks       UI3    ^ 

Tasks for: KWS Testinq, ver 3.0 
Date Due    Title IKDB4 

14Feb98     Attachments Review 
O03Mar98     Do Its Review 
O 25Mar98     Cyclic Revew 

Figure 3-7: Task Manager Window 

Manipulating Tasks 

*!*  Opening the Task 
Manager 

Tasks can be manipulated within the Task Manager, Graphical Task 
Manager, ToDo, and Task Windows. Both the Task Manager and Graphical 
Task Manager are used when building or modifying the organization's 
process model. The ToDo Window is used by individual knowledge workers 
for executing their tasks. Tasks within the ToDo Window may be 
decomposed through the Task Window. See Adding Public Tasks From the 
ToDo List for more detail. 

The following sections describe how to manipulate tasks within the Task 
Manager. Detail on manipulating tasks within the Graphical Task Manager 
may be found in the section describing the Graphical Task Manager. Further 
detail on manipulating tasks within the ToDo Window may be found in 
Chapter 2, The ToDo List. 

To open the Task Manager: 

1. Click on the Task option in the KWS Menu Bar. 

2. Select Task Manager from the list of options. The Task Manager 
Window will be displayed with your organization's processes in the top 
level. 

Viewing the Task Tree in 
the Task Manager 

To view the task tree in the Task Manager: 
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View the children of any task in the Task Manager by double-clicking on the 
task or clicking the task icon in the Indicator Column. The child tasks will 
be displayed in the lower workspace. You may continue moving down the 
hierarchy by clicking on a task to display its child tasks. You can move 
between the different levels of the Task Manager by clicking the browser 
arrow buttons located on the leftmost edge of the windows. If the browser 
arrow is gray, then the next level has no items. 

Task Window Sort 
Options 

A set of sort options is available in the Options dialog box of all task 
windows. Task windows can be sorted by Date Due or Late Start Date 
(chronological or reverse), alphabetically by Title, or by order of creation. 

To set sort options for a task window: 

1. Select Sort... from the options menu on the Window menu. 

2. The Task Sort Options dialog box appears. Select a sort option from the Sort 
Order group box. 

3. To retain the selected sort option as the default for new task windows, check the 
Save Options as Default checkbox. 

4. Click OK. 

Accessing Child Tasks,       To access child tasks, steps, attachments,and Do Its: 
Steps, Attachments, and 
Dolts 

Click on the left mouse button the desired resource icon in the Indicator 
Column of the Task Manager Window. 

or... 

Accessing Sibling and 
Parent Tasks 

Inserting Public Tasks 

Select the desired task and click the appropriate button from the Task 
Manager Window Button Bar. 

With either method, the window for the desired resource will be displayed. 

To access sibling or parent tasks: 

1. Select the task for which you want to view the sibling or parent task. 

2. Click the right mouse button to open the Available Options Menu. 

3. Select the desired option, Siblings or Parent, from the menu. A task 
window will be displayed that contains the related tasks. 

Public tasks are a part of the organization's KWS process model. Any task 
inserted within the Task Manager is a public task. 
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*t* Modifying Tasks 

*** Deleting Tasks 

To add a public task from the Task Manager: 

1. Move to the location in the task tree where you want to add the task. 

2. Click the Insert button from the Task Window Button Bar to open the 
Task Dialog Box. 

3. Enter the information for the task and click OK. 

A user may change task information for the tasks in the Task Manager. 
However, the information that can be changed depends on the task 
permissions assigned to the user. 

To modify a task from the Task Manager: 

1. Select the desired task and click the Modify button from the Task 
Manager Window Button Bar. The Task Dialog Box for the task will 
appear. 

2. Make the desired changes in the Task Dialog Box and click the OK 
button. 

You may delete a task in the Task Manager only if you have been given 
delete permission for the task. 

To delete a task from the Task Manager: 

1. Select the task to be deleted. 

2. Click on the Delete button from the Task Manager Window Button Bar. 
The Delete? Dialog Box will appear. 

3. Click Yes to delete the task or No to cancel. 

[ Remember that deleting a task deletes all its children, attachments, steps, and 
1 Do Its. Use this command with caution. 

Moving and Copying 
Tasks 

Tasks can be copied or moved to new locations within the task hierarchy. 
When a task is moved, all its child tasks, attachments, and Do Its are mo.ved 
along with it. 

When a task is copied, all its child tasks are copied and links are made 
between the copied tasks to the original task's attachments and Do Its. It is 
important to remember that the attachments and Do Its are not copied. They 
are the same attachments and Do Its as those linked to the original task 
structure; any changes made to them from either task structure will be 
reflected in the other. 
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Tasks can be copied or moved between any of the task windows: Task, Task 
Manager, and ToDo. To copy or move tasks between Task Managers, it is 
necessary to open two Task Manager Windows. 

Tip: Use Window/ Tile to facilitate copying or moving. 

To copy or move a task: 

1. In the Task Manager Window, go to the location in the task hierarchy to 
which you want to move or copy the task. 

2. Open a second Task Manager Window and select the task to be copied or 
moved. 

3. Hold down the left mouse button and drag the selected task to the desired 
location in the other Task Manager. 

4. Release the mouse button. The Confirm Move or Copy Dialog Box will 
appear. 

5. Select Move or Copy as desired. 

Tasks Spanning 
Organizations 

There may be projects that include workers from multiple organizations. 
KWS allows a task or milestone to be assigned to users or workgroups from 
multiple organizations. 

To set the Assigned To, Performed By, Assigned By, or Task Owner 
fields to a user or workgroup from a different organization: 

1. Select the ... button to the right of the field. 
The Select KW or Group window will appear, 

2. Select a different organization from the list by clicking the small arrow 
to the right of the Organization field. 

3. To choose a User ID, select from the KWs list. To choose a workgroup, 
select from the Groups list. 

4. Click OK. 

*!*  Converting a Private 
Task to a Public Task 

Private tasks can be made a part of your organization's public task hierarchy 
by copying the task from your ToDo List to the desired location in the Task 
Manager. 
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*>  Converting a Public 
Task to a Private Task 

To convert a private task to a public task: 

1. In the Task Manager Window, go to the location in the task hierarchy 
where you want to include the private task. 

2. In your ToDo List, select the private task that you want to convert to a 
public task. 

3. Hold down the left mouse button and drag the selected task to the desired 
location in the Task Manager Window. 

4. Release the mouse button. The Confirm Move or Copy Dialog Box will 
appear. 

5. Select Move. 

Public tasks can be made a part of your personal task hierarchy by copying 
the task from the Task Manager to your ToDo List. However, the location 
you select in your ToDo hierarchy cannot be at the top level, it must be at 
Level 2 or greater. 

To convert a public task to a private task: 

1. In your ToDo Window, go to the location in the task hierarchy where 
you want to include the public task. 

2. In the Task Manager, select the public task that you want to convert to a 
private task. Do not select a Level 1 task (process level). 

3. Hold down the left mouse button and drag the selected task to the desired 
location in the ToDo Window. 

4. Release the mouse button. The Confirm Move or Copy Dialog Box will 
appear. 

5. Select Move. 

Changing Task Status Two methods change Task Status from the Task Manager Window. The 
quickest method uses the Status Symbol Menu. The other uses the Task 
Dialog Box. 

Task Status should normally be updated within the ToDo List as the task is 
being executed. It should only be changed within the Task Manager as 

1 required for database maintenance.  
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To change Task Status using the Status Symbol Menu: 

1. Select the desired task and place the cursor over the Status Symbol 
Column on the left side of the Task Manager. 

2. Click the left mouse button once, and the Status Symbol Menu will be 
displayed with the options Not Started, Started, Finished, or OBE. 

3. While holding the mouse button down, move the cursor over the 
appropriate status option and release the mouse. 

To change Task Status using the Task Dialog Box: 

1. Select the desired task and click the Modify button from the Task 
Manager Window Button Bar. The Task Dialog Box for the task will be 
displayed. 

2. Mark the appropriate status option in the Status area of the dialog box, 
and then click OK. 

*!* Assigning Task If you are the task owner, you can assign permissions to other users to allow 
Permissions them to perform actions on tasks you have inserted into the KWS database. 

To assign Task Security: 

1. If the Task Dialog Box is not already open, select the task for which you 
want to assign permissions. 

2. Click the Security button on the Task Dialog Box. The Task Security 
Window will open (Figure 3-8). 
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Task Security 

User/Group: PUBLIC 

-Assigned Permissions - 

Organization: 

r~ ChOdren inherit permissions 

B 

Permission To Update:- 

I- assignment F Status r All Qthet Attributes 
V DateDue/Duration R Steps 

r Delete 

p Update 

I" Save as my default PUBLIC permissions for new tas 

User/Group Description 

a) 
BROWN C Chuck Brown 
JONES M Mike Jones 
KELLY G- George Kelly 
WENT L LynWent 
ACCT Group 
OPS Group 

Cumulative Permissions 

OK Cancel 

Figure 3-8: Task Security Dialog Box 

3. Select the Organization by clicking the small arrow to the right of the 
Org field. 

4. Select the User ID or Work Group for which you want to assign 
permissions. 

5. Select the desired permissions by clicking the appropriate checkbox. 

6. For each additional user for whom you want to assign permissions, 
repeat steps 3 and 4. 

7. Click OK to save. 

Default Public Task 
Security Settings 

The default Public Security Settings for new tasks can be set from within the 
Task Security dialog box. All new tasks will have the specified default 
Security Settings. 

To set the default Public Task Security Settings: 

1. Select a task in a Task Window and click Modify on the button bar. The Task 
dialog box appears. 

2. Click on the Security... button. The Task Security dialog box appears. 

3. Select PUBLIC in the User/Group listbox. 
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4. Set the desired public permissions for the task. 

5. Check the checkbox titled Use as default PUBLIC permissions for new tasks. 

6. Click OK. 

j Once you change the default public task security setting, any new tasks you 
[ create will have the specified public Security Settings. 

*!* Modifying the Percent 
Complete Value of a 
Task using the Status 
Symbol Menu 

Change the Percent Complete value for a task by selecting Percent 
Complete from the Status Symbol Menu for the task. This action displays a 
dialog box, which contains a slider bar that can be used to set the Percent 
Complete value. 

To modify the Percent Complete value of a task using the Status Symbol Menu: 

1. In any task window, position the mouse pointer within the left margin next to a 
task and click the left mouse button. The Status Symbol Menu appears. 

2. Select Percent Complete. The Percent Complete Dialog Box appears, 
including a slider bar that indicates the current Percent Complete value for the 
task. 

3. Click the slider button and drag it left or right to the desired Percent Complete 
value. 

4. Click OK. 

CYCLIC TASKS 

Tasks that need to be performed at regular intervals are referred to as 
"cyclic" tasks in KWS. Cyclic tasks occur at regular cycles throughout a 
specified time period. For example, the task Conduct Weekly Project Meeting 
occurs every week until the project is complete. Instead of inserting the 
same task multiple times, KWS allows you to designate a task as Cyclic; 
multiple instances of the task will then be created automatically. All 
children, steps, attachments, and Do Its associated with a cyclic task are also 
associated with each occurrence ofthat task. 

Template 

A Task Template is generated when a cyclic task is created. This Template 
is used by KWS to create instances of the task. The Template appears in the 
Task Manager as TEMPLATE: <Task Name>. It appears in the Graphical 
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Task Manager as a task with a lighter bar color than other tasks. In both 
cases, the user can set options to display or not display Templates in the 
window. See Font and Data Display Preferences for more details on this 
option. 

If a cyclic task is defined with an empty value in the Last Cycle field, only 
the Template is created. This fact allows you to define the task structure, 
including child tasks, attachments, Do Its, and steps before creating any of 
the cycles. When the task structure is complete, the instances of the cyclic 
task are created by entering a Last Cycle value for the Template. 

Cycle Types 
KWS allows users to define cyclic tasks that occur Weekly, Monthly, 
Quarterly, and Yearly. 

Weekly        Instances of weekly tasks are assigned Date Due values that 
occur on the same day of the week as the Date Due value 
specified in the Template. For example, instances of a weekly 
task with Date Due of (Wednesday) 03feb99will occur on 
Wednesdays. 

Monthly      Monthly tasks are assigned Date Due values that occur on the 
same date of the month as the Date Due value specified in the 
Template. For example, instances of a monthly task with Date 
Due of 30dec99 will occur on the 30th of each month. If the 
month does not have a day with the date, as is the case with 
February, then KWS assigns the latest available date in the 
month, e.g., February 28th. 

Quarterly    Quarterly tasks occur every 3 months. They are assigned Date 
Due values that occur on the same date of the third month as 
the Date Due value specified in the Template. For example, 
instances of a quarterly task with Date Due of 30mar99 will 
occur on the 30th of every third month, e.g.,30jun99. If the 
month does not have a day with the date, then the latest 
available date in the month is assigned. 
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Yearly Yearly tasks occur once every year. They are assigned Date 
Due values that occur on the same date of the year as the Date 
Due value specified in the Template. For example, instances 
of a yearly task with a Date Due of 3 ldec99 will occur on 
December31st, e.g#> 3 ldec99. If the month does not have a 
day with the date, then the last available date in the month is 
used. 

Manipulating Cyclic Tasks 
Inserting Cyclic Tasks The number of instances of a cyclic task created depends on the Date Due, 

Cycle Type, and Last Cycle Date values specified in the Task Dialog Box. 
The Date Due indicates the date that the first occurrence of the task is due 
and is used to determine the Date Due for all subsequent instances of the 
task. The Cycle Length indicates how often the task will occur: Weekly, 
Monthly, Quarterly, or Yearly. The Last Cycle Date indicates the date the 
last occurrence of the task is due. For instance, if you define a task as 
Cyclic, Weekly with a Date Due value of 05mar99 and a Last Cycle date 
value of 26mar99, four occurrences of the task will be created. The first 
occurrence will have a Date Due value of 05mar99 and the last occurrence 
will have a Date Due value of 26mar99. 

Cyclic tasks may be inserted from the same locations as any other KWS task. 

To insert a cyclic task: 

1. Open a Task Dialog Box by clicking the Insert button. 

2. In the Date Due field, enter the due date of the first occurrence of the 
cyclic task. 

3. Click the Cyclic box. A check will appear in the box, and the Cyclic 
Options fields will become available. 

4. Select the desired Cycle Type: Weekly, Monthly, Quarterly, or 
Yearly. 

5. In the Last Cycle field, enter the date of the last occurrence of the cyclic 
task. 

6.   Enter all other Task data field values as appropriate, then click OK. 
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Modifying Cyclic Tasks      Both the Template and individual instances of cyclic tasks can be modified. 
Changes made to the Template will affect all unfinished instances of the 
cyclic task. Changes made to an individual instance will only affect that 
instance. Possible modifications to cyclic tasks include extending the Last 
Cycle Date, terminating unfinished instances, and changing the Cycle Type. 
In addition, modifications to the task structure can be made by adding or 
subtracting child tasks, attachments, Do Its, and steps. 

Cyclic tasks cannot be changed to noncyclic. 

To extend a cyclic task: 

1. Select the Template for the cyclic task to be extended. 

2. Open the Task Dialog Box by clicking the Modify button in the Task 
Button Bar options. 

3. In the Last Cycle field, enter the new date of the last occurrence of the 
cyclic task. 

4. Click OK. 

To terminate unfinished instances of a cyclic task: 

1. Select the Template for the cyclic task to be terminated. 

2. Open the Task Dialog Box by clicking the Modify button in the Task 
Button Bar options. 

3. In the Last Cycle field, enter the date of the last finished instance of the 
cyclic task. 

4. Click OK. 

5. A message will ask if you are sure you want to delete all of the tasks due 
after the date entered. Click Yes. 

To modify an individual instance of a cyclic task: 

1. Locate the individual instance of the cyclic task to be modified. 

2. Modify the task structure as desired. All changes will be reflected only 
in the individual instance. 
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To modify the task structure for all unfinished instances of a cyclic task: 

1. Locate the Template for the cyclic task to be modified. 

2. Delete unfinished instances of the task. 

3. Modify the task structure as desired. 

4. Extend the cyclic task to the desired date. 

To change the Cycle Type of a cyclic task: 

1. Select the Template for the cyclic task to be changed. 

2. Open the Task Dialog Box by clicking the Modify button in the Task 
Button Bar options. 

3. Change the Cycle Type to the desired value. 

4. Click OK. 

j If you change the Cycle Type of a cyclic task, the change will only affect 
j future projections of the cyclic task. Existing instances of the cycle will 
I remain unchanged. To remove unfinished instances of the previous cycle 
j type, follow the procedure for terminating unfinished instances and then 
I extend the cyclic task to create instances with the new Cycle Type. 

*> Deleting Cyclic Tasks        When deleting cyclic tasks, the Delete Cyclic Task? Dialog Box is displayed 
with the following options: 

Delete All Cycles Deletes all instances (finished and 
unfinished) of a cyclic task. The Template 
is not deleted. 

Delete Just This Cycle Deletes only the selected instance of a 
cyclic task whether finished or unfinished. 

Delete Unfinished Cycles        Deletes all unfinished instances of a cyclic 
task. 

Delete This Cycle and Later    Deletes the selected instance of a cyclic task 
Cycles and all later instances. 

To delete all instances of a cyclic task: 

1.    Select the Template for the cyclic task to be deleted or any instance of 
the cyclic task. 



KWS Ver 3.6 Reference Guide . . ?_^£ 

2. Click the Delete button in the Task Button Bar options. 

3. The Delete? Dialog Box will be displayed. Click Yes. 

4. The Delete Cyclic Task? Window will then appear. From the options 
available, select Delete All Cycles. 

5. Click OK. 

To delete one instance of a cyclic task: 

1. Select the instance of the cyclic task to be deleted. 

2. Click the Delete button in the Task Button Bar options. The Delete? 
Dialog Box will be displayed. 

3. Click Yes. 

4. The Delete Cyclic Task? Window will then be displayed. From the 
options available, select Delete Just This Cycle. 

5. Click OK. 

To delete all unfinished instances of a cyclic task: 

1. Select the Template for the cyclic task to be deleted or any instance of 
the cyclic task. 

2. Click the Delete button in the Task Button Bar options. 

3. The Delete? Dialog Box will be displayed. Click Yes. 

4. The Delete Cyclic Task? Window will then be displayed. From the 
options available, select Delete Unfinished Cycles. 

5. Click OK. 

To delete all instances of a cyclic task due after a specific date: 

1. Select the earliest instance of the cyclic task to be deleted. 

2. Click the Delete button in the Task Button Bar options. 

3. The Delete? Dialog Box will be displayed. Click Yes. 

4. The Delete Cyclic Task? Window will then be displayed. From the 
options available, select Delete This Cycle and Later Cycles. 

5. Click OK. 
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To delete all instances and the template of a cyclic task: 

1. Select the template for the cyclic task to be deleted or any instance of the 
cyclic task. 

2. Click the Delete button in the Task Button Bar options. 

3. The Delete? Dialog Box will be displayed. Click Yes. 

4. The Delete Cyclic Task? Window will then be displayed. From the 
options available, select Delete All Cycles. 

5. Click OK. All instances of the cyclic task will be deleted, but the 
template will remain. 

6. Select the template for the cyclic task to be deleted. 

7. Click the Delete button in the Task Button Bar options. 

8. The Delete? Dialog Box will be displayed. Click Yes. 

9. The Delete Cyclic Task? Window will then be displayed. From the 
options available, select Delete Just This Cycle. 

10. Click OK. 

PREDECESSOR AND SUCCESSOR RELATIONSHIPS 
A task that must be completed before starting another is called a predecessor. 
Conversely, a task that must be performed after another task is called a 
successor. 

Certain rules are enforced whenever a task is designated as a predecessor or 
successor. These rules are: 

• The status of a successor task cannot be set to Started or Finished until 
the predecessor task has been marked Finished or OBE. If you violate 
this rule, KWS displays a message stating that the task cannot be started 
until the predecessor has been completed. If a task is currently waiting 
for a predecessor to be completed, a W will appear in the status column 
of the task. 

• The Start Date of a successor task must be greater than or equal to the 
Date Due of the predecessor task. If you violate this rule, KWS 
reschedules the Start Date of the successor to equal the Date Due of the 
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predecessor. If a task is a predecessor of a milestone, KWS reschedules 
the Date Due of the predecessor to equal the Start Date of the milestone. 

Predecessor and successor links should typically be made between sibling 
tasks. If you need to do otherwise, you should probably rethink the way you 
have decomposed your tasks. The step-by-step nature of predecessor and 
successor links usually infers the sibling relationship. For example, the 
Acquire Funds task (see Figure 3-9) has five child tasks - Write Proposal, 
Write Cover Letter, Review Proposal, Acquire Signature, and Submit. The 
tasks Write Proposal and Write Cover Letter must be completed before 
Review Proposal, so they have been designated as predecessors of Review 
Proposal. Review Proposal must be completed before Acquire Signature and 
Submit and has been designated as a predecessor of the two tasks. Upon 
completion of the final two sibling tasks, the parent task will also be 
completed. This example illustrates how a good task decomposition has 
related child tasks whose completion will result in the completion of the 
parent task. 

Graphical Task Managet rnnnn 

|U) Develop Ver 3.5 Intermediate I w 

J 
rtet^j 

Figure 3-9: Task Structure With Predecessor/Successor Relationships 

Creating Predecessor 
and Successor 
Relationships 

j Predecessors and successors are used in defining workflow. See Workflow 
| in Chapter 4, Attachments, for more detail on workflow. 

The following method describes how to designate predecessor and successor 
relationships within task windows. Predecessor and successor relationships 
can be created by designating one task a successor of another or by 
designating one task a predecessor of another. Which method you use is a 
matter of personal preference. Once a task is designated as a predecessor (or 
successor) of a second task, the second task automatically becomes the 
successor (or predecessor) of the first task. 
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To designate a predecessor task: 

1. Select the task with which you want to create a predecessor relationship. 

2. Click the Pred button. A Predecessor Window will be displayed. If no 
predecessors of the selected task currently exist, this window will be 
empty. 

3. Locate and select the task you would like to designate as the predecessor. 
Drag the selected task to the Predecessor Window by holding down the 
left mouse button and releasing it within the Predecessor Window. A 
message window will ask whether you want to Move or Copy the task. 

4. Select Copy. The task should now be displayed in the Predecessor 
Window. 

To designate a successor task: 

1. Select the task with which you want to create a successor relationship. 

2. Click the Succ button. A Successor Window will be displayed. If no 
Successors of the selected task currently exist, this window will be 
empty. 

3. Locate and select the task you would like to designate as the successor. 
Drag the selected task to the Successor Window by holding the right 
mouse button down and releasing it within the Successor Window. A 
message window will be displayed asking whether you want to Move or 
Copy the task. 

4. Select Copy. The task should now be displayed in the Successor 
Window. 

j Defining predecessor/successor relationships within Task Windows can be 
1 confusing because multiple windows must be opened. We recommend you 
[ define predecessor/successor relationships in the Graphical Task Manager. 
[ See the Creating Predecessor and Successor Links in the GTM section in 
I Chapter 3, Tasks and Steps, for more detail on this option. 

Viewing Predecessor 
and Successor 
Relationships 

In the Task Manager, there is no way to immediately determine from the 
task list if a task has a predecessor or successor. Therefore, it is necessary to 
open the task's Predecessor and Successor Windows to determine if it 
contains any such tasks. 
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♦/* Deleting a Predecessor 
or Successor 
Relationship 

To view a predecessor or successor task: 

1. Select the task for which you want to view the predecessor or successor. 

2. Click the Pred or Succ button in the Task Button Bar options. 

3. A Predecessor or Successor Window will appear. If no predecessors or 
successors of the selected task currently exist, this window will be 
empty. 

When you delete a task from the predecessor or successor list, it is not 
deleted from the task hierarchy; only the predecessor or successor 
relationship is deleted. 

To delete a predecessor (or successor) task: 

1. Select the task whose predecessor (or successor) you wish to delete. 

2. Click the Pred (or Succ) button in the Task Button Bar options. A 
Predecessor (or Successor) Window will be displayed. 

3. Select the item from the predecessor (or successor) list to be deleted and 
click the Delete button in the Task Button Bar options. A dialog box 
will ask you to confirm the deletion. 

4. Click Yes. 

MILESTONES 
A milestone is a zero duration task with a set due date. Whereas a task 
represents an activity that starts, finishes, and consumes resources, a 
milestone represents completion of a task or a set of tasks. The task KWS 
Ver 3.5 is an example of a milestone. This task has a set due date and on its 
own has no duration. Instead, another task would be defined to accomplish 
this milestone such as Develop Ver 3.5 Intermediate Deliverables (Figure 
3-10). The use of milestones within KWS is optional. They are useful when 
you want to assign a task without having to specify a start date and duration. 
The user assigned the milestone would then be responsible for defining the 
task structure required to complete the milestone by the set date. 
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Figure 3-10: Defining a Milestone 

Milestones are displayed in both the Task Manager and Graphical Task 
Manager Windows. The same actions that you can perform on tasks such as 
copying, deleting, and creating predecessor and successor relationships can 
be performed on milestones. 

To view Milestones: 

1. Select Task from the KWS Menu Bar. 

2. Select Milestones from the Task Menu. The Milestones Window 
showing the milestones defined for your organization will be displayed 
(Figure 3-11). 

4- Milestones For Organization FF 

Date Due    Title 

gl27Feb98     Complete TAPES for GS9 
O     ©12Mar98     Budget Report 
O     ©05Jul98       KWS ver 3.0 

.iiJ 
Figure 3-11: Milestones Window 

To insert a Milestone: 

1. Select Task from the KWS Menu Bar. 

2. Select Milestones from the Task Menu. The Milestones Window for 
your organization will be displayed. 

3. Click Insert. The Task Dialog Box will be displayed with the Milestone 
check box already marked (Figure 3-12). 
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Figure 3-12: Milestone Dialog Box 

4. Enter the information required to define the milestone. 

5. Click OK. 

THE GRAPHICAL TASK MANAGER 
The Graphical Task Manager (GTM) enables the user to view tasks in a 
graphical format. The graphical view is presented in a combined hierarchical 
tree and Gantt chart format (Figure 3-13). Depending on your personal 
preference, the graphical display may make it easier to understand the 
"nesting" of tasks and their relationships to each other. It is also easier to 
perform some task manipulations in the graphical view, e.g., assigning 
predecessor and successor relationships. The Task Manager presents the 
same information in text form. 
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Figure 3-13: Graphical Task Manager 

*>   Viewing all Public Tasks    In the GTM, you may view all your organization's public tasks, via the 
in the GTM Graphic Task Manager option in the Task Menu. 

To view all public tasks in the Graphical Task Manager: 

1. Select the Task Menu from the KWS Menu Bar. 

2. Select the Graphical Task Manager option from the Task Menu. 

*>   Viewing a Specific Task     A specific task listed within the Task Manager, a Task Window or the ToDo 
in the GTM List can be viewed graphically via the Graph option in the Available Options 

Menu. 

To view a specific task in the Graphical Task Manager: 

1. Select the desired task from your task list. 

2. Open the Available Options Menu by clicking the right mouse button. 

3. Select the Graph option from the Available Options Menu. 

You may view the items in your ToDo List graphically via the ToDo Graph 
(TDG) option or the ToDo Context Graph (TDCG) option. These options 
open a Graphical Task Manager containing all of your ToDo items. The 
ToDo Context Graph shows the entire task hierarchy for processes that 
include your ToDo items. The items in your ToDo List are displayed in bold 
typeface. 

Viewing a ToDo List in 
the GTM 
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To open the ToDo Graph (TDG): 

1. Select the ToDo Menu from the KWS Menu Bar. 

2. Select the ToDo Graph option from the ToDo Menu. 

To open the ToDo Context Graph (TDCG): 

3. Select the ToDo Menu from the KWS Menu Bar. 

4. Select the ToDo Context Graph option from the ToDo Menu. 

The purpose of the ToDo Context Graph is to enable you to see how your 
ToDo items fit within your organization. If your organization's process 
hierarchy contains many tasks and your ToDo items span several processes, 
the TDCG may be difficult to interpret. In this case, it may be better to use 
the ToDO Graph, which does not show the context of each ToDo item. 

Using the Graphical Task Manager 
The GTM Window (Figure 3-13) is split into two parts by a separator bar: 
The task tree on the left and a Gantt chart on the right. The task tree 
provides a view of the task hierarchy. The Gantt chart provides a view of the 
tasks organized by date. A linear timeline at the top of the Gantt chart 
denotes months and years. 

The Task Tree: In the task tree, each task is connected to its children and 
parents by a line. The task tree view may be expanded and compressed to 
display all of the tasks in the hierarchy or to display only a portion of the 
tasks. A plus (+) sign is displayed to the left of a task when the task has 
children and has not been fully expanded. A minus (-) sign is displayed to 
the left of a task when the task has been fully expanded. 

The Gantt Chart: Each task in the Gantt chart is displayed as a rectangular 
bar, called the task bar, with attendant data in and around it. The attendant 
data includes the task Title, Status Symbols, and Indicator Icons. Depending 
on user-assigned preferences, the Date Due, Start Date, Duration, Percent 
Complete and predecessor/successor links may also be displayed with the 
task. The tasks are organized horizontally by date (Start Date and Date 
Due), with later dates to the right. The tasks are organized vertically by 
Start Date, with earlier tasks at the top. The size of each task is determined 
by the task's duration. The result of this organization is that the tasks layer 
from left to right across the workspace in the order in which they should be 
performed. 

Relationship Between the Task Tree and Gantt Chart: The two sides of 
the GTM Window are synchronized. When you select a task in the task tree, 
the same task is selected in the Gantt chart. Similarly, if you expand or 
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compress a task on either side, the task is expanded or compressed on the 
other. 

<* Adjusting the Separator     The bar separating the two parts of the graphical view is called the Separator 
Bar Bar. This bar can be moved to change the size of the task tree and Gantt 

chart views by dragging it one way or the other. 

To adjust the Separator Bar: 

1. Place the cursor over the bar. When the bar is selected, the cursor will 
change into a bar with arrows. 

2. Click the left mouse button, and drag the bar to move it. 

Viewing and Hiding 
Child Tasks 

| If you slide the bar to the leftmost side of the window, the task tree 
: disappears and the separator bar is represented by a small bar, which appears 
I to the left of the left scroll arrow at the bottom of the window. To move the 
; bar back to the right, select the small bar and drag it. 

When you open the GTM, the task tree and Gannt chart are compressed and 
display only the top-level tasks. To view the children of a particular task, 
you must expand the task. After a task is expanded, the user must compress 
the task to hide the children of the task. 

To expand a task: 

In the task tree, double-click on the task title or click the plus sign to the left 
of the task. 

or... 

In the Gantt chart, double-click on the task bar. 

To compress a task: 

In the task tree, double-click on the task title or click the minus sign to the 
left of the task. 

or... 

In the Gantt chart, double-click on the task bar. 

Moving through the 
Task Tree and Gantt 
Chart 

You can move horizontally in each window using the scroll bars at the 
bottom of the task tree and Gantt chart. The two windows are synchronized, 
so you can move vertically through both windows using the scroll bar at the 
right of the Gantt chart. 
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Expanding and 
Compressing the 
Timeline 

Selecting a Task 

If you need to scroll a long distance through the Gantt chart, compressing the 
timeline can shorten the scroll time. Also, if you click the mouse anywhere 
in the Gantt chart outside of a task, the workspace will scroll horizontally to 
the task located on that line. 

The timeline at the top of the Gantt chart can be expanded or compressed to 
control the length of the time period displayed. You can expand the timeline 
to shorten the timeframe or compress it to lengthen the timeframe. 

To expand the time line: 

1. Move your mouse over the timeline. 

2. Click either mouse button and drag it to the right until the desired time 
period is displayed. 

To compress the time line: 

1. Move your mouse over the timeline. 

2. Click either mouse button and drag it to the left until the desired time 
period is displayed. 

When a task is selected, the task bar is highlighted by a bold border and is 
outlined with a rectangular box. Within the outline, the Late Start Date is 
displayed on the left, the Date Due is displayed on the right, and the 
Duration is displayed in the middle. Other information may also be 
displayed depending on the GTM Window preferences specified See 
Setting GTM Display Preferences in this chapter for more detail. 

To select a task: 

Click on the title of the task in the task tree. 

or 

Click on the task bar in the Gantt chart. 

Changing Percent 
Complete in the GTM 

If you are selecting a task in order to edit it, you must select it from the Gantt 
chart, because tasks cannot be edited from the task tree. 

In the GTM, you can change the Percent Complete value by selecting the 
task and clicking the Modify button to open the Task Dialog Box. In the 
Task Dialog Box, enter the new value for Percent Complete. The GTM 
provides a simpler method that does not require opening the Task Dialog 
Box. 
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To change Percent Complete in the GTM: 

1. Move the cursor between the two date fields in the Task Outline box. 
The cursor will change to a percent sign (%). 

2. Click the left mouse button. The Percent Complete value will be 
displayed above the cursor. 

3. While holding the left mouse button down, drag the percent cursor. 
When your desired Percent Complete value is displayed, release the 
mouse button. 

[ If, in the GTM Window preferences, you specified that you wanted Per- 
j centage Complete to be displayed, then a red line representing the Percent 
| Complete will be displayed over the task bar and will change in size as you 
j drag the % cursor. 

Changing Task Status in    Task Status is changed in the GTM in the same manner as in the Task 
the GTM Manager, that is, via the Task Dialog Box or the Status Symbol Menu. 

To change task status from the Status Symbol Menu: 

1. Click the right mouse button in the space between the task bar and the 
outline (to the left of the task bar). The Status Symbol Menu will appear. 

2. Select the desired status value from the Status Symbol Menu and release 
the mouse button. 

To change task status from the Task Dialog Box: 

1. Select the task and click the Modify button. The Task Dialog Box will 
open. 

2. In the Task Dialog Box, change the status by clicking the box next to the 
desired value. 

3. Click OK to save. 

Remember that only the status of a leaf-level task can be changed. 

Changing Task Dates in     Changes to task dates may be made by either moving the entire task or 
the GTM changing the individual Start Date and Date Due values. 

To change task dates by moving the task: 

1.   Select the task to be moved by clicking on its task bar with the left 
mouse button. 
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2.   While holding the left mouse button down, drag the task to the desired 
location. Note that the Start Date and Date Due change as you move the 
task. 

To change individual task dates: 

1. Select the date to be changed, either the Start Date or Date Due, by 
clicking on it with the left mouse button. A red box will surround the 
selected date. 

2. While holding the left mouse button down, drag the date until the desired 
value is displayed, then release the mouse. 

| You cannot change the Start Date and Date Due of a parent task directly. 
I Instead, you must change the dates of the children, which will cause the dates 
• to change in the parent. However, you can change both the Start Date and 
| Date Due of a parent task by moving the task; the dates of the task's children 
| will be changed accordingly. 

Setting the duedate of a 
subtask by dragging its 
parent task 

In some circumstances, a user may wish to position a task in the Graphical 
Task Manager so that one of its subtasks will fall due on a specific date. 
When a task structure is dragged in the Graphical Task Manager, the 
duedates of all descendant tasks are displayed. The user can drag a task 
until one of its descendant tasks is due on the desired date. 

To set the duedate of a subtask by dragging its parent task in the GTM: 

1. Select the parent task in the GTM. 

2. Expand the parent task until the subtask or descendant task is visible. 

3. Click the left mouse button on the parent task and drag the task left or right. 

4. The new duedates of the descendant tasks will change as you drag the parent 
task. Release the left mouse button when the descendant task has the desired 
duedate. 

Inserting a Task in the 
GTM 

A task may be inserted in the GTM as a sibling or child of another task. 
However, once a task already has a child, additional children are inserted by 
adding siblings to its child. Tasks are inserted into the GTM via the Task 
Dialog Box. See Task Definition in Chapter 3, Tasks and Steps, for detail 
on using the Task Dialog Box. 
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To insert a sibling task: 

1. Select the task for which you want to insert a sibling. 

2. Click the Insert button. The Task Dialog Box appears. 

3. Enter the task information. 

4. Click OK to save. 

To insert a child task: 

1. Select the task for which you want to insert a child. 

2. Double-click the left mouse button. The Task Dialog Box appears. 

3. Enter the task information. 

4. Click OK to save. 

<*  Modifying a Task in the     You may change all task data values within the GTM via the Task Dialog 
GTM Box. See Task Definition in Chapter 3, Tasks and Steps, for detail on using 

the Task Dialog Box. However, the information that can be changed 
depends on the task permissions assigned to the user. See Task Security in 
Chapter 3, Tasks and Steps, for more detail. 

To modify a task in the GTM: 

1.   Select the task to be modified by clicking the left mouse button on its 
task bar. 

Deleting Tasks in the 
GTM 

2. Click the Modify button from the Task Button Bar. The Task Dialog 
Box will open. 

3. Enter your desired modifications into the Task Dialog Box. 

4. Click OK to save your changes. 

You may delete a task in the GTM only if you have been given delete 
permission for the task. See Task Security in Chapter 3, Tasks and Steps, 
for more detail. 

To delete a task from the GTM: 

1. Select the task to be deleted. 

2. Click the Delete button from the Task Manager Window Button Bar. 
The Delete? Dialog Box will be displayed. 

3. Click Yes to delete the appointment or No to cancel. 



KWS Ver 3.6 Reference Guide 3-49 

I Remember that deleting a task deletes all its children, attachments, steps, and 
I Do Its. Use this command with caution. 

Ordering Tasks in the 
GTM 

Tasks can be ordered in the Graphical Task Manager by dragging the task 
up or down in the Task Outline view. The order in which the subtasks of a 
task are arranged will be preserved and restored the next time that task is 
viewed in the GTM. 

To order a set of subtasks in the Graphical Task Manager: 

1. Click the left mouse button on a task in the Task Outline frame of the 
Graphical Task Manager window. 

2. While holding down the left mouse button, drag the task up or down. The 
mouse pointer will change to a horizontal bar. 

3. Drag the horizontal bar pointer to the desired new position of the task in the task 
outline. 

4. Release the left mouse button and the selected task will be moved to the new 
position. 

*!* Printing the Graphical 
Task Manager Window 

The contents of the Graphical Task Manager window can be printed by 
selecting Print from the File menu. The printout will conform to the page 
formatting defined for the current user. 

To print the contents of the Graphical Task Manager window: 

1. Open the Graphical Task Manager window and scroll the tasks to be printed 
into view. 

2. Adjust the date scale by clicking on the date bar at the top of the window and 
dragging the cursor left or right. 

3. Adjust the size and shape of the window so the portion of the graph to be 
printed is in view. Note that whatever appears in the window will be stretched to 
fit the page when printed. 

4. Select Print from the File menu. The Print dialog box appears. 

5. Click OK. 

Saving Changes in the 
GTM 

If you have modified a task in the GTM, a red M symbol will appear in the 
left end of the task bar. If you have inserted a task in the GTM, a red I 
symbol will appear in the left end of the task bar. These symbols will 
remain until the changes are saved to the database. 
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Creating Predecessor 
and Successor Links in 
the GTM 

***  Deleting Predecessor 
and Successor Links in 
the GTM 

*t*   Workflow Icons in the 
GTM 

You may choose to have your changes saved automatically as soonas you 
make them by setting the Save After Each Change to Graph option. See 
Setting GTM Display Preferences for more detail. The option to not have 
changes saved automatically facilitates "what if analysis of your model. 

To save changes in the GTM: 

1. If the GTM is not already the active window, make it active by clicking 
anywhere on it. 

2. Open the Window Menu from the KWS Menu Bar and select Save 
Changes. 

If the GTM is not the active window, the Save Changes option will not be 
available. 

To create a predecessor (or successor) link: 

1. Select the predecessor task. 

2. While holding down the mouse button, press the [Shift] key and drag the 
cursor to the desired successor task. 

3. Release the [Shift] key and mouse button. A red arrow will be displayed 
to represent the link between the two tasks. 

To delete a predecessor (or successor) link: 

1. Select the predecessor task of the link to be deleted. 

2. While holding down the mouse button, press the [Shift] key and drag the 
cursor to the successor task. 

3. Release the [Shift] key and mouse button. The red arrow that indicated 
the predecessor/successor link will disappear. 

Workflow information can be viewed and manipulated in the GTM. For 
more information on workflow documents see Chapter 4, Attachments. 

The GTM workflow icons are: 

Workflow Link 

Workflow Copy 

Workflow Link which sends a workflow copy up to the 
parent task 
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*>   Viewing Workflow Links    To view workflow links in the Graphical Task Manager: 
in the GTM 

1. In the Graphical Task Manager, select the task for which you want to 
view the workflow links. 

2. Select Attachments from the Available Options Menu. 

3. Select Workflow from the Attachments submenu. 

*t* Hiding Workflow Links 
in the GTM 

*!* Linking Workflow 
Documents in the GTM 

4. Select the name of the attachment from the menu. The workflow icons 
will appear next to the tasks that receive either the original or copies of 
the workflow document. 

To hide the workflow links in the Graphical Task Manager: 

1. In the Graphical Task Manger, select the task for which you want to hide 
the workflow links. 

2. Select Attachments from the Available Options Menu. 

3. Select Workflow from the Attachments submenu. 

4. Select Hide from the Workflow submenu. The workflow icons will be 
removed for the view. 

To link a workflow document in the Graphical Task Manager: 

1.   Unhide the workflow icons as described in the steps for viewing 
workflow links. 

Copying a Workflow 
Document in the GTM 

2. Select the tasks you wish to link. 

3. Place the mouse cursor over the workflow icon. When the mouse is over 
the icon, the icon will have a black box around it. 

4. Drag the icon to the next task in the workflow. The workflow link icon 
will now be added to the destination task. 

To copy a workflow document in the Graphical Task Manager: 

1. Unhide the workflow icons (as described in the steps for viewing 
workflow links). 

2. Select the tasks you wish to link. 

3. Place the mouse cursor over the workflow icon. When the mouse is over 
the icon, the icon will have a black box around it. 
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Removing Workflow 
Links or Copies in the 
GTM 

4.   Hold the [Shift] key down and drag the icon to the next task in the 
workflow. The workflow copy icon will now be added to the destination 
task. 

To remove a link or copy of a workflow document in the Graphical 
Task Manager: 

Repeat the steps for creating the link or copy. Dragging the icon to an 
existing link or copy will toggle on and off the link or copy connection. 

Zoom Capability in 
Graphical Task 
Manager Window 

Select the Window|Zoom menu option in the Graphical Task Manager to 
see a zoomed view of tasks. Alternatively, press Ctrl-Z to toggle the 
zoomed view on or off. 

Viewing the Workload 
Graph in the GTM 

You can display a bar graph within the GTM that shows the workload 
distribution for a knowledge worker. 

To view the workload bar graph in the Graphical Task Manager: 

In the Graphical Task Manager, drag the window split bar (Figure 3-14) up. 
The lower section of the Graphical Task Manger window will now show the 
workload graph for the current knowledge worker. 

To view the workload for a different knowledge worker in the Graphical 
Task Manager: 

1. Open the workload view by dragging the split bar up. 

2. Click the knowledge worker selection button once with the left mouse 
button. (The knowledge worker selection button is located in the upper 
right-hand corner of the workload display and is labeled with the current 
knowledge worker.) 

3. Select the knowledge worker or workgroup from the Select KW or 
Group Dialog Box. 

4. Click OK. 
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Figure 3-14: Graph Manager with Workload Window 

You can customize the appearance of the GTM Window by specifying bar 
colors, which task data fields are displayed around the task bar, graph style, 
and whether KWS will save changes to a task as soon as you modify it. 

To set GTM display preferences: 

1.   With a GTM Window active, open the Window Menu from the KWS 
Menu Bar and select Options. The Graph Preferences Window will 
appear (Figure 3-15). 
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Figure 3-15: Graph Preferences Window 

2.   Set display options by clicking on the box next to the option in the 
Display area. If an option is checked then it will be displayed for all 
tasks. The option definitions are: 

Due Date 

Late Start Date 

Duration 

Percent Complete 

Predecessor Links 

Milestones 

The Due Date value for the task will be 
displayed with the task bar. 

The Late Start Date for the task will be 
displayed with the task bar. 

The Duration value for the task will be 
displayed with the task bar. 

A colored bar will be displayed over the task 
bar that represents Percent Complete value for 
the task. 

The predecessor and successor links will be 
displayed by a red arrow between tasks. 

Milestones will be displayed in the GTM. 

3.   Color options may be set for: 

Task Bar For Level 

% Complete Bar 

Allows you to customize the color of the first 
six task levels. 

Allows you to customize the color of the 
Percent Complete bar. 

Set Color options by clicking the button for the item for which you want to 
set the color. The Select Color Window will display (Figure 3-16). 
Set the color by sliding the Red, Green and Blue bar until the desired 
color is displayed in the box to the right. 
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Figure 3-16: Select Color Window 

Set Graph Style options by clicking on the box next to the option in the 
Graph Style area. If an option is checked, then the graph will be 
displayed using that style option. The option definitions are: 

Block 

Bar 

Parent tasks are displayed as blocks that 
surround child tasks. 

All tasks are represented as bars. A selected 
task will have a block that surrounds its child 
tasks. 

Set the Save After Each Change to Graph option. If the Save After 
Each Change to Graph box is checked, KWS will save changes to a 
task as soon as it is modified in the GTM. If the box is not checked, 
then you must explicitly save any changes you make to a task in the 
GTM. 

Set the Save as Default option. If the Save as Default box is checked, 
the preferences you specify will be saved as your default settings for 
future use in KWS. If the Save as Default box is not checked, changes 
made in the Graph Preferences Window will be active for the current 
KWS session only. 

STEPS 
Steps provide an outline of the procedures users must follow in order to 
complete a task. They are the lowest level of detail used to define a task. 
Unlike tasks, steps have few data fields associated with them. Step data 
fields are entered through the Step Dialog Box (Figure 3-17). 
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Step Title: 

Review current TAPES objectives 
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Figure 3-17: Step Window 

The four data fields associated with a step are: 

Step Title A textual description describing the action to be 
performed. 

Step Number The number indicating the order in which the step 
should be performed. 

Completed An indicator of whether the step has been completed. 

Date Completed        The date the step was completed. 

Steps are displayed within the Steps Window (Figure 3-18). They are 
organized by Step Number, which reflects the order in which the steps 
should be performed. Information about each step's status is displayed in the 
leftmost column with a check mark displayed if the step is completed. 
Similar to tasks, icons representing attachments and Do Its are displayed in 
the rightmost columns when these items exist. 

Steps: Prepare for Midpoint TAPES objectives review MSB 
ff    Title 

1.    Review current TAPES objectives 27Feb98 
2.     Print copy of your attached DA form 

2222-1 and annotate required 
revisions for discussion with your 
Division Chief 

Date Finished    Hü 

m 

JLLI ±] 
Figure 3-18: Steps Window 

Viewing Steps Steps associated with a task may be viewed by opening the Steps Window. 

To view steps: 

1.   Select the task for which you want to view steps. 
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2.   Click the Step button in the Task Button Bar 

or.. 

*!* Inserting Steps 

Modifying Steps 

Reordering Steps 

Deleting Steps 

Click the Step icon in the Indicator Column. In either case, the Steps 
Window will be displayed. 

To insert a step: 

1. Select the task for which you want to insert the step. 

2. Click the Steps button from the Button Bar or the Steps icon in the 
task's indicator column (if one exists). The Steps window for the 
selected task will open. 

3. To add a step in a specific location in the steps list, select the step that 
will precede the new step. 

4. Click the Insert button. The Step Dialog Box will open. 

5. Enter the Step Title in the Step Dialog Box. 

6. Click OK to save. 

To modify a step: 

1. Select the step to be modified. 

2. Click the Modify button. 

3. Change the step information as desired and click OK to save. 

The order in which steps are listed in the Steps Window can be changed by 
modifying the Step Number value. 

To reorder a step: 

1. Select the step to be reordered. 

2. Click the Modify button. The Step Dialog Box will appear. 

3. Change the value of the Step Number to the new value. 

4. Click OK to save. 

To delete a step: 

1.   Select the step to be deleted. 
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Changing Step Status 

Moving and Copying 
Steps 

2. Click the Delete button. The Delete? Window will appear. 

3. Click Yes to confirm your deletion, or Click No to cancel. 

Be careful when deleting steps. Deleting a step also deletes all links to any 
Do Its and attachments associated with the step. 

Steps can be assigned status values of Complete or Not Complete. Similar 
to tasks, the status of a step can be set through the Step Dialog Box or the 
Status Symbol Menu. 

To change step status via the Step Dialog Box: 

1. Select the desired task. 

2. Click the Steps button. The Steps Window will appear. 

3. Click the Modify button. The Step Dialog Box will appear. 

4. In the Step Dialog Box, a step is complete when the box to the left of the 
Complete field is checked and not complete when it is not checked. 
Click on the checked box to make the check disappear and vice versa. 

5. Click OK to save. A check mark will appear in the symbol field next to a 
completed step. 

To mark a step complete via the Status Symbol Menu: 

1. Click your left mouse button in the leftmost column of the Step Window 
next to the desired step. The Status Symbol Menu will appear. 

2. While holding the mouse button down, select the desired Status value 
and release the mouse button. 

Steps can be copied or moved to new locations within the task hierarchy. 
When a step is moved, all of its attachments and Do Its links are moved 
along with it. When a step is copied, new links are created between the new 
steps and the attachments and Do Its. It is important to remember that the 
attachments and Do Its are not copied. The attachments and Do Its are the 
same ones linked to the original step, so any changes made to them from the 
new step will be reflected in the old step. 

To copy or move a step: 

1.   Open the destination Step Window by selecting the task that the step will 
be associated with and clicking the Steps button or icon. 
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2. Open the Step Window containing the step(s) to be moved by selecting 
the associated task and clicking the Steps button or icon. 

3. Select the step to be moved or copied. Hold down the left mouse button 
and drag the selected step to the destination window. 
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OVERVIEW 

KWS Ver 3.6 Reference Guide 

Attachments are information resources used during the execution of an 
activity. Attachments can be associated with any of the following items: 
tasks, steps, appointments, and milestones. An association between any of 
these items and an attachment is referred to as an attachment "link." 
Attachments may be defined during the initial development of a KWS 
process model or ad hoc, as required by the user. 

This chapter describes how to create an attachment, manipulate attachments 
to support'task execution, define attachment access rights, and define 
attachment workflows. 

DEFINING ATTACHMENTS 

Each attachment has a specific set of information or data fields associated 
with it. This information is referred to as the Attachment Profile. When an 
attachment is created within KWS, the Attachment Profile information is 
stored in the KWS database and is used to search for and retrieve the file. 
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The Attachment Profile Dialog Box 
Attachments are entered into the KWS database through the Attachment 
Profile Dialog Box (Figure 4-1). The Attachment Profile Dialog Box 
contains a set of data fields and captures user-specified values that define 
attachments within KWS. In addition, the Attachment Profile Dialog Box 
contains buttons used to access dialog boxes for capturing and viewing 
additional attachment information. The following sections describe the user- 
specified and KWS-generated data fields contained in the Attachment Profile 
Dialog Box. 

Attachment Profile 

Public 

Title: 

Description: 

Application: 

Storage Type: 

Attachment Type: 

Context: j 

Long-T erm S totage: | Keep 

MARKS Number:      I 

SME Guidelines) Version: 

Guidelines for SME Documentation 

~3 
Referential "3 

'J 

Retention Days: 

1365 

History 

Status: Available 

Created By: KAPPES_S 

Date Created: 09Feb97 

Last Edited By: 
Last Edit Date:   

Access Rights... 

Links... 

OK Cancel 

Figure 4-1: The Attachment Profile Dialog Box 

User-Specified Data Fields 
The following sections describe the Attachment Profile data fields entered by 
the user when defining attachments within KWS. 

Title 
Entering the Attachment    To enter an attachment Title: Type the desired value into the Title field. 
Title 

Description: A descriptive name given to the attachment. 
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Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols. 

Default Value: Blank 

Usage: The Title value should contain a textual description that enables you 
to easily recognize what is contained in the attachment file, not the actual 
DOS file name. For example, use a descriptive title that will remind you of 
the nature of the attachment such as FY98 Budget Report. For an individual 
item, the Title value should be unique so that you can differentiate it from 
others. The Title values for versioned attachments cannot be changed from 
the original attachment's title. 

Description 

Entering an Attachment     To enter an attachment Description: Type the desired value into the 
Description Description field. 

Description: Text describing the nature of the document. 

Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols. 

Default Value: Blank 

Usage: The Description value contains text that enables you to easily 
identify the purpose of the document and differentiate between attachment 
versions. For example, use a description that will remind you of the 
differences between versions such as 1st Quarter Revision and 2nd Quarter 
Revision. 

Application 

Entering the Application    To enter the Application Name: Click the small arrow to the right of the 
Used To Create an field and select the desired value from the list provided. 
Attachment 

Description: The name of the application software or computer program 
used to create and launch the attachment file. 

Type: A text field selected from your Application List. 

Default Value: Blank 

Usage: The Application Name is used by KWS to locate and launch the 
software required when editing the attachment. If the Application Name is 
left blank, you will not be able to edit the attachment. The Application 
Name is selected from a list you specify in the KWS File Menu, Preferences, 
Applications option. See Chapter 7, Customizing KWS, for more detail. 
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When you import an attachment file for which you have a predefined 
association for the extension of the file name, KWS will use the filename 
extension to automatically set the Application Name. This value can be 
changed if required. See Chapter 7, Customizing KWS for more detail. 

When creating a new attachment, the Application Name field of the 
Attachment Profile dialog box lists only those applications for which a 
template has been defined. A template is necessary in order to create a new 
attachment. When importing an attachment file, all applications are listed 
regardless of whether a template is defined. 

Storage Type 

Entering the Attachment    To enter the attachment Storage Type: Click the small arrow located to 
Storage Type the right of the field and select the desired value from the list provided. 

Description: An indicator used by KWS to determine the physical location 
for storing the attachment file. 

Type: A text field selected from a list containing the values Public, Private, 
or Removable. 

Default Value: Public 

Usage: Storage Type indicates the physical location for storing the 
attachment file. There are three possible values: Public, Private, or 
Removable. Public files are stored on the KWS shared file server and can 
be accessed by all KWS users. Private files are stored on the KWS work- 
station of the individual creating the attachment and can only be accessed by 
the attachment creator. Removable files are stored on a removable media of 
your choice such as a floppy or Bernoulli disk. The directories for Public 
and Private attachments are defined by KWS during the KWS installation 
process. See Database and File Storage Setup, in Chapter 7, Customizing 
KWS for more detail. There is no required directory structure for removable 
media, but it is recommended that the media be dedicated for KWS use only. 

Attachment Type  

Entering the Attachment    To enter the Attachment Type: Click the small arrow to the right of the 
Type field and select the desired value from the list provided. 

Description: Indicates the category of a document. 

Type: A text field selected from a list containing a blank value and 
Referential. 

Default Value: Blank 
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Usage: The Attachment Type value is used by KWS to determine storage 
and archival routines for attachments. A blank Attachment Type value is 
used for most attachments to indicate a general category. This general 
category includes attachments that are a product generated by a task. An 
Attachment Type value of Referential is used to indicate that an attachment 
contains information that may be useful in completing the task but will not be 
modified during the execution of the task. Examples include online Standing 
Operating Procedures and Department of the Army Regulation documents. 
When an attachment is specified as Referential, it will be stored in the 
referential attachment directory specified during KWS setup. See Chapter 7, 
Customizing KWS, for detail on KWS Database and File Storage Setup. 

1 The Attachment Type field is a relatively new feature and is not fully 
| functional. Currently only two values are available: blank and Referential. 
(Future versions will allow for additional values. Its primary purpose in the 
| current version is to separate Referential attachments from other attachments 
| so that routines may be developed to improve access, sharing, and 
(administration of referential documents. 

Context 

Entering the Context of 
an Attachment 

To enter the Context: Type the desired value into the Context field or 
click the small arrow to the right of the field and select the desired value 
from the list provided. 

Description: A value used for organizing and searching attachments. 

Type: A text field selected from a list or entered by the user that can include 
any combination of alphanumeric characters, punctuation marks, and 
standard ASCII symbols. 

Default Value: Blank 

Usage: The Context field is for organizing and searching for attachments 
based on its subject matter. It is an optional field but is useful for grouping 
related attachments. For example, if you want to relate all your attachments 
for a specific subject such as "Personnel," you could enter the value 
Personnel into the Context field. You could then do an attachment search to 
list all attachments with the Context field value of Personnel. 

Long-Term Storage 

To enter the Long-Term Storage: Click the small arrow to the right of the 
field and select the desired value from the list provided. 

Description: An indicator used by KWS to determine the long-term storage 
type. 



Retention Days 

Type: A text field selected from a list containing the values Keep, Archive, 
and Delete. 

Default Value: Keep 

Usage: The Long-Term Storage field applies only to Public attachments 
and is used by KWS to determine where the attachment file should be stored 
on a long-term basis. There are three possible values: Keep, Archive, or 
Delete. Files with a storage type of Keep will remain in the KWS 
attachment directory indefinitely. Files with a storage type of Archive will 
be moved to the KWS attachment archive directory when the file has not 
been viewed or edited within the retention period. The directories for 
archival purposes are defined during the KWS installation process. See 
Chapter 7, Customizing KWS for more detail. Files with a storage type of 
Delete will be deleted from the KWS attachment directory once the file has 
not been viewed or edited within the retention period. 

To enter the number of Retention Days: Type the desired value into the 
Retention Days field. 

Description: The number of days before an inactive attachment will be 
archived or deleted. 

Type: A number. 

Default Value: 365 

Usage: The number of Retention Days is used by KWS to determine when 
an attachment is considered inactive. If an attachment with Long-Term 
Storage type of archive or delete has not been viewed or edited within the 
retention days period, the attachment is considered inactive and will be 
archived or deleted. 

MARKS Number 

To enter the MARKS Number: Type the desired value into the MARKS 
Number field or click the ... button to the right of the field to open the 
MARKS Number dialog box. The dialog box contains a search utility to 
assist you in determining the MARKS number. 

Description: A document categorization standard used by the US Army. 

Type: A text field containing a valid MARKS Number. 

Default Value: blank 
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Usage: The MARKS Number is used for organizing and categorizing 
documents. This information is optional within KWS. 

Access Rights 

Access Rights. 
The Access Rights... Button on the Attachment Profile Dialog Box 
is used to define user access rights for attachments. Clicking the 
Access Rights... Button displays the Attachment Access Rights 
Dialog Box (Figure 4-2) where the following values may be 
assigned by Knowledge Worker and Work Group. See Attachment 
Access Rights, in this chapter for more detail. 

Attachment Access Rights 

User/Group:   PUBLIC 

■ Assigned Access R ights - 

f" View Profile 
■<• [Read/Cog 

<"" Read/Copy/Edit 

f Security Restrictions" 

r™ Sensitive 

V Locked 

f~ Save as my default PUBLIC access rights for new attachments 

User/Group Description Cumulative Access Rights 

BROWN C 
JONES M 
KELLY_G 
WENT_L 
ACCT 
OPS 

Chuck Brown 
Mike Jones 
George Kelly 
Lyn Went 
Group 
Group 

OK 

View Profile, 
View Profile, 
View Profile, 
View Profile, 
View Profile, 
View Profile, 

Cancel 

Read/Copy 
Read/Copy/Edit 
Read/Copy 
Read/Copy 
Read/Copy 
Read/Copy 

Figure 4-2: Attachment Access Rights Dialog Box 

Access Rights 

View Profile Allows the user or work group to view only the 
attachment's profile and not the attachment 
file. 

Read/Copy Allows the user or work group to view the 
attachment's profile and to view or copy the 
attachment file, but not to edit the document. 

Read/Copy/Edit Allows the user or work group to view the 
attachment's profile and to view, copy, and edit 
the attachment file. 



KWS Ver 3.6 Reference Guide 4-9 

Security Restrictions 

Sensitive Allows only the attachment creator to view the 
attachment profile and access the attachment 
file. If Sensitive is checked, the attachment 
title is displayed in the Attachments Window 
only when the attachment creator is logged in. 

Locked Allows the attachment creator to lock the 
attachment. If Locked is checked the attached 
file can be viewed but cannot be edited. An 
attachment that is checked out is automatically 
locked. 

WWW User-Specified Data Fields 

Title 

The following section describes the user-specified data fields contained in 
the WWW Attachment Profile Dialog Box (Figure 4-3). 

WWW Attachment Profile 

Title: Guidelines Page) 

Description:     P^T Guidelines web pages 

http address:   | nttP: "www. army, mil/rvt. html 

Context: RVT "3 
p History  

Created By: 

Date Created: 

KAPPES.S 

09Feb97 

Links... 

OK Cancel 

Figure 4-3: WWW Attachment Profile Dialog Box 

To enter a WWW Attachment Title: Type the desired value into the Title 
field. 

Description: A descriptive name given to the attachment. 

Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols. 

Default Value: blank 
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Description 

http address 

Usage: The Title value should contain a textual description that enables you 
to easily recognize the contents of the attachment web page. 

To enter a WWW attachment Description: Type the desired value into the 
Description field. 

Description: Text describing the nature of the web page. 

Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols. 

Default Value: blank 

Usage: The Description value contains text that enables you to easily 
identify the purpose of the document and differentiate between attachment 
versions. 

To enter a WWW Attachment http address: Type the desired value into 
the http address field. 

Description: The http address of the attachment web page. 

Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols that make up a 
valid URL. 

Default Value: blank 

Usage: The http address contains the URL of the attachment web page. 

Context 

To enter a WWW Attachment context: Type the desired value into the 
Context field or click the small arrow located to the right of the field and 
select the desired value from the list provided. 

Description: A value used for organizing and searching attachments. 

Type: A text field selected from a list or entered by the user that can include 
any combination of alphanumeric characters, punctuation marks, and 
standard ASCII symbols. 



KWS Ver 3.6 Reference Guide 4-11 

Default Value: Blank 

Usage: The Context field is for organizing and searching for attachments 
based on its subject matter. It is an optional field but is useful for grouping 
related attachments. For example, if you want to relate all your attachments 
for a specific subject such as "Personnel," you could enter the value 
Personnel into the Context field. You could then do an attachment search to 
list all attachments with the Context field value of Personnel. 

KWS-Generated Data Fields 

Version 

Status 

The following data fields are generated by KWS when a user defines an 
attachment within KWS. 

Contains the version number of the attachment file. 

The current accessibliry status of the attachment file. The values of the 
status field are: 

Available The document is unlocked and available for 
edit. 

Locked The attachment is locked and can not be 
edited. 

Created By 

Check Out By ...       The attachment document has been checked 
out by the specified user and is locked. 

The KWS User ID of the user who created the link to the attachment file. 
This value is used by KWS to determine who has subsequent modify rights 
to the attachment's profile. 

Date Created 

The date the attachment link was created. 
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Last Edit By 

Last Edit Date 

Contains the KWS User ID of the user who last edited the attachment file. 
This value is set whenever a user opens the attachment via the Edit button in 
the Attachment Window Button Bar. 

Contains the date the attachment file was last edited. This value is set 
whenever a user opens the attachment via the Edit button in the Attachment 
Window Button Bar. 

Links 

Links... 
Indicates the number of links to items associated with an attachment 
file. This value can be obtained by clicking on the Links... button in 
the Attachment Profile Dialog Box.   Clicking the Links... button 
will display the Attachment Links Window (Figure 4-4) that displays 
the number of links and lists the titles of all items attached to the 
attachment file. 

You can move to one of the linked Tasks by selecting the task and 
then clicking the Go To Task button. A Task Window will open and 
list the selected task and its siblings. 

Attachment Links 

: Number Of Links: 6 

JAS I..   V/nte Prppp: .ä! 
C TASK 
WTASK 
WTASK 
WTASK 
WTASK 

Acquire Funds 
Aquire Signatures 
Review Proposal 
Submit 
Write Proposal 

Go To Task Close 

Figure 4-4: Attachment Links Window 

THE ATTACHMENTS WINDOW 
The Attachments Window (Figure 4-5) lists the attachment associated with a 
selected item alphabetically by Title. The information displayed in the 
window is determined by your display field setup. For instance, you may 
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change the order of the fields displayed or remove a field from display. See 
Chapter 7, Customizing KWS, Display Field Setup, for detail. 

Ü ATTACHMENTS: Task Identify SMEs to decompose tasks HBO I 
Title Version        Storage 

Document Templates 
Guidelines Page 

& Index Doc 
W   CSME Document 
R      SME Guidelines 

Public 
WWW 
Public 
Public 
Public 

<i   1 Jj 

Figure 4-5: The Attachments Window 

The columns on the left of the Attachments Window contain symbol(s) that 
indicates the type and status of each attachment.   There are three types of 
attachments: Normal, Referential, and Workflow. No symbol appears if 
the attachment is type Normal. There are two status symbols for 
attachments: Locked and Checked-Out. The following are the type and 
status symbols for attachments: 

Accessing Attachments 
Window Options 

R Referential 
W Workflow 
C Checked-Out 

Ö Locked 

Options for manipulating attachments within the Attachments Window are 
accessed in the Attachments Window Button Bar and the Available Options 
Menu. These options are available whenever the Attachments Window is 
active. 

To access Attachments Button Bar options: 

1. Select the item associated with the attachment. 

2. Click the Attach button in the button bar or the attachment icon in the 
indicator column to the right of the item. An Attachments Window will 
open and the Attachments Button Bar (Figure 4-6) will be displayed with 
the Insert, Delete, Profile, View, Edit, Export, Copy, Version, Check 
Out, and Check In options available for attachment manipulation. 

Insert    1    Delete   |    frotile   |     View Edit |    Expert   |    Copy    |   Veislon ;|'Cftcdc.Pflt. 

Figure 4-6: The Attachments Button Bar 
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Edit 
Export 
Copy 

Version 
Check Out 
Check In 
Links 

Profile 
Delete 

Define Workflow 

To access the Attachment Window Available Options Menu: 

1. Within the Attachment Window, select the desired attachment. 

2. Click the left mouse button. The Available Options Menu will be 
displayed with the View, Edit, Export, Copy, Version, Check 
Out, Check In, Links, Profile, Delete, and Define Workflow 
options available for attachment manipulation. 

The Available Options Menu provides the same options 
available from the Attachment Window's Button Bar, except 
Insert. In addition, the Available Options menu provides the 
options Links and Define Workflow. See Workflow in this 
chapter for more details. 

Attachment Window Sort   The Attachment window provides a dialog box that allows the user to select 
Options from several sort choices, including chronological, reverse chronological 

and alphabetical. 

To specify the sort order for an Attachment window: 

1. Activate the Attachment window and select Options... from the 
Window menu. 

2. Select Sort... from the pull-down menu. 
The Attachment Window Sort Options dialog box appears. 

3. Select an option from the Sort Order group box. Ifyouwishto 
preserve this sort order as the default for all Attachment windows, check 
the Save Options as Default checkbox. 

4. Click OK. 

Inserting an Attachment     When a user inserts a new attachment, a link is made from the attachment to 
the selected item. Attachment links may be made to URLs, existing files or 
to new files you create during the linking process. 

To insert an attachment link to an existing file: 

1. Select the item to which the file will be linked. 

2. Click the Insert button. 
The Attachment Insert Dialog Box appears (Figure 4-7). 
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3.   From the Attachment Insert Dialog Box, select Import. 
A file browsing window opens. 

Attachment Insert 

import   ! Create WWW 

Cancel 

Figure 4-7: Attachment Insert Dialog Box 

4. In the file browsing window, locate and select the file you want to attach 
and click OK. 
The Attachment Profile Dialog Box displays. 

5. Enter the information describing the attachment in the Attachment 
Profile Dialog Box. 

6. Click OK. 
The new attachment will appear in the Attachment Window. 

To insert an attachment link to a new file: 

1.   Select the item to which the file will be linked. 

2. Click the Insert button. 
The Attachment Insert Dialog Box will be displays. 

3. From the Attachment Insert Dialog Box, select Create. 
The Attachment Profile window displays. 

4. Enter the information describing the attachment in the Attachment 
Profile Dialog Box. 

5. Click OK. 
The application software entered in the Application Name field of the 
Attachment Profile will be launched with the new file. 

6. Follow normal procedures for editing and saving the document with the 
launched application. (DO NOT CHANGE THE NAME OF THE FILE— 
KWS only recognizes the link to the filename it generated.) After you 
exit the application, the new attachment will be displayed in the 
Attachment Window. 
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To create a WWW attachment: 

1. Open the Attachment Window. 

2. Click the Insert button. 

3. On the Attachment Insert Dialog Box, click the WWW button. 
The WWW Attachment Profile Dialog Box opens. 

4. Enter the information describing the attachment in the Attachment 
Profile Dialog Box. 

5. Click OK. 
The new attachment will appear in the Attachments Window. 

Deleting an Attachment     When deleting an attachment, only the link to the attachment file is deleted 
and not the file itself. If the last link to an attachment is deleted, the 
attachment file will be deleted. However, the user is given the opportunity 
to store the file outside the KWS environment if desired. 

To delete an attachment: 

1. Select the attachment to be deleted. 

2. Click the Delete button. The Delete? Dialog Box will be displayed 
(Figure 4-8). 

1 Delete? Ell 

■®- 
Do you want to delete the link to attachment: 

SME Guidelines 

Yes f'illlllj 

Figure 4-8: The Delete? Dialog Box for Attachments 

3. Click Yes to confirm the deletion, No to cancel. 

4. If you deleted the last link to the attachment, the Attachment Delete 
Dialog Box will be displayed (Figure 4-9). 

5. Ifyou want to save a copy ofthe attachment file, click Yes. Otherwise, 
click No. [Ifyou clicked Yes, a file browser window will be displayed 
where you can designate the name and location ofthe saved file.] 
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| Only the user who created the attachment link (or System Administrator) is 
I able to delete it. 

Attachment Delete 

/"«j^X     Budget Report   ■■■■'.:.■;"' 

^^     This is the last link to this attachment file in KWS. 

Do you want to save the file to another location before it is deleted from the KWS storage area? 

j      Yes No 

Figure 4-9: Attachment Delete Dialog Box 

*>   Viewing and Modifying      Most of the attachment information defined within the Attachment Profile 
an Attachment Profile        can be viewed in the Attachment Window display fields. However, to 

modify or view all of the information it is necessary to open the Attachment 
Profile. 

To view or modify Attachment Profile information: 

1. Select the attachment for which you want to view or modify the 
Attachment Profile. 

2. Click the Profile button. The Attachment Profile Window will be 
displayed. 

3. To modify the Attachment Profile, enter the new values in the 
appropriate data fields and click OK to save. To view only and exit 
without making changes, click Cancel. 

Only the user who created the original attachment link (or System Adminis- 
trator) is able to modify the Attachment Profile information. The User ID of 
the attachment link creator is contained in the Created By data field for the 
attachment. 

*** Dragging Files From 
Windows Explorer 

Files can be dragged from a Windows Explorer folder into a KWS 
Attachment, Task, or Step Window. If dragged to an Attachment Window, 
the files are added to the list of attachments. If dragged to a Task or Step 
Window, the files are attached to the tasks or steps selected in that window. 

To drag files from Windows Explorer to KWS 

1.    Open the Attachment, Task or Step window in KWS where you wish to attach 
the files from Windows Explorer. If the target window is a task or step, select 
the specific item where the file(s) will be attached. 

2.    Select one or more files from a folder in Windows Explorer. 
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3. Drag the file(s) to an Attachment, Task or Step window in KWS. 

4. A new attachment is created for each file you dragged. If you dropped the 
file(s) into an Attachment Window, each is added to the list of attachments 
within that Attachment window. If you dropped the file(s) into a Task or Step 
Window, each is attached to the specific tasks or steps selected within that 
window. 

Viewing an Attachment 
File 

KWS attachment files may be viewed without loading the application used 
to create it. For instance, a file created in WordPerfect can be viewed on the 
computer screen without requiring a copy of WordPerfect. You must 
specify a file viewer for use with KWS to have the capability to view 
attachments. If you do not specify a file viewer, the View option will not be 
available. See Chapter 7, Customizing KWS, for more detail on setting up a 
file viewer. 

To view an attachment file: 

1. Select the attachment for which you want to view the file contents. 

2. Click the View button from the Attachment Window Button Bar options. 
Your file viewer software package will be launched with the attachment 
displayed. 

3. Follow normal procedures for viewing the document within the file 
viewer application. When finished, exit the application to return to 
KWS. 

Modifying an 
Attachment File 

I If you do not have a file viewer software package or your file viewer does 
I not support the attachment file's format, you will have to launch the 
I application used to create the file in order to view it. You can do this by 
I clicking the Edit option instead of the View option available from the 
| Attachments Window Button Bar. However, if you do not have Edit access   ; 
| rights, you will not be able to open the file using this method. 

KWS attachment files may be modified with the application used to create it. 
You must have a copy of the attachment's associated application, and the 
application must be defined in your Application List in order to edit it. See 
Chapter 7, Customizing KWS, for more detail on defining your application 
list. In addition, you must be the attachment's creator or have Edit access 
rights. 

To modify an attachment file: 

1.   Select the attachment to be modified. 

Click the Edit button. KWS will launch the associated application with 
the selected attachment file. 
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Exporting an Attached 
File 

3.   Follow normal procedures for editing and saving the document with the 
launched application. (DO NOT CHANGE THE NAME OF THE FILE— 
KWS only recognizes the link to the filename it generated.) 

At times it may be necessary to copy an attachment file and save it to a 
location external to the KWS environment. For example, you may need to 
give a copy of an attachment file to someone who is not a KWS user or who 
is at a remote location. Within KWS, this capability is referred to as 
"exporting." 

To export a copy of an Attachment file: 

1. Select the Attachment for which you want to export a copy. 

2. Click the Export button from the Attachment Window Button Bar 
options. The Attachment Export Dialog Box will open (Figure 4-10). 

Attachment Export 

Expurl To        

<? JFiiel 
r Email 

r Fax 

Re name: 

OK Cancel 

Figure 4-10: Attachment Export Dialog Box 

3. Click the File button to the right of the File Name field. 
A file browser window opens. 

4. In the file browser window, specify a name and location for the exported 
attachment and click OK. 

[rTislmportant to remember that exporting an attachment file makes a copy of 
(the attachment from the KWS environment. The original attachment file 
I remains within KWS. 

To send an Attachment to other knowledge workers as email: 

1. Select an Attachment in an Attachment window. 

2. Click the Export button on the button bar. 
The Attachment Export Dialog Box appears. 

3.   Select the Email option in the Export To group box. 
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4. Click the Next button. 
The Notification Dialog Box appears. 
The Attachment file appears in the Attachments field. 

5. If desired, enter a subject and text, and/or select one or more knowledge 
workers, groups and email addresses as recipients. 

6. Click OK. 

j To export an attachment as email, you must have a MAPI compliant email 
1 program and it must be currently running on your machine. Ask your 
j System Administrator if you have questions about your email program. 

To export an attachment as a FAX: 

1. Select the attachment to export. 

2. Click the Export button. 
The Attachment Export Dialog Box appears. 

3. Select FAX from the Export To section. 

4. Click OK. 
KWS will then pass the attachment file to your FAX program. 

| To export an attachment as a FAX, you must first specify (one-time only) a 
[ FAX program for your KWS login. See Chapter 7, Customizing KWS, for 
j more on setting up KWS to work with a FAX program. 

Making Copies of an 
Attachment Linked to 
Multiple Items 

You can make copies of an attachment file to more than one task, step, 
appointment, or milestone through the Copy option in the Attachment 
Window Button Bar. 

To make copies of an attachment to multiple items: 

1. Select the attachment that you want to copy. 

2. Click the Copy button. 

3. If the attachment has multiple links, the Copy Links? Dialog Box will be 
displayed (Figure 4-11). If you want the new copy to have the same links 
as the original, click Yes. Otherwise, click No. 
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Copy Links? 

<5>' This attachment has multiple links,. Doyou want this new copy of the attachment to have the same links as the original? 

Yes 

Figure 4-11: Copy Links? Dialog Box 

Creating Versions of an     Versions of attachment files can be made to save variations of a single 
Attachment File document as separate files. This capability can be used to track revisions of 

a document. 

To create a new version of an attachment file: 

1. Select the attachment for which you want to make a version. 

2. Click the Version button. KWS will make a new version by making a 
copy of the selected attachment, incrementing the highest version 
number of the selected attachment by 1, and assigning the result to the 
version number of the copy. The new version will have the same title as 
the original attachment and cannot be changed. 

3. (Optional) Enter text in the Description field of the new version that 
indicates the purpose of the version. Do this by modifying the 
Attachment Profile. Use this Description to differentiate between 
versions. 

Locking Attachments 

When you make a version of an attachment, you will become the owner of 
the new version. This will be reflected in the Attached By field value in the 
Attachment Profile. All other profile information remains the same.         

Attachments can be locked by the owner to prevent other users from editing 
the attached file. An attachment that is currently locked will be indicated by 
a padlock icon to the left of the attachment in the Attachment List Window. 

To lock an attachment: 

1. Open the profile for the attachment. 

2. Click the Access Rights button. 
The Attachment Access Rights Dialog Box opens. 

3. Click the Locked check box. 

4.   Click OK. 
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To unlock an attachment: 

1. Open the profile for the attachment. 

2. Click the Access Rights button. 
The Attachment Access Right Dialog Box opens (Figure 4-12). 

3. Click the Locked check box. 

4. Click OK. 

Attachment Access Rights 

User/Group:   PUBLIC 

-Assigned Access Rights- 

C View Profile 

C Read/Copy/Edit 

• Security Restrictions- 

r~ Sensitive 

F" Locked 

r" Save as my default PUBLIC access rights for new attachments 

User/Group Description Cumulative Access Rights 

/iew Profile.. Read/Cony PUBLIC 
BROWN C Chuck Brown View Profile, Read/Copy 
JONES M Mike Jones View Profile, Read/Copy/Edit 
KELLY G George Kelly View Profile, Read/Copy 
WENT L Lyn Went View Profile, Read/Copy 
ACCT Group View Profile, Read/Copy 
OPS Group View Profile, Read/Copy 

OK     \     Cancel  | 

Figure 4-12: Attachment Access Rights 

Attachment Check-In 
and Out 

There may be times when you want to edit an attached document outside of 
the KWS environment. KWS provides a check-out and check-in function to 
allow you to temporarily use a document outside of the KWS program. The 
check-out capability enables users to copy files to external media for editing 
outside KWS. While a file is checked-out, the Attachment will be locked 
and disallow any editing until the document has been checked back in. Any 
user with edit rights for the Attachment can check out the document. 

To check-out an attachment document: 

1.   Select the attachment in the Attachment Window. 
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2. Click the Check-Out button on the Attachment Window Button Bar. 
The Check-Out Attachment File Dialog Box appears. 

3. Enter the Save Filename for the Attachment document. 

4. Click OK. 
The Check-Out Attachment File Dialog Box closes. The attachment is 
now locked until the document is checked back in. 

To check-in an attachment document: 

1. Select the attachment in the Attachment Window. 

2. Click the Check-In button on the Attachment Window button bar. 
The Select Files To Check In Dialog Box appears. 

3. Select the file to check back in as the attachment. 

4. Click OK. 
The Select Files To Check In Dialog Box closes. The attachment is now 
unlocked. 

I Note that the attachment document must be checked back in by the same user 
\ who checked the document out. 

MOVING, COPYING, AND LINKING ATTACHMENTS 
When you move, copy, or link existing attachments within KWS, it is 
important to understand the relationships that may exist between items and 
attachments. When an attachment is inserted, its initial link to an item is 
created (Figure 4-13(a)). Once created, the attachment may be linked to 
additional items (Figure 4-13(b)), the attachment may be copied and the copy 
linked to another item (Figure 4-13(c)), and the link may be moved from one 
item to another (Figure 4-13(d)). 
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Taskl u Attachment 1 [a] Original attachment linked 
to a single task. 

Taskl 

Task 2 

Task 3 

m Attachment 1 (b) An attachment linked 
to multiple tasks. 

Taskl 

Task 2 

€1 
U 

Attachment 1 

Attachment 1 

[c] Copy of an attachment linked 
to separate tasks. 

Taskl 

Task 2 

Taskl 

Task 2 

d Attachment 1 

move link from 
task1totasiif 

[dj Attachment link moved from 
one task to another. 

% Attachment 1 

Figure 4-13: Attachment Link Relationships 

Moving an Attachment 
Link to Another Item 

Moving an attachment creates a link with a new item and deletes the link 
from the item from which it was moved. 

To move an attachment link to another item: 

1. Select the item associated with the attachment that you want to move and 
open its Attachment Window by clicking the Attach button. 

2. Select the destination item (the one to which you want to move the 
attachment) and open its Attachment Window by clicking the Attach 
button. 

| You should now have two Attachment Windows open—one for the 
j originating item and one for the destination item. 

Select the attachment that you want to move, hold down the left mouse 
button, drag the attachment to the destination item's Attachment 
Window, and release the mouse button. The Modify Attachment Links 
Dialog Box (Figure 4-14) will be displayed. 

4.   Select Move. 
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1 Modify Attachment Links [x] 

Do you wish to perform a MOVE, COPY or LINK? 

Link j      Move      | Copy 

Cancel 

Figure 4-14: Modify Attachment Links Dialog Box 

Copying an Attachment      Copying an attachment to another item creates a new copy of the attachment 
to Another Item file and creates a link with the new item. 

To copy an attachment to another item: 

1. Select the item associated with the attachment that you want to copy to 
another item. Open its Attachment Window by clicking the Attach 
button. 

2. Select the destination item (the one to which you want to move the 
attachment) and open its Attachment Window by clicking the Attach 
button. 

Linking an Attachment 
to Another Item 

| You should now have two Attachment Windows open—one for the 
1 originating item and one for the destination item.  

3. Select the attachment that you want to move, hold down the left mouse 
button, drag the attachment to the destination item Attachment Window, 
and release the mouse button. The Modify Attachment Links Dialog 
Box will be displayed. 

4. Select Copy. 

5. If the attachment has multiple links, the Copy Links? Dialog Box will be 
displayed (Figure 4-11). If you want the new copy to have the same links 
as the original, click Yes. Otherwise, click No. 

Linking an attachment to another item creates a new link from the 
attachment file to the new item. This feature provides the capability to link 
an attachment to multiple items. 
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To link an attachment to another item: 

1. Select the item associated with the attachment that you want to link to 
another item. Open its Attachment Window by clicking on the Attach 
button. 

2. Select the destination item (the one to which you want to link the 
attachment) and open its Attachment Window by clicking on the Attach 
button. 

You should now have two Attachment Windows open—one for the 
originating item and one for the destination item. 

Select the attachment that you want to link, hold down the left mouse 
button, drag the attachment to the destination item Attachment Window, 
and release the mouse button. The Modify Attachment Links Dialog Box 
will be displayed. 

4.   Select Link. 

CREATING SENSITIVE ATTACHMENTS 
Sensitive attachments are documents that must be kept secure from access by 
unauthorized personnel. For example, contract documents prior to award of 
the contract are considered sensitive. This access limitation typically requires 
that the file be stored on a media that can be removed and locked in a secure 
area. KWS provides the capability to link sensitive attachments to items, 
while maintaining the extra security restrictions required via the Sensitive 
option in the Attachment Profile. 

Only the attachment creator is granted access rights to a sensitive attachment. 
In addition, the attachment is not listed in the Attachment Window unless the 
attachment creator is the user logged in to KWS, which further ensures that 
no one else is aware of the sensitive attachment's existence. 

Creating a Sensitive To create a Sensitive attachment: 
Attachment 

1. Within the Attachment Profile, click the Access Rights... button. The 
Access Rights Dialog Box will appear. 

2. Check the Sensitive box located within the Security Restrictions area of 
the dialog box. The Assigned Access Rights options and the 
User/Group List will become grayed out because you may not give other 
users access rights to a sensitive attachment (Figure 4-15). 

3. Click OK. You will be returned to the Attachment Profile Dialog Box. 
Because you designated the attachment as Sensitive, the Storage Type 
value has been set to Removable. 
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Attachment Access Rights 

IWGroup:   PUBLIC 
-Assigned Access Rights- 

C View Profile 
P Readf'Copy 

C Read/Copy/Edit 

• Security Restrictions- 

|7 j|ensitivej 

r" Locked 

f Save as my default PUBLIC access rights for new attachments 

User/Group Description Cumulative Access Rights 

View Profile, Read/Copy 
View Profile, Read/Copy 
View Profile, Read/Cop.y 
View Profile, Read/Copy 
View Profile, Read/Copy 
View Profile, Read/Copy 

BROWN C Chuck Brown 
JONES M Mike Jones 
KELLY G George Kelly 
WENT L Lvn Went 
ACCT Group 
OPS Group 

OK    |     Cancel | 

Figure 4-15: Attachment Access Rights Dialog Box With Sensitive Box 
Checked 

4.   Enter the information required for specifying the removable media to 
which you want to save the attachment. See Attachment File Storage, 
below, for more detail on saving to removable media. 

An attachment with a Storage Type value of Public or Private may be 
stored as a sensitive attachment. However, since the intent is to store 
sensitive attachments on a securable media, doing so will jeopardize security, 

5.   Click OK. 

ATTACHMENT FILE STORAGE 
The ability to effectively use and share documents in a work group 
environment such as KWS depends on the user's ability to access them. 
KWS manages attachment file storage to ensure you have access to the 
documents you need. In addition, KWS manages document storage to 
ensure that users who should not have access to your documents do not. 

KWS allows three Storage Type values: Public, Private, or Removable. 
The default Storage Type value is Public.   Public attachment files are stored 
on your organization's shared file server and can be accessed by all KWS 
users. Private files are stored on the KWS workstation where you create the 
attachment and can only be accessed by users at that workstation. 
Removable files are stored on a removable media of your choice such as a 
floppy or a Bernoulli disk. 
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Saving Attachments to 
Removable Media 

KWS assigns default attachment access rights based on the value you assign 
for Storage Type. You can assign specific access rights to users or work 
groups to further control access to your attachments See Attachment Access 
Rights in this chapter for more detail. 

When you create an attachment, KWS generates a file name and stores the 
file in a location reserved specifically for KWS attachments. This location is 
based on the value you assign to the Storage Type value. For Storage 
Types Public and Private, you are only responsible for designating the 
Storage Type value and are not required to determine the actual physical 
location where the document is to be stored. KWS uses the Storage Type 
value and the information specific to your organization to determine the 
physical location to store the document. See Database and File Storage 
Setup, in Chapter 7 for more detail. For Storage Type Removable, you 
must specify the physical location for storing the file. KWS then uses the 
location you specify to store and retrieve the attachment. 

To save an attachment to removable media: 

1. Within the Attachment Profile, click the small arrow located to the right 
of the Storage Type field and select Removable from the list provided. 
A Media Info... button will be displayed on the lower right corner of the 
Attachment Profile Dialog Box (Figure 4-16). 

Attachment Profile 

Title: 

Description: 

Application: 

Storage Type: 

Attachment Type: 

Context 

SME Guidelines 

B 
(Removable 

Referential 

Long-Term Storage: |K.eep 

MARKS Number:     I 

-History  

Status: Available 
Created By: KAPPES S 
Date Created 09Feb97 
Last Edited By: 
Last Edit Date: 

Version:   \) 

Guidelines for SME Documentation 

—'-■ Retention Days: 

"3   [385 

"J 
Media Info... 

Access Rights... 

Links... 

OK Cancel 

Medalnfo... 
button is 
added when 
storage type 
is set 
to removable 

Figure 4-16: Attachment Profile Dialog Box With Media Info... button 

2.   Click the Media Info... button. The Save to Removable Media Dialog 
Box will be displayed (Figure 4-17). 
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3. Specify the drive where the directory you want to open is located. 

4. Select the directory that contains the file you want to open. 

Save To Removable Media 

Directory: 
AAcontracts OK 

Qa:\ Cancel 

Network- 

Drive: 

11'-"» a: 

Media Description: 

3 
[Contract Specifications 

Figure 4-17: Save to Removable Media Dialog Box 

5. Enter text in the Media Description field that identifies the storage 
media. It is recommended that you also label the disk with the same text 
value so you can easily identify it when you later retrieve the attachment 
file. 

6. Click OK. 
KWS will generate a file name for the attachment and save it to the 
specified drive and directory. 
KWS will use this information when you retrieve an attachment file from 
removable media. The system will display an Insert Removable Media 
Dialog Box to request you to insert the media you previously specified 
(Figure 4-18). 
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Insert Removable Media 

Insert removable media into drive A: 

Contract Specifications 

to retrieve attachment file: 

Statement of Work 

OK Cancel 

Figure 4-18: Insert Removable Media Dialog Box 

SEARCHING ATTACHMENTS 

Searching/or 
Attachments 

KWS enables you to search for attachments associated with tasks and steps 
using Query-by-Example (QBE). Essentially, QBE enables you to search 
attachments by entering data values for fields contained in the attachment's 
Profile. KWS uses these values to perform the search and retrieve the 
attachments that contain them. 

To search for an attachment: 

1. Select Query from the KWS Menu Bar. 

2. Select Attachments from the Query Menu. 

3. Select the Attachment Search option from the Attachments submenu. 
The Attachment Search Dialog Box will appear (Figure 4-19). 
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Attachment Search 

Search For: 

Title: 

Description: | 

Application: 
;T    : 

Storage Type: ALL T     ■ 

Attachment Type: ALL :■▼■ 

Context: 
;,T: 

Long-Term Storage: ; ALL V 

MARKS Number: 

;-   Checked-Out By: A 
Created By: A 
Document Text:       1 

V Locked J~ Sensitive 

Current Task: Midpoint Tapes objectives review 

- Search Documents Attached To: -| 

V Current Task 

F* Ancestors of Current Task 

P. Descendants of Current Task 

p All Tasks OK 

r~ Match Case 

Cancel 

Figure 4-19: Attachment Search Dialog Box 

4. (Optional) Enter the Title value for which you want to search. You may 
also enter a text string value if you want to find attachments containing 
the string in its title. 

5. (Optional) Enter the Description value for which you want to search. 
You may also enter a text string value if you want to find attachments 
containing the string in its description. 

6. (Optional) Enter the Application value for which you want to search by 
clicking the small arrow to the right of the data field and selecting the 
desired value. 

7. (Optional) Enter the Storage Type value for which you want to search 
by clicking the small arrow to the right of the data field and selecting the 
desired value. 

8. (Optional) Enter the Attachment Type value for which you want to 
search by clicking the small arrow to the right of the data field and 
selecting the desired value. 
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9. (Optional) Enter the Context value for which you want to search by 
clicking the small arrow to the right of the data field and selecting the 
desired value. 

10. (Optional) Enter the Long-Term Storage value for which you want to 
search by clicking the small arrow to the right of the data field and 
selecting the desired value. 

11. (Optional) Enter the MARKS Number value for which you want to 
search. 

12. (Optional) Enter the Checked-Out By value for which you want to 
search by clicking the ... button to the right of the data field and 
selecting the user from the dialog box. 

13. (Optional) Enter the Created By value for which you want to search by 
clicking the ... button to the right of the data field and selecting the user 
from the dialog box. 

14. (Optional) Enter the Document Text value for which you want to 
search. THIS SEARCH CAN TAKE A LONG TIME SO USE ONLY 
WHEN NECESSARY. 

15. (Optional) Check Locked if you want to search for attachments that are 
locked by a specified user. 

16. (Optional) Check Sensitive if you want to search for attachments of type 
Sensitive. 

17. Select the task from which you want to search by checking the box next 
to one or more of the following options: 

Current Task Searches for attachments linked to 
the selected task. Attachments 
linked to the Steps associated with 
the task will also be searched. 

Ancestors of Current Task Searches for attachments linked to 
the upper level tasks of the 
selected task (all parents and their 
parents). Attachments linked to 
the Steps associated with the tasks 
will also be searched. 

Descendants of Current Task     Searches for attachments linked to 
the lower level tasks of the 
selected task (all children and 
their children). Attachments 
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Searching the Last 20 
Attachments 

All Tasks 

linked to the Steps associated with 
the tasks will also be searched. 

Searches attachments linked to all 
tasks and steps. 

i Performing the All Tasks option may take a while, so use it only when 
| necessary.   

18. If you want your search to find only values whose letters match the case 
you entered in the search criteria, check the box next to the Match Case 
option in the lower right-hand corner of the dialog box. 

19. Click OK. When the search is complete, the Attachment Search Results 
Window will be displayed (Figure 4-20). This window lists all the 
attachments found that satisfy the search criteria. If no matches are 
found, the window will be empty. The text string entered in the Title 
field will be highlighted in the title of each attachment listed. 

rR Attachment Seaich Results 

# Matches   Title 
BEE 

Version 

C Title ttxia Document 
SME Guidelines 

AJ ±J 
Figure 4-20: Attachment Search Results Window 

KWS includes a pre-defined query that returns a list of the last 20 
attachments you have accessed. 

To list the last 20 attachments accessed: 

1. Select Query from the KWS Menu Bar. 

2. Select Attachments from the Query menu. 

3. Select Last 20 Attachments Accessed from the Attachments 
submenu. 
An Attachments Window displays titles of the 20 most recently accessed 
attachments. 

ATTACHMENT ACCESS RIGHTS 
Each attachment has access rights associated with it that enable you to limit 
access to your attachments. As the attachment creator, you automatically 
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have full rights to the attachment and are the only one who can modify 
access rights for other users. 

The following access rights values may be assigned: 

View Profile Allows the user or work group to view only the 
attachment's profile and not the attachment 
file. 

Read/Copy Allows the user or work group to view the 
attachment's profile and to view or copy the 
attachment file, but not to edit the document. 

Read/Copy/Edit Allows the user or work group to view the 
attachment's profile and to view, copy, and edit 
the attachment file. 

When you insert an attachment, KWS designates you as the Owner of the 
attachment and assigns default access rights to you and the Work Group 
PUBLIC. [PUBLIC is a KWS-generated Work Group that contains all KWS 
users within your organization.] Depending on the Attachment Type value 
you entered for the attachment—Public, Private, or Removable—KWS 
assigns the following default access rights: 

Public Private Removable 

Owner View Profile, 
Read/Copy/Edit 

View Profile, 
Read/Copy/Edit 

View Profile, 
Read/Copy/Edit 

PUBLIC View Profile, 
Read/Copy 

View Profile View Profile 

Assigning Attachment 
Access Rights 

To assign attachment access rights: 

1.   Within the Attachment Profile Dialog Box, click the Access Rights... 
button. 
The Attachment Access Rights Dialog Box opens (Figure 4-21). 



KWS Ver 3.6 Reference Guide 4-35 

Attachment Access Rights 

User/Group:   PUBLIC 

p Assigned Access Rights - 

f View Profile 
<• Pead/Cppjj 
r Read/Copy/Edit 

pS ecurity Restrictions - 

r" Sensitive 

F^ Locked 

I"" Save as my default PUBLIC access rights for new attachments: 

User/Group Description Cumulative Access Rights 

View Profile, Read/Copv PUBLIC 
BROWN C Chuck Brown 
JONES M Mike Jones 
KELLY G George Kelly 
WENT L Lyn Went 
ACCT Group 
OPS Group 

OK 

View Profile, 
View Profile, 
View Profile, 
View Profile, 
View Profile, 
View Profile, 

Cancel 

Read/Copy 
Read/Copy 
Read/Copy 
Read/Copy 
Read/Copy 
Read/Copy 

Figure 4-21: Attachment Access Rights Dialog Box 

2.   Select the User ID or Work Group ID to which you want to assign access 
rights by clicking on it in the User/Group list. 

| To give the same access rights to all users, choose the KWS Work Group 

(PUBLIC. 

3. Within the Assigned Access Rights area of the dialog box, click the 
button next to the desired access rights (View Profile, Read/Copy, or 
Read/Copy/Edit). 

4. Repeat steps 2 and 3 for each User ID or Work Group to which you want 

to assign access rights. 

5. Click OK. 
You will be returned to the Attachment Profile Dialog Box. 

5.   Click OK. 

Default Public 
Attachment Access 
Rights 

The default Public Attachment Access Rights can be set from within the 
Attachment Rights Dialog Box. As new Attachments are created, each will 
have the specified default Public Access Rights. 

To set the default Public Attachment Access Rights: 

1.   Select an Attachment in an Attachment window and click on Profile 
from the button bar. The Attachment Profile dialog box appears. 
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2. Click on the Access Rights button. The Attachment Access Rights 
dialog box appears. 

3. Click on PUBLIC in the User/Group listbox and select public Access 
Rights for the Attachment. 

4. Check the checkbox titled Save as default PUBLIC Access Rights for 
new Attachments. 

5. Click OK. 

| Any new Attachments you create will have the specified public Access 
[ Rights. 

WORKFLOW 
Workflow is a capability that allows an organization to manage the route a 
document takes as it passes from person to person. As each person com- 
pletes an assigned action on the document, the document is passed to the 
next person in the workflow. Insurance claim processing is a classic 
example of a workflow application. A predefined set of actions occur on the 
insurance claim document from its point of receipt in the claims office to the 
time it is processed and the final action is taken on the claim. 

KWS provides workflow capability by allowing the user to define the path 
an attachment takes as it progresses through a task hierarchy. This path is 
referred to as the "workflow path." As an attachment progresses through a 
workflow path, successive actions are performed on it until it reaches the last 
task in the path. The final task's action on the attachment should result in a 
completed product. 

Definition of a workflow path requires a mechanism for specifying the next 
task in the sequence. Within KWS, this mechanism is provided through 
predecessor and successor links. See Chapter 3, Tasks and Steps, 
Predecessor and Successor Relationships, for more detail. After these 
relationships are established within a task hierarchy, an attachment can be 
designated as a workflow attachment and the path it will follow within the 
predecessor and successor task structure can be defined. 

Proper definition of a workflow path requires a thorough understanding of 
the process and of task decomposition. Also, you must understand what 
types of task structures are candidates for workflow definition. The 
following criteria can be used to identify candidates when defining workflow 
paths. 
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• Tasks in the task hierarchy must be completed in a step-by-step fashion. 
In other words, before one task can be started, another one must be 
completed. 

• A specific attachment is required at each step of the task hierarchy and 
some modification is performed on the attachment at each step. In 
addition, this attachment is a final product resulting from the completion 
of the tasks in the hierarchy. 

Defining a Workflow Before defining a workflow path for an attachment, the predecessor and 
path successor links must be set up for the task hierarchy through which the path 

will flow. See Chapter 3, Tasks and Steps, Predecessor and Successor 
Relationships, for further detail. Once these links have been established, the 
workflow path is defined by linking the attachment from predecessor task to 
successor task until the attachment has been passed through the task 
hierarchy. At any point in the path, a copy of the attachment may be passed 
to the parent task or a successor task. 

To define a workflow path for an attachment: 

1. Select the attachment for which you want to define a workflow path. 

2. Open the Available Options Menu by clicking the right mouse button. 

3. From the Available Options Menu, select Define Workflow. The 
Workflow Definition Dialog Box will appear (Figure 4-22). This dialog 
box displays the name of the attachment, the name of the current task to 
which the attachment is linked, and the successor tasks of the current 
task. The parent task of the successor task is included at the top of the 
list. 
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Woikflow Definition 

Attachment Title: KWS Proposal 

Current Task:      Write Proposal 

Successor Tasks: 

Link 

Copy 

PARENT: Acquire Funds 
L    Review Proposal 

Continue Back Finish 

Figure 4-22: Workflow Definition Dialog Box 

4. Select the task to which you want to link the workflow attachment. Click 
the Link button. The symbol L will appear to the left of the task. Only 
one task in the window may have a workflow link. 

5. If you want to link copies of the workflow attachment to any of the other 
tasks listed, select the task and click the Copy button. The symbol C will 
appear to the left of the task. 

6. Click the Continue button. The Workflow Definition Dialog Box will 
show the successor tasks of the task to which you linked the workflow 
document. If there are no successors, the successor task list will contain 
only the title of the Parent task. If only the parent task is listed, you may 
only send a copy to it because it is not a successor. 

7. Repeat Steps 4 and 5 until you have made all the desired workflow links. 
At any time during workflow definition, you may click the Back button 
to return to your previous link and make any modifications. 

8. To terminate the workflow definition, click the Finish button. You will 
be returned to the Attachment Window. The workflow attachment will 
now have a W next to it in the indicator column. 
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Choosing Between 
Copying and Linking in 
Workflow Definition 

The following example is provided to illustrate how to choose between 
copying or linking an attachment within a workflow path. Essentially you 
should follow the simple rule: If an attachment is going to be modified in 
some way during execution of the successor task, it should be linked to the 
task; otherwise, it should be copied. Copies are made to pass the attachment 
to a new workflow process or to provide information only. The following 
example is somewhat complex in that two attachments are being flowed 
through the task hierarchy. However, it illustrates how more than one 
workflow path can be used to produce the final product. 

A graphical depiction of the sample workflow path is shown in Figure 4-23. 
In this process, the task Write Proposal has the attachment "Proposal 
Document." The task Write Proposal Cover Letter has the attachment 
"Proposal Cover Letter." Both of these attachments must be passed to the 
task Review Proposal Package. Upon completion of Review Proposal 
Package, both attachments must be passed to Submit Proposal Package for 
Approvals and a copy of each passed to Acquire Sponsor's Signature on Draft 
Proposal. Upon completion of Submit Proposal Package for Approvals, the 
attachment will be the final product of the overall task structure so a copy is 
sent to the parent task, Acquire Funds. The receipt of the signed hard copy 
of the attachments copied to the task Acquire Sponsor's Signature on Draft 
Proposal will result in completion of the task, and the attachment will not be 
passed to any additional tasks. 

[Note that when an attachment is copied and not linked to another task in the 
(workflow path, it should no longer be considered part of the workflow. 
| However, the copy could then be used to start a new workflow definition. In 
(this example, the copy passed to the parent task Acquire Funds could then 
I be used in a new workflow within the parent's sibling task Execute Funded 
j Project. 

When defining the workflow paths for these attachments, three successive 
Workflow Definition Dialog Boxes would be displayed. The following 
workflow definitions would be designated in the order listed for the 
attachment "Proposal Document": 

1. Link to Review Proposal Package. 

2. Copy to Acquire Sponsor's Signature on Draft Proposal and Link to 
Submit Proposal Package for Approvals. 

3.   Copy to Acquire Funds. 
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- Graphical Task Manager 

Accessing Workflow 
Attachments 

Creating Multiple 
Copies of a Workflow 
Attachment 
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Figure 4-23: Workflow Process 

The following workflow definitions would be designated in the order listed 
for the attachment "Proposal Cover Letter": 

1. Link to Review Proposal Package. 

2. Copy to Acquire Sponsor's Signature on Draft Proposal and Link to 
Submit Proposal Package for Approvals. 

3. Copy to Acquire Funds. 

Workflow attachments are accessed in the same manner as any other 
attachment. However, workflow attachments have additional access 
constraints imposed. These constraints are: 

• Once the task linked to a workflow attachment has been marked 
complete, the workflow attachment can no longer be modified from the 
completed task. 

• A workflow attachment cannot be modified from a task until the 
predecessor task has been marked complete. 

At times you may want several copies of an attachment to follow the same 
workflow path. KWS enables this capability without having to define the 
path for each copy. 

To create multiple copies of a workflow attachment: 

1. Select the workflow attachment to be copied. 

2. Click the Copy button. 
The Copy Links? Dialog Box opens. 
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3.   Click Yes. 
The attachment and all its links will be copied. 

<* Auto Workflowing of You can automatically create workflow links for an Attachment where its 
Attachments associated tasks have successors. To automatically flow an attachment 

through a chain of single successors to the task, select Auto Workflow from 
the Available Options Menu for that attachment. 

(Note that workflow will be created only for each task that has a single 
S successor. 

To automatically create workflow for an Attachment: 

1. Select an Attachment in an Attachment Window and right click to access the 
Available Options Menu. 

2. Click on Auto Workflow. 
Workflow links will be created for the attachment for each task in the chain of 
single successors. A message displays the number of workflow links created. 



CHAPTER5   DOITS 

Overview 5-2 

Do Its 5-2 

Time Agents 5-10 

DoItBase 5-14 



5-2 KWS Ver 3.6 Reference Guide 

OVERVIEW 
Do Its are executable programs that can be launched directly from KWS. 
Like attachments, Do Its can be linked to any of the following items: tasks, 
steps, appointments, and milestones. In general, Do Its automate repetitive 
activities performed by knowledge workers. An example of an activity that 
could be automated by a Do It is generating a weekly report that requires 
logging into a remote database, downloading data to your workstation, and 
compiling a report from the data. 

DOITS 

Do Its also can be associated with time agents, which are executable pro- 
grams performed at a specified time. Within KWS, you can define time 
agents that are associated with a Do It and time agents that run independently 
of Do Its. When a Do It is associated with a time agent, it is called a Time- 
Contingent Do It. This capability enables a user to define activities that can 
be executed automatically, eliminating the need for the user to start the 
program. 

As the number of Do Its within the organization increases, a mechanism will 
be required for storing and retrieving them to simplify access and support 
sharing. KWS provides this capability through the DoItBase application 
DoItBase is a collection of Do Its that have been archived. You may store 
your own Do Its in the DoItBase, and you may retrieve Do Its belonging to 
other users. 

Each Do It has a specific set of information associated with it that KWS uses 
to execute the Do It. Do It information is captured using the Do It Dialog 
Box (Figure 5-1). 
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Title: 

Command: 

Working Directory: 

- Execution Mode—— 

C DOS Full Screen 

r DOS Window 

^Windows Program 

Optional Parameters: 

-Window Size- 

f*  Normal 

C Maximized 

C Minimized 

Figure 5-1: Do It Dialog Box 

Time Agent Setup... 

OK Cancel 

The Do It Dialog Box contains the following data fields, which capture user- 
specified values required for executing Do Its within KWS. 

Title 

*> Entering the Do It Title      To enter the Do It title: Type the desired value into the Title field. 

Description: A descriptive name given to the Do It. 

Type: A text field that can include any combination of alphanumeric 
characters, punctuation marks, and standard ASCII symbols. 

Default Value: blank 

Usage: The Title value should contain a textual description that enables you 
to easily recognize what the Do It does, not the actual DOS filename. For 
example, use a descriptive title such as Generate Budget Report. For an 
individual task, step, or appointment, the Title values should be unique so 
that you can differentiate between them in the Do It Window. 

Command  __ 

Entering the Do It 
Command 

To enter the Do It command: 

Type the desired value into the Command field 

or... 

Click the file browser button to the right of the Command field and select 
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the path and executable file name. 

Description: The name of the executable file required to launch the Do It. 

Type: Text field containing a valid file and path name. 

Default Value: blank 

Usage: Any executable filename may be entered into the Command field. 
This includes program files with .exe extensions, batch files with .bat 
extensions, and command files with .com extensions. KWS supports both 
DOS- and Windows-executable files. 

Optional Parameters 

> Entering Do It Optional     To enter the Do It optional parameters: 
Parameters 

Type the desired value into the Optional Parameters field 

or... 

If your optional parameter is a file, click the file browser button to the right 
of the Optional Parameters field to select a filename. 

Description: The parameters that your application uses on startup. 

Type: Text field. 

Default Value: blank 

Usage:   These are the same parameters you would type after the 
application's filename when starting the application from the MS-DOS 
command prompt or from the Windows File, Run option. For example, to 
start Microsoft Excel with a specific file open, type the filename in this field. 
If your Do It does not require parameters, leave this field blank. See the 
documentation for your Do It for valid parameters. 

Working Directory 

*** Entering the Do It To enter the Do It working directory: 
Working Directory 

Type the directory path value into the Working Directory field 

or... 

Click the file browser button to the right of the Working Directory field and 
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select the desired path. 

Description: The name of the directory where the program files for the Do 
It are located. 

Type: Text field containing a valid path name. 

Default Value: blank 

Usage: The working directory value is optional. If a value is entered, the 
current directory is changed to this value before the Do It is executed. If the 
value is left blank, the directory where the program files are located is the 
working directory. 

Execution Mode 

Entering the Do It 
Execution Mode 

To enter the Do It execution mode: Click on the box next to the desired 
value within the Execution Mode area. If one box is already checked, 
clicking on another box will uncheck it and set the new value. 

Description: The screen interface mode in which you want the Do It 
displayed. 

Type: A text field selected from the values DOS Full Screen, DOS 
Window, or Windows Program. 

Default Value: Windows Program 

Usage: This option is used to control the screen interface for initially 
displaying the Do It. The possible values are: 

DOS Full Screen 

DOS Window 

Windows Program 

Displays the Do It in a full screen DOS shell. 

Displays the Do It in a window from which the 
DOS application is executed. 

Displays the Do It in the Windows 
environment. 

You may use either DOS Full Screen or DOS Window to run DOS 
applications. However some DOS applications may not run in DOS Window 
mode. In this case, you will have to use DOS Full Screen mode. You must 
use Windows Program mode to run Windows applications. 

Window Size 

*** Entering the Do It To enter the Do It window size: Click on the box next to the desired value 
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Window Size within the Window Size area. If one box is already checked, clicking on 
another box will uncheck it and set the new value. 

Description: The size of the window used for displaying Do Its with a value 
of Windows Program specified for the Execution Mode. 

Type: A text field selected from the values Normal, Maximized or 
Minimized. 

Default Value: Normal 

Usage: This option is only available if the Execution Mode value has been 
set to Windows Program. The possible values are: 

Normal Displays the Do It in the screen size set by the 
Dolt. 

Maximized Displays the Do It in full-size window, which 
occupies the full screen. 

Minimized Displays the Do It as an icon. 

You should only use the Minimized value when the Do It does not require 
user input to execute. 

Time Agent Setup... 

Creating a Time To create a time contingent Do It: Click the Time Agent Setup... button. 
Contingent Do It The Time Agent tool and Event Detail Dialog Box will appear. Enter the 

details into the specified fields. See Time Agents in this chapter for more 
detail. 

The Do Its Window 
The Do Its Window (Figure 5-2) lists the Do Its associated with the selected 
item alphabetically by Title. The information displayed in the window is 
determined by your display field setup. For instance, you can change the 
order of the fields displayed or remove a field from display. See Chapter 7, 
Customizing KWS, Display Field Setup, for detail. 
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S, Do Its: Create Weekly Budget Report 

Title 
HBB 

Command 

Email budget report to division chiefs       sendmail.exe 
c:\budqet\budqet.doc 

Run Budget Report budget.exe 

±1 
Figure 5-2: Do Its Window 

*> Accessing Do It Window    Options for manipulating Do Its within the Do Its Window are accessed in 
Options the Do Its Window Button Bar and the Available Options Menu. These 

options are available whenever the Do It Window is active. 

To access Do It Button Bar options: 

1. Select the item associated with the Do It. 

2. Click the Do It button in the button bar or the Do It icon in the indicator 
column to the right of the item. A Do Its Window will open and the Do 
Its Button Bar (Figure 5-3) will be displayed with the Insert, Delete, 
Modify, and Execute options available for Do It manipulation. 

Insert Delete Modify Execute 

Figure 5-3: Do Its Window Button Bar 

Accessing the Do Its 
Window Available 
Options 

Inserting a Do It 

You can access the Available Options Menu if at least one Do It is listed in 
the Do It Window. 

To access the Do Its Window Available Options: 

1.   Within the Do Its Window, select the desired Do It. 

Click the left mouse button. The Available Options Menu will be 
displayed with the Delete, Modify, and Execute options available for Do 
It manipulation. 

To insert a Do It: 

1. Select the item to which the Do It will be linked. 

2. Click the Insert button. The Do It Dialog Box will be displayed (Figure 
4-1). 

3. Enter the information describing the Do It in the Do It Dialog Box. 

4. Click OK. The new Do It will appear in the Do It Window. 
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*!*  Deleting a Do It 

*!*  Modifying a Do It 

*** Executing a Do It 

When deleting a Do It, only the link to the Do It is deleted and not the Do Its 
program file. 

To delete a Do It: 

1. Select the Do It you want to delete. 

2. Click the Delete button. The Delete? Dialog Box will appear. 

3. Click Yes to confirm the deletion, No to cancel. 

To modify a Do It: 

1. Select the Do It you want to modify. 

2. Click the Modify button. The Do It Dialog Box will be displayed. 

3. Enter your modifications in the Do It Dialog Box in the appropriate data 
fields. 

4. Click OK. 

To execute a Do It: 

1. Select the Do It you want to execute. 

2. Click the Execute button. The Do It will be executed. 

1 If the Do It does not execute, you may not have defined it correctly or there 
I may not be enough memory available on your workstation. 

Moving and Copying Do Its 
You may copy a Do It to multiple items after it has been inserted in a Do Its 
Window. Also, you may move a Do It link from one item to another. 

Moving a Do It Moving a Do It creates a link with a new item and deletes the link from the 
item from which it was moved. 

To move a Do It to another item: 

1. Select the item associated with the Do It that you want to move and open 
the Do Its Window by clicking the Do It button. 

2. Select the destination item (the one to which you want to move the Do It) 
and open its Do Its Window by clicking the Do It button. 
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Copying a Do It 

) You should now have two Do Its Windows open—one for the originating 
I item and one for the destination item. 

3.   Select the Do It that you want to move, hold down the left mouse button, 
drag the Do It to the destination item's Do Its Window, and release the 
mouse button. The Confirm Move or Copy Dialog Box (Figure 5-4) will 
be displayed. 

Confirm MOVE or COPY 

Do you wish to perform a MOVE or a GORY? 

Move Copy 

I"" [Confirmation no longer necessarjj 

Cancel 

Figure 5-4: Confirm Move or Copy Dialog Box 

4.   Select Move. 

Copying a Do It to another item creates a link between the Do It to the new 
item. The Do It program files are not copied. This feature provides the 
capability to link a Do It to multiple items. 

To copy a Do It to another item: 

1. Select the item associated with the Do It that you want to copy and open 
the Do Its Window by clicking the Do It button. 

2. Select the destination item (the one to which you want to copy the Do It) 
and open its Do Its Window by clicking the Do It button. 

I You should now have two Do Its Windows open—one for the originating 
1 item and one for the destination item. 

Select the Do It that you want to copy, hold down the left mouse button, 
drag the Do It to the destination item's Do Its Window, and release the 
mouse button. The Confirm Move or Copy Dialog Box will be 
displayed. 

4.   Select Copy. 
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TIME AGENTS 

Time agents are useful to support execution of repetitive tasks that occur at 
regularly scheduled times. For example, suppose you have the ToDo item 
Generate Weekly Budget Report that consists of three steps: 1. Get budget 
data, 2. Review budget data, and 3. Print budget report. The first step 
involves downloading data from a remote computer into the appropriate 
budget report format. In addition, the first step is performed every Monday 
morning. If a Time-Contingent Do It is linked to this step, the budget data 
could be downloaded automatically at a specified time without your input. 
You could even set the Time-Contingent Do It to execute at a time such that 
the budget data is waiting for you when you arrive at work on Monday 
morning. You could then start immediately on the next step of reviewing the 
data, saving the time you would have spent waiting for the data to download. 

*t* Executing Time Agents Individual time agents are started through the TimeAgent Program. Hence, 
the TimeAgent Program must be running before you can execute a time 
agent. If KWS is not running when the TimeAgent Program starts a time 
agent, you will be prompted for your KWS login information, which is 
required to obtain access to the KWS database. However, the KWS 
application will not be started; only its database will be accessed. 

To start the TimeAgent Program: 

1. Select Tools from the KWS Menu Bar. 

2. Select TimeAgent from the Tools Menu options. The KWS TimeAgent 
Window will be displayed (Figure 5-5). 

KflKWS TimeAgent MSB 
File   Edit 

Add Copy Modify Delete Refiesh 

Enabled | Event» 

Run Budget Report 
Email budget report to division chi      Weekly 

Frequency 

Weekly 

kwsdb- KAPPES S 

I Time 

Fridays at 1:0 
Fridays at 2:1 

17-Mar-98     7:57:03 PM 

Figure 5-5: KWS TimeAgent Window 
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I If you want a üme agent to execute when you are not at your workstation, 
| you must leave your workstation on with KWS and the TimeAgent Program 
| running. If KWS is closed, the TimeAgent program will also close, and the 
! Time Agent will not execute.  

*> Adding a Time Agent 

To close the TimeAgent Program: 

1. Switch to the KWS TimeAgent Window using normal Windows 
procedures, e.g., [Ctrl-Tab]. 

2. Select File, Close from the TimeAgent Window Menu Bar or double 
click on the Control-menu box in the upper left corner of the window. 

Time agents are added within the TimeAgent Program. Remember that you 
may define time agents that are associated with a Do It and time agents that 
run independently of Do Its. When a Do It is associated with a time agent, it 
is referred to as a Time-Contingent Do It. 

To add a time agent [not associated with a Do It]: 

1. If you have not already done so, start the TimeAgent Program. 

2. In the KWS TimeAgent Window, click the Add button. The TimeAgent 
Event Detail Window will appear (Figure 5-6). 

Event Detail 

Description- 
Title: 
Run Budget Report 

Command Line To Run: 

I budget, exe 

^Parameters! 

sSehedulej- 

r* Prompt Bef ore Execution 

Frequency: (Weekly__ 

Time: [Öl~_ : |Öo"__PM: 

Week Day: (Friday 

Day: I 

Month:        | 

Year: I 

Type oft Action    f   ,.; 
(*   Run Program 

C Display Message 

Activate  

F Enable Event 

S ecurity ~~ 

Owner:       |KAPPES„S 

Assign To: |KAPPES_S 

OK. Cancel 

Figure 5-6: TimeAgent Event Detail Window 

The TimeAgent Event Detail Window contains the following data fields: 
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Title 

Command Line 

Parameters 

Prompt Before 
Execution 

A textual description identifying the time 
agent. 

The path and executable file name of the 
program to be executed. 

Any additional parameters required in the 
Command Line when executing the program. 

An indicator that specifies whether the user 
should be prompted before the program is 
executed. 

Type of Action 

Owner 

Assign To 

Frequency 

Time 

Week Day 

Day 

Month 

Year 

Enable Event 

Indicates that the time agent executes a 
program when set to the value Run Program 
or displays a message when set to the value 
Display Message. 

The KWS user who added the time agent. 

The user or work group who can execute the 
time agent. 

How often the time agent should be run. 
Possible values are: One Time, Yearly, 
Monthly, Weekly, Week Days (every day 
Monday through Friday), Daily (every day of 
the week), and Hourly. [Note that a time agent 
with a Frequency value of One Time will 
automatically be deleted after it executes.] 

The hour and minute that the time agent should 
execute. 

The day of the week the time agent should 
execute when Frequency is set to Weekly. 

The day of the month the time agent should 
execute when Frequency is set to Monthly. 

The month of the year the time agent should 
execute when Frequency is set to Yearly. 

The year the time agent should execute when 
Frequency is set to One Time. 

Activates the time agent. This box must be 
checked before the time agent will execute. 
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3. Enter the information describing the time agent into the TimeAgent 
Event Detail Window. 

4. Click OK. 

A Time Agent associated with a KWS Do It is considered to be a Time- 
Contingent Do It.  

To add a time agent [associated with a Do It]: 

1. Select the item to which you want to link the Time-Contingent Do It. 

2. Click the Do It button or icon. The Do Its Window will appear. 

3. Click the Insert button. The Do It Dialog Box will appear. 

4. Enter the information describing the Do It in the Do It Dialog Box. [See 
Do Its in this chapter, for details on entering data field values.] 

5. Click the Time Agent Setup... button. The TimeAgent Event Detail 
Window will appear. 

6. Enter the data field values to define the time agent. The values for Title 
and Command Line are automatically set to the values entered in the Do 
It Dialog Box and cannot be changed. 

7. Click OK. You will return to the Do It Dialog Box. A clock icon will 
appear to the left of the Do It title to indicate that it is a Time-Contingent 
Do It. 

8. Click OK. The new Time-Contingent Do It will appear in the Do Its 
Window. 

Modifying a Time Agent    To modify a time agent: 

1. Select the time agent to be modified. 

2. Click the Modify button. 

3. Enter the modifications. 

4. Click OK. 

Deleting a Time Agent       To delete a time agent: 

1.   Select the time agent to be deleted. 
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2.   Click the Delete button. 

*!*  Copying a Time Agent       To copy a time agent: 

1.   Select the time agent to be copied. 

2.   Click the Copy button. A copy of the time agent will appear with the 
same title as the original but prefixed by COPY OF:. 

*** Refreshing a Time Agent    To refresh a time agent: 

1.   Select the time agent to be refreshed. 

*!* Deactivating a Time 
Agent 

*t*  Reactivating a Time 
Agent 

2.   Click the Refresh button. The time agent information will reflect 
current values stored in the KWS database. 

To deactivate a time agent: 

1. Select the time agent to be deactivated. 

2. Click the Modify button. The Event Detail Dialog Box will appear. 

3. Uncheck the Enable Event check box. 

To reactivate a time agent: 

1. Select the time agent to be Reactivated. 

2. Click the Modify button. The Event Detail Dialog Box will appear. 

3. Check the Enable Event check box. 

DOITBASE 
The DoItBase contains a set of archived Do Its that have been saved by you 
and other users within your organization. You may add Do Its to the 
DoItBase or you may retrieve Do Its for your own use. Do Its in the 
DoItBase are stored in zip file format, which is used to compress multiple 
files into one file. You may then expand this compressed file to return the 
multiple files into their original format. 

Starting the DoItBase To start the DoItBase application: 

1. Select Tools from the KWS Menu Bar. 

2. Select DoItBase from the Tools Menu options. The KWS DoItBase 
Window will open (Figure 5-7). 
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Opening a DoItBase 
Database 

JfiKWS Doit Base - Budget Software mmm 
File   Edit 

Add Copy Modify Delete View J 
Archive Name 
c:\budget\budget_create.zip 
c: \email\sendemail. zip 

I Brief Description 
Budget creation software 
Sendemail Software 

kwsdb-KAPPES S c:\ 17-Mar-98 

Figure 5-7: KWS DoItBase Window 

To open an existing DoItBase database: 

1. Select File from the DoItBase Menu Bar. 

2. Select Open DoItBase from the File Menu. The Open DoItBase Dialog 
Box (Figure 5-8) will be displayed. 

1 Open DoItBase                                                                      1 

DoItBase Name Owner: 

Budget Software) 

Defined Dol(Bases 

1 

Budget Software OK 

Cancel     1 

Figure 5-8: Open DoItBase Dialog Box 

3.   Select from the Defined DoltBases listed in the Open DoItBase Dialog 
Box and click OK. 
The KWS DoitBase Window now contains a list of all of the archived 
Do Its in the selected database (Figure 5-3). 
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;'^KWS Doit Base - Budget Software ■ Jnlxl 
File   Edit 

Modify                  Delete Add Copy          1 View          1 

Archive Name | Brief Description 
c: \budget\budget create, zip 
c: \email\sendemail. zip 

Budget creation software 
Sendemail Software 

kwsdb- KAPPES S c:\ 17-Mar-98 

Figure 5-9: KWS DoItBase Window With an Open DoItBase Database 

*!* Adding a New DoItBase     To add a new DoItBase database: 
Database 

1.   Select File from the DoItBase Menu Bar. 

2.   Select New DoItBase from the File Menu. The Add DoItBase Dialog 
Box (Figure 5-10) will be displayed. 

|Add DoItBase                                                                         1 

DoItBase Name Owner: 

I 
Defined Dol(Bases 

|KAPPES_S 

Budget Software 
OK 

Cancel 

Figure 5-10: Add DoItBase Dialog Box 

3.   Enter a value in the DoItBase Name field and click OK. 

*!* Adding an Archive To add an archive: 

1.   Click the Add button. The Archive Detail Dialog Box (Figure 5-11) will 
appear. 



KWS Ver 3.6 Reference Guide 5-17 

Archive Detail 

File Name 
c:\budget\budget_create.zip n 

Brief Description 

jBudget creation software 

Full Description 
This archive contains all files for creating £} 
the weekly budget. 

zl 
Required Programs 
iMicrosoft Access 97 

Figure 5-11: Archive Detail Dialog Box 

OK 

Cancel 

Copying an Archive 

The Archive Detail Dialog Box contains the following data fields: 

File Name 

Brief Description 

Full Description 

Required Programs 

The full path and file name of the zip file 
containing the Do It. 

A short description that identifies the Do It. 

A long description that provides information 
about the contents of the zip file, Do It 
installation instructions, and any other 
information that might be useful. 

A list of commercially available software 
programs required to execute the Do It (e.g., 
Microsoft Excel). 

2. Enter the information describing your archived Do It. 

3. Click OK. 

When an archive is copied, only the definition of the archive is copied. The 
actual archive file is not copied. Both definitions will be linked to the same 
file. If you want to link to a separate archive file, you must copy the archive 
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*!* Modifying an Archive 

Deleting an Archive 

Viewing an Archive 

file and add into the DoItBase a new definition that points to it. 

To copy an archive: 

1. Select the archive to be copied from your DoItBase list. 

2. Click the Copy button. The archive definition will be copied and 
displayed in your DoItBase list prefixed by COPY OF:. 

To modify an archive: 

1. Select the archive to be modified from your DoItBase list. 

2. Click the Modify button. The Archive Detail Dialog Box will appear. 

3. Enter your modifications into the Archive Detail Dialog Box. 

4. Click OK. 

To delete an archive: 

1. Select the archive to be deleted from your DoItBase list. 

2. Click the Delete button. A message box will be displayed to confirm the 
delete. 

3. Click Yes. 

The DoItBase application contains a zip file viewer that enables you to view 
the contents of a zip file. 

To view an archive: 

1. Select the archive to be viewed from your DoItBase list. 

2. Click the View button. The View Zip File Window will be displayed 
listing the contents of the zip file (Figure 5-12). 

3. Exit the View Zip File Window by selecting File, Exit from the menu bar 
or double-clicking on the Control-menu box in the upper left corner of 
the window. 
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Figure 5-12: View Zip File Window 

Building a DoItBase 
Automatically 

The DoItBase application will automatically populate a DoItBase from a 
directory containing zip files. 

To automatically build a DoItBase: 

1. Open an existing or create a new DoItBase. 

2. Select File from the DoItBase Menu Bar. 

3. Select Properties from the File Menu. The DoItBase Properties Dialog 
Box will be displayed (Figure 5-13). 

4. Enter the name of the directory containing the zip files into the Default 
Directory field. 

5. If you want another user or work group to be able to access your 
DoItBase, enter the desired User ID in the Assigned To field. 

6. Click OK. The zip files will be added to your DoItBase with the brief 
description value for each set to the name of the file. 
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Doit Base Properties - Budget Software 

Dolt Base Name 
budget Software 

Default Directory 
pr 
Owner 

KAPPES S 

OK 

Assigned To 

KAPPES S 

Cancel 

Figure 5-13: DoItBase Properties Dialog Box 

*** Reconciling a DoItBase     The DoItBase application can determine if the zip files entered in the archive 
definitions still exist and, if not, delete the definition. This process is called 
reconciling a DoItBase. 

To reconcile a DoItBase: 

1. Open the DoItBase that you want to reconcile. 

2. Select File from the DoItBase Menu Bar. 

3. Select Reconcile from the File Menu. You will be prompted to delete 
any DoItBase archive definitions where the zip file does not exist. 

*t*  Searching a DoItBase You may search for text strings contained in the values for the Short 
Description, Long Description, and Required Programs of an archive. 

To search a DoItBase: 

1. Select Edit from the DoItBase Menu Bar. 

2. Select Find from the Edit Menu. The Find Dialog Box will appear 
(Figure 5-14). 

3. Enter the text field for which you want to search into the Find What 
field. 

4. Select which data fields to search by checking any or all of them. 

5. If desired, check Match Case. 

6. Click OK. The first definition in your DoItBase Window that contains 
the text string will be highlighted. 
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Find What: 

V Short Description 
V Long Description 

I" Required Programs 

V Match Case 

OK 

Cancel 

Figure 5-14: Find Dialog Box for Searching a DoItBase 
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OVERVIEW  
The Task Palette application provides a mechanism for storing tasks that can 
be added to your KWS model as needed. Typically, tasks that are repetitive 
and ad hoc in nature are good candidates for the Task Palette. For example, 
the task of generating a purchase order request is done the same way each 
time. However, when it is done varies from instance to instance. The Task 
Palette application enables you to store the task "Generate Purchase 
Request" so that you can easily access it and add it to KWS whenever you 
need to perform the task. 

Within the Task Palette, you can create multiple "palettes." Each palette 
contains a set of related "palette tasks." For instance, you can define a 
palette titled Admin that contains tasks for performing various administrative 
tasks for which you are responsible and another one titled Contracting that 
contains tasks for performing contracting activities. Any of these palette 
tasks can be added to your KWS model by opening the palette that contains 
them and copying them to KWS. 

Palette tasks are originally defined within KWS and then copied to a palette. 
They have the same structure as any KWS task including child tasks, steps, 
attachments, and Do Its. Once copied to a palette, some of the field values 
can be modified, but you cannot change the task structure. 

USING THE TASK PALETTE 

*> Starting the Task Palette    To start the Task Palette application: 

1.    Select Tools from the KWS Menu Bar. 

2.    Select Task Palette from the Tools Menu. 
An empty KWS Palette Window (Figure 6-1) opens. 
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Opening an Existing 
Task Palette 
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Connected to kwsdt 

Figure 6-1: KWS Task Palette Window 

To open an existing Task Palette: 

1. Select File from the KWS Palette Menu Bar. 

2. Select Open Palette... from the File Menu. 
The Open Palette Dialog Box (Figure 6-2) opens. 

Open Palette 

Palette Name: Organization: 

Admin 
Contracting 
Personnel 
Travel 

IFF                d 
Owner: 

1 
r Show All Palettes 

iOK! 

Cancel 

Figure 6-2: Open Palette Dialog Box 

3. Select the organization to which the palette belongs. 

4. Select the name of the palette to open. The Palette Name and Owner 
values of the selected palette will be displayed in their respective data 
field boxes. 
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5.   Click OK. 
The palette opens and its individual palette tasks will be represented by a 
title and an icon in the KWS Palette Window (Figure 6-3). Also, the 
name of the palette will appear in the window's title bar. 

fcSKWS Task Palette 

File   Settings   Window   Help 

foSI Travel H®E 

Expense Report Travel Request 

[Travel' opened       JKAPPES.S   {Administrator 

SäEj 

Figure 6-3: KWS Palette Window With an Open Task Palette 

Status Bar The Task Palette Status Bar is split into three sections: 

Left 

Middle 

Right 

The last operation performed on the Task 
Palette. 

The owner of the currently selected palette. 

Your privileges for the currently selected 
palette. 

Creating a New Palette      To create a new palette: 

1.   Select File from the KWS Palette Menu Bar. 

*!*  Saving a Task Palette 

2. Select New Palette... from the File Menu. The name of the palette will 
displayed as "untitled" in the window's title bar. To give it a name, you 
must save the new palette. 

To save a task palette: 

1. Select File from the Task Palette Menu Bar. 

2. Select Save As... from the File menu. 
The Save As Dialog Box opens (Figure 6-4). 
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*!*  Copying a Task from 
KWS to a Palette 

Save As 

Palette Name: Organization: 

|FF 

Owner: 

-3 
Admin 
Contracting 
Personnel 
Travel 

KAPPES_S 

r Show All Palettes 

OK 

Cancel 

Figure 6-4: Task Palette Save As Dialog Box 

3. Enter a name for the new Task Palette into the Palette Name field box. 

4. Click OK. 

A task can be copied from any T0D0, Task, or Task Manager 
Window to a Palette. When you copy the task, all its child tasks, 
steps, attachments and Do Its also are copied. 

! You cannot drag a task from a Graphical Task Window to a palette. 

To copy a task from KWS to a palette: 

1. In KWS, select the top level task of the task you want to copy to a 
palette. 

2. Click on a task within a KWS task window and while holding down the 
mouse button, drag the task to the KWS Palette Window. 
A Palette icon opens, entitled with the name of the selected task. 

*!*  Copying a Palette Task 
to KWS 

You can copy a palette task to any T0D0, Task or Task Manager 
Window. When you copy the task, all its child tasks, steps, 
attachments, and Do Its are copied. If you copy a task to a Task 
Window or Task Manager Window, the task is changed to Public 
and becomes a child of the task to which you copied it. If you copy 
a task to your T0D0 List, it automatically becomes Private and is 
assigned to you. 

You cannot drag a palette task from a palette to a Graphical Task Window. 

To copy a palette task to KWS: 

1.   Open the palette that contains the palette task you want to copy to KWS. 
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Copying from one 
palette to another. 

2. Select the palette task that you want to copy. 

3. Click on a palette task and, while holding down the mouse button, drag 
the palette task to the desired location in KWS. 

If the palette task requires any variable assignments before it can be 
copied, you will be prompted for the values (Figure 6-5). If the palette 
task contains any invalid values, such as an invalid User ID, you will be 
prompted for a new value. 

Select date for SDATEDUE 

:Fcbruary':!398;^ 

I? 29 ?36Sftc^^»^S!:-"^F?^ 2S ^T^^'^S' 

3T J7 

Date:  UÜEKJJ OK Cancel 

Figure 6-5: Task Attributes Dialog Box 

To copy a palette task from one palette to another: 

1. Open the two task palettes. 

2. Select the palette task to be copied by clicking on the palette task icon. 
If you wish to drag more than one palette task, select any additional 
palette tasks by holding the [Ctrl] key down and clicking the other 
palette task icons. 

3. Drag the icons to the second task palette. 
The Move, Copy dialog box appears. 

Do ycu wsh to peifoi'm 'i Mcve"o'r't _r.._  . ..... 

r. ~ ~ ■■•:■■ -.".■. ■ -. T.—?r--—T—;■ -■   .. 

Figure 6-6: Move, Copy Dialog Box 

4.   Cick Copy to link the palette task to the second task palette. 
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Moving from one palette    To move a palette task from one palette to another: 
to another. 

1.   Open the two task palettes. 

Select the palette task to be moved by clicking on the palette task icon. To 
drag more than one palette task, select any additional palette tasks by 
holding the [Ctrl] key down and clicking the other palette task icons 

3.   Drag the icons to the second task palette. 
The Move, Copy dialog box appears. 

Figure 6-7: Move, Copy Dialog Box 

4.   Click Move to move the links to the palette task to the second task 
palette. 

Deleting a Palette To delete a palette: 

1. Select File from the Task Palette Menu Bar. 

2. Select Delete Palette... from the File Menu. 
The Delete Palette Dialog Box (Figure 6-8) opens. 



6-8 KWS Ver 3.6 Reference Guide 

*** Editing the Name of a 
Palette Task 

Delete Palette 

Palette Name: Organization: 

Admin 
Contracting 
Personnel 
Travel 

Owner: 

r"Sh ow All Palettes 

OK 

! Cancel; 

Figure 6-8: Delete Palette Dialog Box 

3. Select the Palette to be deleted. 
The Palette Name and Owner values of the selected task will be 
displayed in their respective data field boxes. 

4. Click OK. 
A message box opens and asks you to confirm the deletion. 

5. Click Yes. 

When a task is copied into a palette, the name of its icon is set equal 
to the title of the task. However, if you would like another title you 
can change it. 

To edit the name of a palette task: 

1. Click once on the name of the icon to be changed, a line cursor will 
appear. 

2. Enter your modifications by adding or deleting text from the label. 

j If you are unable to edit the name of the palette, you may not have edit 
(permission. 

*> Deleting a Palette Task     To delete a palette task: 

1.   Select the palette task to be deleted. 

2.   Press the [Del] key. 
A message box opens and asks you to confirm the deletion. 

3.   Click Yes. 
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Changing Task Palette 
Settings 

[if you are unable to delete a palette task, you may not have delete privileges, j 

A few options are available for customizing your Task Palette 
environment. These options are available from the Settings Menu in 
the KWS Palette Menu Bar. 

To change Task Palette settings: 

1. Select Settings from the KWS Palette Menu Bar. 

2. Select Application from the Settings menu. 

3. Select Preferences from the Application submenu. 

The following options are offered: 

Always on Top 

Prompt for Icon 
Name 

Confirm Copy 

Load on KWS Start 
Up 

Notification 

By default, the KWS Palette Window 
will always be in front of any other 
windows. This option allows you to 
change the default so that when you 
move to another window, the KWS 
Palette Window will move to the 
background. 

By default, when you copy a task to a 
palette, the task icon is given the name of 
the selected task. This option will cause 
a prompt to appear whenever you copy a 
task to a palette; you will be asked to 
provide a name for the task icon. 

By default, when you copy a palette task, 
you are not asked to confirm whether 
you want to copy the task. This option 
will cause a prompt to appear whenever 
you copy a task. 

By default, when KWS is started, the 
Task Palette is not started. This option 
will cause the Task Palette program to 
start whenever KWS is started. 

This option sets the notification 
preference used whenever a palette task 
is changed. By default, whenever a 
palette task is modified a Palette 
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Setting Palette 
Permissions 

Modification message is sent to all users 
who have a task instantiated from the 
palette task. You can choose to be 
prompted whether or not to send a 
Palette Modification message or you can 
choose to never send a Palette 
Modification message. 

4.   Select your desired option. 

You may assign permissions for other users to use and edit your 
palette. 
Note: By default, nobody can use or edit the task palettes you 
create. 

To set palette permissions: 

1. Select Settings from the KWS Palette Menu Bar. 

2. Select Palette from the Settings Menu. 

3. Select Permissions... from the Palette submenu. 
The Palette Security Dialog Box opens (Figure 6-9). 

The palette security options are: 

None 

Open, Copy From 

Open, Copy From, Copy To, 
Edit 

Open, Copy From, Copy To, 
Edit, Delete Items 

Owner 

Administrator 

The user cannot open or 
manipulate the palette. 

The user can open the palette 
and copy palette tasks from the 
palette. 

The user can open, copy, and 
edit any palette task in the 
palette. 

The user can open, copy, edit, or 
delete any palette task in the 
palette. 

The user has full rights, plus the 
permission to grant or revoke 
permissions for the palette to 
other users. 

The user has the same privileges 
as the owner. 
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4. Select the organization by clicking the down arrow to the right of the 
Organization field and selecting the organization from the list.  Use this 
to select the organization of the user to which you want to grant 
privileges. Notice that when the different organization is selected, the 
list of knowledge workers in the KWID box below changes. 

5. Select the user or group to assign rights by clicking once with the left 
mouse button on the name in the KWID list. The selected ID will be 

highlighted in blue. 

6. Select the set of access rights to grant by clicking on the appropriate set 

in the Assigned Access Rights box. 

7. Click OK. 

Viewing a Task Palette 
Task 

SiPalettecSecuntoi'''" 
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Chuck Brown None I 
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George  Kelly None f 
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Group None § 
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Figure 6-9: Palette Permissions Dialog Box 

You can view the task structure of a palette task and edit the task 
field values. You can also enter variable names for task field values 
so that users will be prompted to enter values when copying a palette 

task to KWS. 
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To edit a palette task: 

1. Double-click on the task icon. 
The Task Palette Manager window opens in the main KWS window, 
with the palette task selected. 

2. Use the Modify button on the button bar to modify the palette task. 

***  Changing Palette Task      You can change the palette task icon for an entire palette or for a 
Icons single palette task. 

1 Default! con                                                             1 

o |      OK       | 

Reset    1    Select... Cancel 

Figure 6-10: Task Palette Default Icon Dialog Box 

To change the default icon for all palette tasks on a palette: 

1. Select the palette to change. 

2. Select Settings from the Task Palette menu bar. 

3. Select Palette from the Settings menu. 

4. Select Default Icon from the Palette submenu. The Default Icon dialog 
box will appear. 

5. Click the Select button. The Icon Browser dialog box will open. 

6. Select the icon file to be used as the default icon. 

7. Click OK. 
You will be returned to the Default Icon dialog box. 

8. Click OK. 

To change the default icon back to the palette default icon: 

1. Select the palette to change. 

2. Select Settings from the Task Palette menu bar. 

3. Select Palette from the Settings menu. 
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4. Select Default Icon from the Palette submenu. The Default Icon dialog 
box will appear. 

5. Click Reset. 

6. Click OK. 

To change the icon for a single palette task: 

1. Select the palette task to change. 

2. Open the Task Dialog box for the palette task by double clicking on the 
palette task icon. 

3. Click the Change Icon button. The Icon Browser dialog box will open. 

4. Select the new icon file. 

5. Click OK. 

To change the icon for a single palette task back to the default icon: 

1. Select the palette task to change. 

2. Open the Task Dialog box for the palette task by double clicking on the 
icon. 

3. Click the Set To Default button. 
The icon will change back to the default icon for the palette. 

When an icon for the single palette task is set back to the default icon, it is 
the default icon for the palette, which is not necessarily the Task Palette 
program default icon.  

TASK PALETTE MANAGER 

The Task Palette Manager (Figure 6-11) is used to create and manage 
palette processes. The Task Palette Manager is similar to the Task 
Manager Window except that, instead of processes, the Task Palette 
Manager lists all palettes owned by the current user's organization. 
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Task Palette Manager riTnrei 
Palette Processes: FF 
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Figure 6-11: Task Palette Manager 

To assign a variable value to a field: 

You can assign a variable name to a field value or perform simple calcula- 
tions within a field. A variable name can be any text string that starts with a 
dollar sign ($). For example, you can enter the variable name $ID in the ID 
field. Then, whenever you copy the task to KWS you will be prompted to 
enter a value for the $ID variable. The ID field will then be set to the value 
specified. Fields can also contain simple mathematical formulas. For 
example, you can enter the formula $START_DATE + 5 into the Date Due 
field. Whenever you copy the palette task to KWS you will be prompted to 
enter a value for the $START_DATE variable. The Date Due field will then 
be set to the value specified plus five. 

When you are creating a palette task that will be used by other users, it is 
recommended that you enter variable values into the Assigned To, 
Performed By, and Assigned By fields. For example, suppose all three 
fields are set to the variable $KWS_USER. Each time the task is copied to 
KWS, the user copying it will be prompted to enter one value that will be 
assigned to all three fields. You may also leave these fields blank, and the 
values will default to the User ID of the user dragging the task to KWS. 

Task Palette Manager The Task Palette includes the Task Palette Manager. This window is 
available under the Task menu within KWS, along with the Task Manager 
and Graphical Task Manager. The Task Palette Manager provides the 
capability to edit Palette Processes within KWS, using the same interface 
used to create normal processes. A list of all of the Palettes containing a 
particular Palette Process can also be viewed. 
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To edit palette processes in the Task Palette Manager: 

1. Select Task Palette Manager from the Task menu. 
The Task Palette Manager window appears. This browser window 
allows you to browse through palette process hierarchies. 

2. Use the Insert, Delete, and Modify buttons on the button bar to add, 
remove, or change palette tasks. 

To view a list of palettes containing a specified palette process: 

1. Select a palette process in the top-level window of the Task Palette 
Manager window. 

2. Click the Palettes button on the button bar. 
The Palettes Containing Task Dialog Box that appears contains a list of 
all of the palettes containing the selected palette process. 

3. Click OK to close the dialog box. 

To filter the list of palette processes in the Task Palette Manager: 

1. While the Task Palette Manager window is active, select Filter... from 
the Window|Options menu. 

The Task Window Options dialog box appears. 
Selecting users and groups in the User/Groups listbox only displays 
palette processes owned by the users/groups. 

2. Check the Save Options as Default button if you want to use the same 
Task Palette Manager Windows options in the future. 

3. Click OK to save the specified options. 

To add a palette process to a task palette: 

1. Open the Task Palette Manager window by selecting Task Palette 
Manager from the Task window. 

2. Drag a palette process from the Task Palette Manager window to a task 
palette. A link to the palette process will be placed on the palette. 

Graphical Editing of Palette processes can now be edited graphically in a Graphical Task 
Palette Processes Manager window by selecting Graph in the Available Options Menu of the 

Task Palette Manager. 



6-16 KWS Ver 3.6 Reference Guide 

To edit a palette process graphically: 

1. Open the Task Palette Manager window by selecting Task Palette 
Manager from the Task window. 

2. Select a palette process and select Graph from the Available Options 
Menu for the task. 
A Graphical Task Manager window opens and displays the palette 
process. The due date of the top-level task of the palette process 
(SDUEDATE) will be set to the current date, and all editing of dates will 
be relative to this date. 

3. When editing the palette process, select SaveChanges from the 
Windows menu. 
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OVERVIEW 
KWS provides several options for customizing the KWS environment. 
These options include configuring the KWS Program Window, setting font 
and display preferences, defining options for handling attachments, entering 
knowledge worker and work group information, and setting up KWS 
database connections. The following sections describe these options. 

SYSTEM OPTIONS 
*** Non-Working Day 

Prompt 
KWS allows you to set the prompt option for non-working days. This 
setting determines what action the program will take when a task is due on a 
non-working day. 

To change the non-working day prompt option: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File menu. 

3. Select System Options from the Preferences submenu. 
The Options dialog box opens. 

4. In the Task Scheduling section, select the prompt option you desire. 

5. Click OK. 

*** Notification Option KWS can be set to automatically open the Notifications window on startup if 
you have new notifications. 

To set the Notifications option: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File menu. 

3. Select System Options from the Preferences submenu. The Options 
dialog box will appear. 

4. In the Notifications section select the check box for Open window on 
startup. If the box is checked, the Notifications window will 
automatically open on KWS startup, whenever you have new 
notifications. 
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Notification as Email Notifications can be sent to you as email. 

To allow other users to send you notifications as email: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File menu. 

3. Select System Options from the Preferences submenu. The Options 

dialog box will appear. 

4. In the Notifications section select the check box for Send Notifications 
as Email. If the box is checked, other users will be able to send 
notifications to you through your email package. 

KWS PROGRAM WINDOW CONFIGURATION 
* Saving Your KWS 

Window Configuration 

KWS allows you to save your current window configuration with KWS. 
When you do this, the current size and location of all windows in the KWS 
workspace will be saved. These windows will then be displayed each time 
you login to KWS until you save a new configuration. 

To save your KWS window configuration: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu. 

3. Select Save Window Configuration from the Preferences Menu. 

or... 

*!* Displaying the Status 
Bar 

Instead of steps 1-3, you may enter [Ctrl ]+ S. 

I The contents of a GTM Window, attachment query windows and Do It 
! search windows are not saved. 

You can specify whether the status bar will be displayed in the KWS 
Program Window. 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu. 

3. Select Show Status Bar from the Preferences Menu. 
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j If the Show Status Bar option has a check mark next to it, the Status Bar 
[ will be displayed. Otherwise, it will not be displayed. 

<* Displaying the Button        You can specify whether the button bar will be displayed in the KWS 
Bar Program Window. 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu. 

3. Select Show Button Bar from the Preferences Menu. 

j If the Show Button Bar option has a check mark next to it, the Button Bar 
| will be displayed. Otherwise, it will not be displayed. 

FONT AND DATA DISPLAY PREFERENCES 
KWS allows you to set preferences for fonts and displaying data fields. 
Preference options that are not window specific are accessed from the File 
Menu, Preferences option. Preference options that are window specific are 
accessed from the Window Menu. 

Display Font Setup 
Setting Display Fonts You can specify the font to use to display text within KWS. The font you 

specify will be used for all text display within KWS, so any window can be 
active when you select this option. 

To set display fonts: 

1. Select Preferences from the KWS Menu Bar. 

2. Select Display Font... from the Preferences Menu. The Font Window 
will be displayed (Figure 7-1). 

3. Select your desired Font, Font Style, and Size values from the lists 
provided. 

4. Click OK. 
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Figure 7-1: Font Window 

Display Field Setup 
*1* Specifying Display 

Fields 

You can specify which data fields will be displayed, the order in which they 
will be displayed, the width of the data field, and whether text should be 
wrapped for each window type. These options are window specific, so the 
fields displayed are different for each window type. Remember to make 
the correct window type active before you select this option. 

To access display field options for the active window: 

1. Select Window from the KWS Menu Bar. 

2. Select Display Field Setup from the Window Menu. The Display Field 
Setup Window for the active window type will appear (Figure 7-2). 
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ToDo Field Setup 

Fields Displayed 

- Date Due" 
Title 
ID 
Assigned To 
Performed By 
Duration 
Status 
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Assigned By 

Date Due 

Width: (in.V I°-7 

Width   > s^rap 

<« | 

:ields Not Displayed 

0.7" MR * Attachments 
3" 
0.75" 
0.75" 
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Ye~~ 
Nc ' 
Nc 
Nr-1 

Nc 
Nc 
Nc    . 
Nc^j 

Dolts 

0.5" 
1" 
0.75" 
0.75" 

>» I 

V Wrap OK    I      Cancel 

Figure 7-2: Display Field Setup Window 

The Display Field Setup Window contains the following information: 

Specifying Data Fields 
To Display 

Fields Displayed 

Fields Not Displayed 

Width 

Wrap 

The data fields that will be displayed in the 
window. 

The data fields that will not be displayed in 
the window. 

The display width of the data field. 

Causes the text in the data field to wrap 
around to the next line within the 
boundaries of the data field width. 

3.   Within the Display Field Setup Window, any of the following procedures 
can be performed. When finished, click OK to save your changes. 

To specify which data fields to display: 

You specify which data fields to display by moving them between the Fields 
Displayed and the Fields Not Displayed lists. 

1. Select the data field in the Fields Displayed list or the Fields Not 
Displayed list that you want to move. 

2. Click the arrow button between the Fields Displayed and Fields Not 
Displayed lists that points toward the list to which you want to move the 
data field. The data field will move. 
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3.   For each data field to be moved, repeat steps 1 and 2. 

Reordering Data Fields     To reorder data fields: 

1. Select the data field to be moved by clicking on it in the Fields 
Displayed list. 

2. Move your cursor into the column of horizontal lines to the left of the 
data field titles. Do not hold down the mouse button. A thick bar will 
appear in place of the cursor. 

3. Move the bar up or down through the column to the desired position. 

4. Click the mouse button. The selected data field will be moved to the 
new position. 

5. For each data field to be moved, repeat steps 1 through 4. 

Setting Data Field Width   To set data field width: 

1. Select the data field for which you want to change the display width. 

2. Enter the new value in the Width field. 

3. For each data field width to be changed, repeat steps 1 and 2. 

Setting the Text Wrap        To set the text wrap option: 
Option 

1. Select the data field for which you want the text to wrap. 

2. Click the Wrap checkbox. A check will appear in the box. 

3. For each data field for which the text is to wrap, repeat steps 1 and 2. 

Printer Page Setup  
*> Specifying Page Setup       You can specify page margins, headers, and footers to be used when printing 

for Printing from KWS. The values specified will be used for all text prints from KWS, 
so any window can be active when you select this option. 

To specify page setup for printing: 

1. Select Preferences from the KWS Menu Bar. 

2. Select Printer Page Setup from the Preferences Menu. The Page 
Setup Window will appear (Figure 7-3). 
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3. Enter the desired values for the Page Width, Page Length, Top Margin, 
Bottom Margin, Left Margin, and Right Margin. 

4. Enter any text that you would like to display in the header and footer and 
enter values for their Left, Center, and Right Margins. You may also 
specify replaceable parameters in the header and footer to display 
information such as the current date, database ID, or KWS User ID. To 
see a complete list of valid replaceable parameters, click the 
Replaceable IDs... button in the lower left corner of the Page Setup 
Dialog Box. The Print IDs Window will be displayed with the available 
IDs listed. 

5. Click OK. 

Page Setup 

Page Width: 

Page Length: pi 

Replaceable IDs... 

Top Margin:      P 

Bottom Maigin: P 

Left Margin:    P 

Right Margin:  P 

- H eader ——-"—-—— 

Left Center Right 

|$DATE :|$TITLE j$KWID: $KWFIRST $KWMID '■■ 

Left Margin:   I0-5 Top Margin:   I0-5 Right Margin: j1 

- Footer——————— 

Left Center Right 

j$0RG |$DBID $DBNAME J$PAGENUM 

Left Margin:   i0-5 Bottom Margin: I0-5 Right Margin: j0-5 

Ok Cancel 

Figure 7-3: Page Setup Window 

Printer Font Setup 
Setting Printer Fonts You can specify the font that you want to use to print text from KWS. The 

font you specify will be used for all text prints from KWS so any window 
can be active when selecting this option. Note that these options only affect 
how the data will appear when printing and do not affect how the data 
appears in the window. 

To set printer fonts: 

1.   Select Preferences from the KWS Menu Bar. 
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2. Select Printer Font... from the Preferences Menu. The Font Window 
will appear (Figure 7-1). 

3. Select your desired Font, Font Style, and Size values. 

4. Click OK. 

Printer Field Setup 
Specifying Printer Field 
Options 

You can specify which data fields will be printed, the order in which they 
will be printed, the width of the data field, and whether text should be 
wrapped when printing from each window type. These options are window 
specific, so the fields displayed are different for each window type. It is 
important to remember that you have made the correct window type 
active before you select this option. Also note that these options only 
affect how the data will appear when printing and do not affect how the data 
appears in the window. 

To access print field options for the active window: 

1. Select Window from the KWS Menu Bar. 

2. Select Printer Field Setup from the Window Menu. The Print Field 
Setup Window for the active window type will appear (Figure 7-4). 

ToDo Piint Field Setup 

 Fields Displayed Width   Wrap 

ifiBrafliai                  HWMHHKB ■*• 
 Title 2.5"      Ye 
 ID 0.75"    Nc 
 Assigned To 0.75"    Nc 
  Performed By 0.75"    Nc—■' 
 Duration 0.5"      Nc 
  Status 1"         Nc 
— Priority 
 Assigned By 

0.75"    Nc 
0.75"    NcjJ 

Fields Not Displayed 

<« 

>» 

Attachments 
Dolts 

Date Due 

Width: (in.): I07 V Wrap OK Cancel 

Figure 7-4: Print Field Setup Window 

The Print Field Setup Window contains the following information: 
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Fields Displayed The data fields that will be printed from the 
window. 

Fields Not Displayed     The data fields that will not be printed from the 
window. 

Width The print width of the data field. 

Wrap Causes the text in the data field to wrap around to 
the next line within the boundaries of the data field 
width. 

3.   Within the Print Field Setup Window, any of the following procedures 
can be performed. When finished, click OK to save changes. 

<* Specifying Data Fields      To specify which data fields to print: 
To Print 

I Specify which data fields to print by moving them between the Fields 
j Displayed list and the Fields Not Displayed list. 

1. Select the data field in the Fields Displayed list or the Fields Not 
Displayed list that you want to move to the other list. 

2. Between the Fields Displayed and Fields Not Displayed lists, click the 
arrow button that points toward the list to which you want to move the 
data field. The data field will be moved. 

3. For each data field you want to move, repeat steps 1 and 2. 

*!* Reordering Data Fields     To reorder data fields: 

1. Select the data field to be reordered by clicking on it in the Fields 
Displayed list. 

2. Move your cursor into the column of horizontal lines to the left of the 
data field titles. Do not hold the mouse button down. A thick bar will 
appear in place of the cursor. 

3. Move the bar through the column to the desired position. 

4. Click the mouse button. The selected data field will be moved to the 
new position. 

5. For each data field that you want to reorder, repeat steps 1 through 4. 
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* Setting the Data Field       To set data field width 
Width 

1. Select the data field for which you want to change the print width. 

2. Enter the new value in the Width field. 

3. For each data field width you want to change, repeat steps 1 and 2. 

* Setting the Text Wrap        To set the text wrap option: 
Option 

1. Select the data field for which you want the text to wrap. 

2. Click the Wrap checkbox. A check will appear in the box. 

3. For each data field for which you want the text to wrap, repeat steps 1 
and 2. 

ATTACHMENT OPTIONS 
Customize the KWS environment for handling attachments by setting file 
associations, specifying a file viewer, and defining your Applications List. 
These options are described in the following sections. 

Setting File Associations 
File associations are relationships between files and the applications used to 
manipulate them. These relationships are based on the one to three character 
suffix that appears after the period in the filename. For example, a file name 
of budget.doc has a file extension of doc. Most applications append a file 
extension that is unique to the files created. When a file is associated with an 
application, you can open the file and start the application at the same time. 

In the Windows environment, these associations are managed within the File 
Manager. When you install Windows, some files are already associated with 
applications and you may add your own associations. During initial 
installation, KWS imports the Windows File Manager associations into its 
own Associations List. You may add to and modify your KWS Associations 
List. KWS uses this information to determine the Application Name for an 
attachment when it is imported or to launch an attachment for editing if an 
Application Name has not been specified. 

<* Setting KWS File To set KWS file associations: 
Associations 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu. 
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3. Select Associations from the Preferences Menu. The File Extension 
Associations Window will be displayed (Figure 7-5). 

4. Enter the extension to be associated with an application in the Extension 
field. 

5. Enter the path and command line for executing the application in the 
Command field by either typing the value into the field or by clicking 
the file browser button on the right and selecting the file in the file 
browser dialog box. 

6. Click the Set button. 

7. For each file association you wish to create, repeat steps 4 through 6. 

8. When finished, click OK. 

File Extension Associations 

Extension Command: 

E:\WINZIP\winzip3Zexe 

Set >» 

Delete 

OK 

Cancel 

laiilM     ^BMWHIgMISMBT    ifqCWSJ                                                        B .*. 
ARJ E:\WINZIP\winzip32.exe 
BG4 E:\WINZIP\winzip32.exe 
BHX E:\WINZIP\winzip32.exe 
bmp DAC0REL50APR0GRAMS\corelpnt.exe 
cch DAC0REL50\PR0GRAMS\corelcht.exe 
cdr D:\C0REL50\PR0GRAMS\coreldw.exe 
CGM D:\IMAGE\PSP\PSP.EXE 
CLP D:\IMAGE\PSP\PSP.EXE 
cmv DAC0REL50\PR0GRAMS\corelmov.exe 
cpt DAC0REL50\PR0GRAMS\corelpnt.exe 

zl CUT DAIMAGE\PSP\PSP.EXE 

Figure 7-5: File Extension Associations 

I When your KWS Associations List is modified, your Windows Association 
j List is not updated and vice versa. These are two separate lists. KWS 
I simply takes advantage of the contents of the Windows Association List to 
| populate the KWS Associations List when it is initially installed on your 
j workstation. 

Specifying a File Viewer 

KWS enables you to view an attachment without having to launch the 
application used to create it. However, a file viewer must be specified before 
this option is available. A file viewer is a software package that displays the 
contents of a file as it would be displayed in the application that created it. A 
variety of commercially available file viewers allow users to view common 
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file formats such as text files, word processing documents, database files, 
and graphic files. 

Specifying a File Viewer    To set up a file viewer: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu. 

3. Select File Viewer from the Preferences Menu. The Select File Viewer 
Window will be displayed (Figure 7-6). 

4. Select the path and executable file name for your file viewer software. 

5. Click OK. 

Select File Viewer 

File Name: 

notepad.exe 

Directories: 

"c:\WIND0WS 

OK 3 
netpwl.exe - 
Netscape Wallpaper.bn 
netscape.ini 
netstat.exe 

 1 
network, txt 
networks 
liHW'M'l^^       H 
notes, bak Zl 

Qc\ d <^j windows 

Q aim95 
C~\ Application Data 

f~~i bosetup 
D CatRoot d 

Cancel 

Network- 

List Files of lype: Drives: 

All Files "3    |e^ "3 
Figure 7-6: Select File Viewer Window 

Specifying a WWW Browser 
KWS enables you to view a HTTP attachment by automatically launching 
your WWW browser. To enable KWS to launch your WWW browser, you 
must first define the location of your browser. 

To define a WWW Browser: 

1. Select the File menu from the KWS Menu Bar. 

2. Select Preferences from the File menu. 

3. Select WWW Browser from the Preferences submenu. The Select WWW 
Browser window will open. 

4.    Select your browser program. 
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5.    Click OK. 

Specifying a FAX Program 

KWS has the option to export an attachment as a FAX. To enable KWS to 
launch your FAX program, first define the location of your FAX program. 

To define a FAX program to be used within KWS: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File menu. 

3. Select FAX from the Preferences submenu. The Select FAX Program 
window will appear. 

4. Select your FAX program. 

5. Click OK. 

Application List Setup 

Before KWS can launch the application program used to create or edit an 
attachment file, it must know the application's location and executable 
command line.   For example, if a user wants to edit an attachment file 
created in WordPerfect, KWS must know the location of the requesting 
user's executable file for WordPerfect (e.g., c:\wpwin\wpwin.exe). Using 
this information, KWS can launch the application with the associated 
attachment file. In KWS, this information is stored in the Application List. 

Each KWS user maintains their own personal Application List. When you 
set up your Application List, you will choose the application names from the 
Master Application List. The Master Application List is entered by your 
KWS System Administrator and contains the standard names given to 
applications within KWS. 

The purpose of the Master Application List is to ensure consistency in 
naming applications throughout KWS. Without this consistency, problems 
may arise when you try to edit an attachment created by another user who 
uses a different name for the application.  For example, suppose you named 
your WordPerfect "Wpwin" and another user named theirs "WordPerfect," 
and each of you created attachments using these values in the Attachment 
Profile. When either of you tried to edit an attachment created by the other, 
KWS would not be able to find the application required to launch the file. 
To solve the problem, each of you would have to add the other user's 



KWS Ver 3.6 Reference Guide 7"15 

application to your application list. In a large KWS environment, this fix is 
both cumbersome and confusing. 

Adding Applications to      To add an application to your Application List: 
Your Application List 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu options. 

3. Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear (Figure 7-7). 

4. Select the application name to add to your list by clicking the small right 
arrow to the right of the Application Name field and then clicking on the 
desired application name from the list provided. The name you select 
will be entered for the value in the Application Name field, and its 
corresponding executable command will be entered for the value in the 
Command Line field. 

5. The value in the Command Line field is a default value associated with 
the Application Name in the Master Application List. If this value is not 
correct for your individual workstation, change it by entering the correct 
value. To enter the value, type it into the field or select it by clicking the 
file browser button to the right of the field. 

6. Once you have entered the Application Name and Command Line 
values, click the Set >» button on the left of the dialog box to add it to 
your list. 

7. For each application to be added to your list, repeat steps 4 through 6. 

8. When finished adding applications, click OK. 
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Applications List 

Application Name:   Microsoft Word 97 

Command Line: jcAmsoffice\winword\winword.exe "El 
Set »> 

Delete 

Launch 

Select Template 

Edit Template- 

(PRIVATE) Arcview 
Microsoft Excel 97 
Microsoft PowerPoint 
iMicrosofWordS.' 
NotePad' 
(PRIVATE) PaintShop Pro 
write 

c:\arcview\arcview.exe 
c:\msoffice\winword\excel.exe 
C:\MSOFFICE\P0WERPNT\P0WE 

3B SmsofficeV 
c:\windows\notepad.exe 
c:\ps\pspro.exe 
write.exe 

* = master template file defined 

*" = private template file defined 
OK Cancel 

Figure 7-7: Application List Dialog Box 

Modifying the Command   To change the Command Line of an Application: 
Line of an Application in 

1.   Select File from the KWS Menu Bar. Your Application List 

2. Select Preferences from the File Menu options. 

3. Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear. 

4. Select the application name to be modified by clicking on its name in 
your application list. The name selected will be displayed in the 
Application Name field along with its Command Line. 

5. Enter the new value in the Command Line field. 

6. Click the Set >» button on the left side of the Application List Dialog 
Box. The new Command Line value should appear in the application 
list. 

Deleting an Entry in 
Your Application List 

7.   Click OK. 

To delete an entry in your Application List: 

1.   Select File from the KWS Menu Bar. 
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2. Select Preferences from the File Menu options. 

3. Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear. 

4. Select the application name to delete by clicking on its name in your 
application list. The name you select will be displayed in the 
Application Name field along with its Command Line. 

5. Click the Delete button on the left side of the Application List Dialog 
Box. The application will be removed from the application list. 

6. Click OK. 

'  Creating Private When you create new attachments, KWS must be able to find a template file 
Application Templates       for the application. This template file is a file that is saved in the applica- 

tion's format. The template file is usually an empty file but may contain 
characters if desired. When you create a new attachment, KWS makes a 
copy of the template file and gives it a KWS generated filename. If a 
template file does not exist for a given application, you will not be able to 
create new attachments using its Application Name. However, you may 
still edit or view existing attachments with it. 

KWS automatically generates a template file for an application selected from 
the Master Application List. This template file may be used for creating 
attachments, so it is not necessary to create template files. If you would 
rather have a personalized template for an application, you may create a 
private application template. For example, you may always want your 
Microsoft Word documents to be formatted using a specific style sheet. You 
may do this by creating a private application template for Microsoft Word 
that uses the style sheet. 

To create a private application template: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu options. 

3. Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear. 

4. Select the application name for which to create a template by clicking on 
its name in your application list. The name selected will be displayed in 
the Application Name field along with its Command Line. 

5. Click the Launch button on the left of the dialog box. KWS will launch 
the selected application. 
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Editing a Private 
Application Template 

6. Enter any text to be included in the template file and then save it using 
normal procedures for the application. [REMEMBER THE NAME 
AND LOCATION OF THE FILE YOU CREATE—YOU WILL 
NEED IT LATER.] Exit the application and you will return to the 
Application List Dialog Box. 

7. Click the Select Template button on the left of the dialog box. The 
Select Template File Dialog Box will appear. Select the name of the file 
created in the previous step and click OK. Two asterisks will be 
displayed to the right of the Application Name to indicate that you have 
created a private template file for it. 

8. Repeat steps 4 through 7 for each private template you want to create. 

9. Click OK to save and exit the Application List Dialog Box. 

To edit a private application template: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu options. 

Adding Private 
Application Names to 
Your Application List 

4. 

5. 

Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear. 
Select the application name for which you want to edit the template by 
clicking on its name in your application list. The name selected will be 
displayed in the Application Name field along with its Command Line. 

Click the Edit Template button on the left of the dialog box. KWS will 
launch the selected application with the template file. 

6. Edit the template file. When you are finished editing, save the file using 
normal procedures for the application. [DO NOT CHANGE THE 
NAME OF THE FILE.] Exit the application and you will return to the 
Application List Dialog Box. 

7. Click OK to save and exit the Application List Dialog Box. 

KWS allows you to add applications to your personal Applications List that 
are not in the Master Application List. This capability is provided so 
attachments can be created using an application that has not been set up yet 
on the Master Application List. It is not recommended for regular use unless 
you do not need to share attachments with other users. 

KWS will automatically set the Storage Type to Private for attachments 
created using Private Application Names. Hence, only the user creating the 
attachment will have access to it. As a private attachment, it will also be 
stored on the workstation where it was created. An attachment's private 
Application Name may be changed to an Application Name on the Master 
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Application List only after the application has been added by your System 
Administrator. 

To add a private application name to your Application List: 

1. Select File from the KWS Menu Bar. 

2. Select Preferences from the File Menu options. 

3. Select Application List... from the Preferences Menu options. The 
Application List Dialog Box will appear. 

4. Enter the name of the application that you want to add to your list by 
typing it in the Application Name field. 

5. Enter the executable file name for the application in the Command Line 
field by typing it into the field or by clicking on the file browser button 
to the right of the field and selecting the file name in the file browser 
window. 

6. Once you have entered the Application Name and Command Line 
values, click the Set >» button on the left of the dialog box to add the 
application to your list. 

7. Click OK. 

Archiving Attachments 
The KWS Administrator can periodically run the Attachment Archive 
function. This function will go through the KWS database and move any 
attachment document with a long-term storage type of Archive and that has 
not been viewed or edited within the retention period to the archive directory. 
A document that has been archived will automatically be moved back to the 
KWS Attachment directory if it is accessed from within KWS. The 
Attachment Archive function will also delete any attachment with a long- 
term storage type of Delete and that has not been viewed or edited within the 
retention period. 

Archiving Attachments       To run the Archive Attachments function: 

1.   Select Admin from the KWS menu bar. 

2.   Select Archive Attachments from the Admin menu. The Archive 
Attachment dialog box will appear, giving you the option to cancel the 
operation. 
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3. Click OK if you want archive attachments or click No if you want to skip 
archive but want to run the delete attachments option. The Delete 
Attachment dialog box will appear next, giving you the option to cancel 
the operation. 

4. Click OK if you want to delete attachments. 

KNOWLEDGE WORKERS AND WORK GROUPS  
KWS provides the capability to view a list of knowledge workers and work 
groups in your organization. In addition, you can modify information about 
a knowledge worker and add, modify, and delete work groups. 

The User List 

) You must have KWS System Administrator privileges in order to add and 
I delete KWS User IDs. 

Viewing the KWS The KWS User List contains a list of organizations and their users within an 
User List MDI window. The split-screen MDI window allows you to view the users 

within and organization and the work groups of each user. 

To view the KWS user list: 

1. Select Admin from the KWS Menu Bar. 

2. Select Knowledge Workers from the Admin Menu. The Knowledge 
Workers Window (Figure 7-8) will be displayed with your organization 
and users listed. 

3. A list of the users in an organization can be viewed by double-clicking 
on the organization. The users in the selected organization will appear in 
the lower level. 
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Knowledge workers 

ID 
Organizations 

Title 

FF FFORG 
General Management Team 

BIEEBI 

ID 
Knowledge Workers in Organization GMT 

First Name Last Name 

BROWN C 
JONES_M 
KELLY_G 
WENT L 

Brown 
Jones 
Kelly 
Went 

Chuck 
Mike 
George 
Lyn 

Figure 7-8: Knowledge Workers Window 

Modifying User 
Information 

\ Move between levels of the window by clicking the browser arrow buttons 
| located on the leftmost edge of the windows. If the browser arrow is gray, 
I there are no items at the next level. 

Each KWS User ID has information associated with it that describes the 
knowledge worker to whom it is assigned. This information includes the 
knowledge worker's full name, supervisor, phone number, and so on. 

To modify user information: 

1. Select Admin from the KWS Menu Bar. 

2. Select Knowledge Workers from the Admin Menu. The Knowledge 
Workers Window will appear. 

3. Select the User ID for which you want to modify user information. 

4. Click the Modify button. The Knowledge Worker Dialog Box (Figure 
7-9) will appear. 



7-22 KWS Ver 3.6 Reference Guide 

i Knowledge Worker 
 ...■.;.                                                                                     .           . 

ID    |BR0WN_d                        JHI 

First                              Middle 

-j Chuck                     J'|A 

Oig  !GMT                          Z. 

.   ' \ JT KWS Admin. Priväege 

•      T~ Task Palette Manager 

Last 

|| Brown 

•Change Password 

Ij 

Supervisor:. |Kim.Mooja | 

Office Sym:  lcI^R-GMT 

Phone:        1*3794 

Fax Phone:  1217-373-6724 
riK 

Address:      IUSA CERL POB 9005 ChamP linn II RIR^G                   ...... 

EmaJAddr.   |cbrown@cecerl.army.mil uancei 

Figure 7-9: Knowledge Worker Dialog Box 

The Knowledge Worker Dialog Box contains the following data fields: 

User ID 

Org 

KWS Admin 
Privilege 

Name 

Supervisor 

Office Symbol 

Phone 

FAX Phone 

Address 

EMail Addr 

The selected KWS User ID. 

The name of the organization to which the User ID 
has been assigned in the KWS database. 

Indicates whether the User ID has been granted KWS 
administrative rights. 

The first, middle, and last name of the user. 

The name of the user's supervisor. 

The user's office symbol. 

The user's telephone number. 

The user's FAX number. 

The user's business mailing address. 

The user's email address. 

5.   Change user information by entering the desired value into the data field. 
Unless you have the KWS Admin Privilege, the User ID and Org fields 
will be grayed out and cannot be changed. 

6.   Click OK to save your changes. 
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Changing Passwords KWS includes a function for changing a user's KWS and database 
password. Changing a password from within KWS is only possible if the 
user's KWS and database accounts have the same name. 

To change a user password: 

1. Open the Knowledge Worker window. 

2. Select the user's account. 

3. Click the Modify button. 
The Knowledge Worker Modify Dialog Box opens. 

4. Click Change Password. 

5. Enter the new password. 

6. Click OK. 

Viewing Work Groups 
Containing a Selected 
User ID 

From the User List, you may view a list of all of the work groups to which a 
selected User ID has been assigned. You may also view a list of all 
members assigned to work groups of the selected User ID. 

To view work groups containing a selected User ID: 

1. Select Admin from the KWS Menu Bar. 

2. Select Knowledge Workers from the Admin Menu. The Knowledge 
Workers Window will appear. 

3. Double-click on the User ID for which you want to view its assigned 
work groups. A Work Groups containing <User ID> Window will be 
displayed in the lower part of the Knowledge Workers Window. 

Work Groups 
A work group is two or more knowledge workers working toward a common 
business goal. In KWS, tasks can be assigned to individual knowledge 
workers and work groups. An organization within KWS is typically 
composed of multiple work groups with one or more knowledge workers 
assigned to each work group. When a task is assigned to a work group, each 
individual KWS User ID within the work group is assigned the task. 
Although a work group is part of a KWS organization, members of the work 
group can belong to different organizations. 
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Viewing Work Group 
Information 

Information about work groups may be viewed within the Work Groups 
Window (Figure 7-10), which displays a list of organizations and their Work 
Groups within an MDI Window. The split-screen MDI window allows you 
to view the work groups within an organization, the knowledge workers 
assigned to a work group, and the work groups assigned to a knowledge 
worker. 

|      Woik Groups HBE3 
Organizations 

ID 

FF 

Title 

FFORG 

► ! 

4 iMT General Management Team| 

JJJ 
Work Groups in Organization GMT 

ID Title 

fi LCCT Accounting 

► C 

<! 1 

)PS Operations 

-i- ► ] 

Figure 7-10: Work Groups Window 

To view work group information: 

1. Select Admin from the KWS Menu Bar. 

2. Select Work Groups from the Admin Menu. The Work Groups 
Window will be displayed with your organization and work groups 
listed. 

3. A list of the work groups in an organization can be viewed by double- 
clicking on the Organization. The work groups in the selected 
organization will appear in the lower level. 

4. A list of the knowledge workers in a work group can be viewed by 
double-clicking on the Work Group. The work group list will move to 
the top level window and the knowledge workers in the selected work 
group will be displayed in the lower level. 

5. A list of work groups to which a knowledge worker belongs can be 
viewed by double-clicking on the knowledge worker. The knowledge 
worker list will move to the top level window and the list of work groups 
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*!* Adding Work Groups 

Deleting Work Groups 

to which the knowledge worker belongs will be displayed in the lower 

level. 

Move between levels of the window by clicking the browser arrow buttons 
located on the leftmost edge of the windows. If the browser arrow is gray, 

there are no items at the next level.  

To add a Work Group: 

1.   Select Admin from the KWS Menu Bar. 

2. Select Work Groups from the Admin Menu. The Work Groups Window 
will be displayed with your Organization selected and Work Groups listed. 

3. Click Insert. The Work Group Dialog Box will appear (Figure 7-11). 

Woik Gioup 

ID: 

Title: 

Org: GMT -3 
QIC Cancel 

Figure 7-11: Work Group Dialog Box 

The Work Group Dialog Box contains the following data fields: 

ID The name of the Work Group. This value will appear in the 
KWS user list when assigning tasks. 

Title A descriptive title that describes the purpose of the work group. 

Org The organization to which the work group belongs. 

4. In the Work Group Dialog Box, enter values for the ID and Title. 

5. Click OK. The Work Group will appear in the list for the organization. 

To delete a Work Group: 

1.   Select Admin from the KWS Menu Bar. 
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2. Select Work Groups from the Admin Menu. The Work Groups 
Window will be displayed with your Organization selected and Work 
Groups listed. 

3. Select the Work Group to be deleted. 

4. Click Delete. The Delete? Dialog Box will be displayed. 

5. Click Yes. 

| A work group with uncompleted assigned tasks cannot be deleted; all tasks 
| must first be reassigned to other users or work groups. If you try to delete a ! 
| work group that has uncompleted tasks, KWS will open a Task window that ! 
j list all uncompleted tasks assigned to the work group. After you have 
j reassigned the tasks, the work group can be deleted. 

*!* Modifying Work Group     To modify work group information: 
Information 

1. Select Admin from the KWS Menu Bar. 

2. Select Work Groups from the Admin Menu. The Work Groups will 
appear with your Organization selected and Work Groups listed. 

3. Select the Work Group for which you want to modify information. 

4. Click Modify. The Work Group Dialog Box will be displayed. 

5. Enter new values for the ID and Title. 

6. Click OK. 

*** Adding Users to a Work    To add users to a Work Group: 
Group 

1. Select Admin from the KWS Menu Bar. 

2. Select Work Groups from the Admin Menu. The Work Groups 
Window will be displayed. 

3. Double-click on the work group to which users are to be added. 
A list of users in the work groups appears in the lower level window. 

4. Select Admin from the KWS Menu Bar. 

5. Select Knowledge Workers from the Admin Menu. 
The Knowledge Workers Window will open. 

6. Select the Organization and User ID that you want to add to the work 
group. To select multiple User IDs, press the [Ctrl] key and click each 



KWS Ver 3.6 Reference Guide 7-27 

ID you wish to include. While holding down the mouse button, drag the 
selected User IDs to the window containing the list of users in the work 
group. 
A Confirm MOVE or COPY Dialog Box opens. 

7.   Click Copy. The User ID will appear in the Knowledge 
Work Group level of the Work Groups Window. 

Workers in 

*t* Deleting a User from a 
Work Group 

To delete a user from a work group: 

1.   Select Admin from the KWS Menu Bar. 

- 

2. Select Work Groups from the Admin Menu. The Work Groups 
Window (Figure 7-10) will appear. 

3. Double-click on the work group from which you want to delete a user. 
To select multiple User IDs, press the [Ctrl] key and click each ID you 
wish to include. A list of users in the work groups will be displayed in 
the lower level window. 

4. Select the user that you want to delete from the work group. 

5. Click Delete. The Remove from Group? Dialog Box will be displayed. 

6. Click Yes. 

Reassignment 

Reassigning All of a 
User's Tasks 

It may become necessary to reassign the tasks belonging to a user, work 
group, or organization. KWS allows an administrator to reassign all tasks or 
a single task structure to other users. 

To reassign all of a user's tasks: 

1. Open the Knowledge Worker window. 

2. Select the user. 

3. Click the Reassign button. 
The Reassign Tasks Dialog Box opens. 

4. For each of the fields, Assigned To, Performed By, Assigned By, and 
Task Owner, select the user to assign the task. 

5. Click OK. 
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Reassigning a User's To reassign a task and all its children: 
Task 

1. Select the task to reassign. 

2. Select Reassign from the Available Options Menu. 
The Reassign Tasks dialog box opens. 

3. For each of the fields, Assigned To, Performed By, Assigned By, and 
Task Owner, select the user to assign the task. 

4. Click OK. 

*'* Reassigning an Org ID      KWS has a function that changes an organization's ID field throughout the 
database. 

To change an organization's Org ID: 

1. Open either the Knowledge Worker list or the Work Group list. 

2. Select the organization to change. 

3. Click the Modify button. 
The Organization Dialog Box opens. 

4. Modify the ID field. 

5. Click OK. You will be asked to confirm that you want to change all 
occurrences of the old organization ID. 

*!*  Changing a Task's Org      To change the Org ID of a task: 
ID 

1. Open either the Knowledge Worker list or the Work Group list. 

2. Select the organization that contains the tasks to be changed. 

3. Click the Tasks button. 
The Task Manager for the selected organization opens. 

4. Select the task to change. 

5. Click the Modify button. 

6. Enter the new value in the Org ID field. 

7. Click OK. 



KWS Ver 3.6 Reference Guide 7-29 

KWS DATABASE AND FILE STORAGE SETUP 
Your KWS database connections are typically defined for you when KWS is 
installed. You may view and modify this information and establish 
connections to other KWS databases if needed. When you have more than 
one database connection setup, you select which one you want to connect to 
when you log in to KWS. See Chapter 1, The KWS User Interface, Logging 
in to KWS, for more details. 

Database connections are entered using the KWS Database Setup Window. 
In this window you may specify the information required for connecting to 
the database, as well as information required for storing attachment files. If 
you do not have the information you need, see your KWS System 
Administrator for assistance. 

KWS Database Setup 

! Connection ID:] KWS Man 11- Archive    f~ Remote Access 

ComectionName:jkwsdätabase   .. ~. 

-r^'Ö»acte'0.ä'd&;; 
•II C Oracle QDBCjl 

M^r^SQliÄeryeiODBiJl 

ikwsman i Databäse ID fevvi ?.- 

Knowledge Worker JDriJ^AfPESJi 

^^abaseLo^JpiÄ-j       _.   . 

pD'aiabäseJiöghPwdJ.;- I 

( KW5TableOw^riö:] \. 

' Aichive:CinneptjohlD:r-L_.    _...   — 

Pfivale Attachment Directory:,.; >*^ v£l 

Pubic BetaehtialMachrr^tDirectoßd 

c:\kwsSattach\public\kwsman 

71 
is: 

c:\kws\attach\private\kwsman 

c:\kws\attacrArer\kwsman 

|c:SkwsSattach\archiveM<wsman       ]|E]I 
Attachment-ArchiveDirectory* | 

;QK1 .Cancel |Valjd&te Buegörjes]) 

Figure 7-12: KWS Database Setup Dialog Box 
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The KWS Database Setup Window contains the following data fields: 

ID 

Name 

Database Type 

Oracle Host 

Knowledge Worker ID 

Database Login ID 

Database Login Password 

KWS Table Owner ID 

A short name used for identifying the 
database. 

A long name used to describe the 
database. 

The type of the database to which you are 
connecting. The value must be either 
Oracle OCI, Oracle ODBC, or Access 
ODBC. 

The source string required for connecting 
to the database. 

The KWS User ID used for connecting to 
the database. 

The Oracle User ID used for connecting to 
the database. 

The KWS password used for connecting to 
the database. 

The Oracle Table Owner ID of the 
database. 

Public Attachment Directory     The directory and pathname used for 
storing Public attachment files. 

Private Attachment Directory    The directory and pathname used for 
storing Private attachment files. 

Public Referential 
Attachment Directory 

Private Referential 
Attachment Directory 

Attachment Archive 
Directory 

The directory and pathname used for 
storing Public Referential attachment files. 

The directory and pathname used for 
storing Private Referential attachment files. 

The directory and pathname used for 
storing archived attachment files. 

Viewing or Modifying        To view or modify your KWS database connection information: 
Information About Your 
KWS Database 
Connection 
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1. Select Admin from the KWS Menu Bar. 

2. Select Database from the Admin menu. 

3. Select Setup Database Connections from the Database submenu. 
The KWS Databases Window will be displayed listing all of the 
connections you have defined (Figure 7-13). 

4. Select the database for which you want to view information. 

5. Click the Modify button. The KWS Database Setup Dialog Box will be 
displayed. 

6. Click the Cancel button to exit without making modifications. Enter 
your desired changes and click the OK button to save changes. 

s« KWS Databases 

ID Name Type 
Riß 

Source/Host     *j 

cerlmain       Cerl's main database Oracle OCI kwscerl 
cerltrain Cerl Training Database Oracle OCI kwstrain 
kws30 KWS 3.0 test database Access ODBC kws30 
Icws95 Test KWS Access db for Win Access ODBC kws95 
kwsdb kws user manual database Access ODBC kwsman 
kwsdemo KWS Access demo database Access ODBC kwsdemo 

üLJ A 
Figure 7-13: KWS Databases Window 

*> Attachment Directory 
Maintenance 

The Database Connections Setup dialog box contains a Validate 
Directories button that validates the specified attachment directories. A 
user with Admin privilege has the option of allowing KWS to automatically 
create the validation files in the specified directory. 

To setup the attachment directories for a database connection: 

1. Open the Database Connections Setup Dialog Box by inserting or 
modifying a database connection record from the Database 
Connections window. 

2. Enter or select a directory for each Attachment directory field. 

3. Obtain the ID of the database from the System Administrator and enter 
this value into the Database D3 field. This value is compared to a value 
in the control file of each attachment directory to verify that the correct 
attachment directory has been specified. 

4. Click the Validate Directories button. This action will verify each 
directory and display a message for each invalid directory. If you have 
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Admin privilege, you will be given the option of creating a directory and 
the control file if it does not exist. 

DATA MAINTENANCE 

Exporting the Entire 
Database 

Exporting a Task 
Structure 

KWS includes several functions to help the KWS Administrator maintain the 
database. These functions include exporting and importing all or part of a 
KWS database, and identifying and removing orphaned objects. 

To export the entire database: 

1. Select Admin from the KWS menu bar. 

2. Select Database from the Admin menu. 

3. Select Export Entire Database from the Database submenu. A Dialog 
Box will open. 

4. Enter the name for the database file. 

5. Click OK. 

To export a task structure: 

1. Select Admin from the KWS menu bar. 

2. Select Database from the Admin menu. 

3. Select New Export/Import Database from the Database submenu. A 
Dialog Box will open. 

4. Enter a name for the database file. 

5. Click OK. An empty Task Manager Window will open. 

6. Drag the task structure to export into the destination Task Manager 
Window. 

7. Close the Task Manager Window. 

Importing a Task 
Structure 

To import a task structure: 

1. Select Admin from the KWS menu bar. 

2. Select Database from the Admin menu. 
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3. Select Open Export/Import Database from the Database submenu. A 
Dialog Box will open. 

4. Select the previously-exported database file to import. A Task Manager 
Window for the selected database will be opened. 

5. Open the KWS Task Window where the tasks are to be imported. 

6. Drag the task structure into the KWS Task Window. 

*>  Orphan Objects As KWS evolves, it is possible that the database will contain orphan objects. 
An orphan is a non-top level task that doesn't have a parent, or steps, 
attachments, or Do Its that are not associated with an object. A KWS 
administrator can get a list of orphans and delete them from the database. 

To list orphan Tasks, Steps, Attachments or Do Its: 

1. Select the Admin menu from the KWS menu bar. 

2. Select Database from the Admin menu. 

3. Select Orphans from the Database submenu. 

4. Select Tasks, Steps, Attachments or Do Its from the Orphans 
submenu. A window will open with all orphans listed. 

To delete an orphan Tasks, Steps, Attachments or Do Its: 

1. Open the list of orphans Tasks, Steps, Attachments, or Do Its. 

2. Select the orphan to delete. 

3. Click the Delete button. 

KWS CONVERTER 

*>  Converting Between A set of conversion utilities allows the import and export of KWS data to 
KWS and Other Tools        and from IDEF, SDEF, and Microsoft Project. 
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Overview 

The KWS Converter utility enables the user to import and export information 
from a variety of formats to and from a KWS database. The formats 
supported are IDEF, SDEF, and MS Project. 

Running the Program 

When the Converter utility is started, the user must log on to a KWS 
database. If KWS is already running, KWS Converter will log on to the 
current KWS database. If KWS is not running, the user will be prompted to 
log on to a KWS database. 

The KWS Converter interface (Figure 7-14) consists of two panes: a tree 
view control, which displays the current task hierarchy, and a client area, 
which displays edit forms for the current tasks. Clicking on a task name in 
the tree view will display the task information in the edit form. 

aJKWS Conveitei 

Fäe   Help 
Tasks: 

Project 17Mar98 
fi- Acquire Funds 

;••• Write Proposal 
I- Write Cover Letter 
I - Review Proposal 
]•••• Aquiie Signatures 
1 ~ Submit 

1ÜQ 

Microsoft Project Model 

:       Project I Tasks] 

I     Pioject Name iProject 17Mar98 
|    .   . V ".:■■.■-..- 

%'■■■■■■■■■-'■'"' ■■■■'•       ""-, , ^|||f| ..:.: ."..'.'■:'    .' 

| Start Date JFri 01730/98 

3 FinisKbate]Tue 05/12/98 

Schedule From| Project Finish Date z\ 

Current Date JTue 17/03/38 

Calendar] Standard zj 

! 

KWS •> MSP 

Figure 7-14: KWS Converter Window 

Aligning the Tree View      To align the Tree View: 

1. Click the right mouse button on the tree view portion of the KWS 
Converter. A menu appears with the choices Align Right and Align Left. 

2. Select the desired alignment. 

3. The Tree View will align accordingly. 
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Converting from IDEF 
to KWS 

To convert from IDEF to KWS 

1.   Select IDEF from the File|Open menu. Select a valid IDL file containing 
an IDEF model from the Open File dialog box. Opening the file will 
convert the IDEF model to a KWS model (Figure 7-15). The IDEF 
project name will appear as the KWS process, and thus the top level in 
the tree view. The status bar will display "IDEF -> KWS," signifying an 
IDEF to KWS conversion. 

Z3ms 
Re   Help 

Documenting Material Acquisition 
{=]- Material Acquisition 

!   Er Manage Material Acquisition 

r+1- Process Material Requests 
R Order Material 

[^3EJ 

I-- Order from Existing Supf 
;■■ Order from New Supplier 

El- Generate Purchase OidV= 
(ft- Manage Material Distribution 
1+1 Maintain Supplier Base 

Prepare Material Budget 
Si- Material Acquisition ■ TO BE on Al P \ 
(+} Part Specification Generation 
$■■ Automated Request Processing 

CO- Budget Preparation 
& Material Acquisition -Activation Base 

E Material Acquisition • Cost/Time Ana 

Titter 
P Mtestone      F ToDo item 

{identify Vendor 

ID |Ä21 

;DueDaleh™ar98 

■;,DatpSt^e^P 

? Da^Ffiished.|- 

: Diiaßon jl 

-Status i 

thtiäikaäei'- 
C Slatted 
C Finished 
r OBE 

: Assi9nodTii:j|KAPPESJS    jTJ! 
:'päot^By:IlWPES.S    ~£ 

;:Ä»s^aiiw>pres.s j 

Task Owner |KAPPES.S JJj 

f!o<m 

|1DEF->KWS 

Figure 7-15: IDEF to KWS Conversion 

2. Double clicking on a task in the tree view will display its subtasks. 
Single click on any task, and its task information will be displayed in the 
KWS Task form. 

3. Edit the task information as necessary. 

4. When you are ready to import tasks into KWS, you can select KWS 
from the File|Save menu. This action will import the entire task structure 
into KWS as a top-level process. 

While holding down the Shift key, drag from the tree view to a Task or 
ToDo window on KWS. The task structure will be inserted into that 
KWS window. 

Converting from KWS to    To convert from KWS to IDEF: 
IDEF 

1. Drag a task from a KWS Task or ToDo window onto the tree view area 
of KWS Converter. 

2. The Convert To Dialog Box will appear, prompting you for the 
destination model type. Select IDEF and press OK. 
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3.   The KWS tasks will be converted to an IDEF model (Figure 7-16), with 
the top-level task being the top level in the tree view. The status bar will 
display "KWS -> IDEF," signifying a KWS to IDEF conversion. 

;§BKWS Converter 

File   Help 

Tasks; 

HHE3 

Acquire Funds 

Write Proposal 

Write Cover Letter 

•Aquire Signatures 

- Submit 

KWS-> IDEF A 

Figure 7-16: KWS to IDEF Conversion 

4.   When you are ready to export to IDEF format, select IDEF from the 
File|Save menu. A Save As Dialog Box will appear and prompt you for 
a file name. Select a file name that ends in .idl. Select OK to save the 
IDEF tasks in IDL format. 

Converting from SDEF 
to KWS 

To convert from SDEF to KWS: 

1.   Select SDEF from the File|Open menu. Select a valid SDEF model file 
(.txt) from the Open File dialog box. Opening the file will convert the 
SDEF model to a KWS model (Figure 7-17). The SDEF project name 
will appear as the KWS process, and thus the top level in the tree view. 
The status bar will display "SDEF -> KWS," signifying an SDEF to 
KWS conversion. 
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jSKWS Converte 

Project 17M «38 
Acquire Funds 
Write Proposal 
Write Cover Letter 
Review Proposal 
Aquire Signatures 
Submit 

i Due Date |l2Mav98 

Duratjm |72 

DateStarte* 

Date Frisbed |—"' 

«Effort [TÖÖ 

Ä:Coriipfete:|0 

-Status - 
: W- NotSfartedS 
■ ':'rj^taitedv:;':;:;S 

'-. ^CiFiriishedii ;■; 
^-OBEÄft" 

;Assidned;Tös|KAPPES.S     vj. 

¥erfo|ed1||I^S.S    ^; 

s!is^|pPPEsT^l; 

^■Normals*: 
r High 

■■riSfcay 
OrgID FF' 
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Figure 7-17: SDEF to KWS Conversion 

2. Double clicking on a task in the tree view will display its subtasks. 
Single click on any task, and its task information will be displayed in the 
KWS Task form. 

3. Edit the task information as necessary. 

4. When you are ready to import tasks into KWS, you can select KWS from 
the File|Save menu. This action will import the entire task structure into 
KWS as a top-level process. 

5. While holding down the Shift key, drag from the tree view to a Task or 
ToDo window on KWS. The task structure will be inserted into that 
KWS window. 

Converting from KWS to    To convert from KWS to SDEF: 
SDEF 

1. Drag a task from a KWS Task or ToDo window onto the tree view area 
of the KWS Converter. 

2. The Convert To dialog box will appear, prompting for the destination 
model type. Select SDEF and press OK. 

3. The KWS tasks will be converted to an SDEF model, with the top-level 
task being the top level in the tree view. The status bar will display 
"KWS -> SDEF," signifying a KWS to SDEF conversion. 
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Figure 7-18: KWS to SDEF Conversion 

A 

4. Double clicking on a task in the tree view will display its subtasks. 
Single click on any task, and its task information will be displayed in the 
KWS Task form. 

5. Edit the task information as necessary. Fields that have been supplied 
with program defaults are marked in bold and may need to be reviewed 
before exporting. 

6. When you are ready to export to SDEF format, select SDEF from the 
File|Save menu. A Save As Dialog Box will appear and you will be 
prompted for a file name. Select a file name that ends in .txt. Select OK 
to save the tasks in SDEF format. 

Converting from MS 
Project to KWS 

Data must be exported from MS Project as "Text (Tab Delimited)" using 
the "Task (Export Table) Map." This action will produce a .txt file. 

To export data from MS Project for import by the KWS Converter: 

1. From MS Project, select Save As from the File menu. The File Save 
dialog box appears. 

2. Select Text (Tab delimited) (*.txt)" from the Save As Type selection 
box. 

3.   Enter the name for the export file in the File Name edit box. And click 
OK. The Export Format dialog box appears (Figure 7-19). 
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Figure 7-19: Export Format Window 

4. Select Task "Export Table" map from the Import/export map list box. 

5. Click Edit... and the Define Import/Export Map dialog box appears. 

inpof t/Exportmip. name: 

[ •.*■■.•Cpfeons.-.--v 
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Figure 7-20: Define Import/Export Map Window 
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6. If the Export header row/Import includes headers checkbox is 
checked, click on it to uncheck it. 

7. Click OK and you will return to the Export Format dialog box. 

8. Click Save and the data will be exported. 

To convert from MS Project (MSP) to KWS: 

1. Select MS Project from the File|Open menu. Select an MSP model in a 
valid file format (.txt) from the Open File dialog box. Opening the file 
will convert the MSP model to a KWS model. The MSP project name 
will appear as the KWS process, and thus, the top level in the tree view. 
The status bar will display "MSP -> KWS," signifying an MSP to KWS 
conversion. 

2. Double clicking on a task in the tree view will display its subtasks. 
Single click on any task, and its task information will be displayed in the 
KWS Task form. 

3. Edit the task information as necessary. 

4. When you are ready to import into KWS, you can select KWS from the 
File|Save menu. This action will import the entire task structure into 
KWS as a top-level process. 

While holding down the Shift key, drag from the tree view to a Task or ToDo 
window on KWS. The task structure will be inserted into that KWS window. 

Converting from KWS to    To convert from KWS to MS Project: 
MS Project 

1. Drag a task from a KWS Task or ToDo window onto the tree view area 
of KWS Converter. 

2. The Convert To dialog box will appear, prompting for the destination 
model type. Select MS Project and press OK. 

3. The KWS tasks will be converted to an MSP model (Figure 7-21), with 
the top-level task being the top level in the tree view. The status bar will 
display "KWS -> MSP," signifying a KWS to MSP conversion. 
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Figure 7-21: KWS to MS Project Conversion 

4. Double clicking on a task in the tree view will display its subtasks. 
Single click on any task, and its task information will be displayed in the 
KWS Task form. 

5. Edit the task information as necessary. Fields that have been supplied 
with program defaults are marked in bold and should be reviewed and 
possibly edited before exporting. 

6. When you are ready to export to MSP format, select MSP from the 
File|Save menu. A Save As Dialog Box will appear and will prompt 
you for a file name. Select a file name ending in .mpx. Select OK to 
save the tasks in Microsoft Project MPX format. 

ADDING ITEMS TO THE TOOLS MENU 

Adding Items to the 
Tools Menu 

The Tools Menu in the KWS Menu Bar provides access to applications you 
can use to enhance your KWS environment. KWS is initially installed with 
the Task Palette, DoItBase, and TimeAgent applications included in the 
Tools Menu. If desired, you can include additional applications in your 
Tools Menu so they can be launched directly from KWS. 

To add items to the Tools Menu: 

1. Open your KWS.INI file (located in the Windows directory) using any 
ASCII file editor. 

2. In the Tools section of your KWS .INI file, enter the items you would 
like to include using the following syntax: 

ITEM<#>=<executable filename>,<name > 
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where    <#> is the location of the item in the menu 
Executable filename> is the full path and filename required 
for executing the application 
<name> is the name you want to display in the Tools Menu. 

The following example will cause two items to display in order at the 
bottom of the Tools Menu, provided the paths you supply are correct. 
KWS will not check for correct/ full paths. 

[TOOLS] 
ITEM 1 =c:\windows\calc.exe,Calculator 
ITEM2=c:\timelog\timelog.exe, TimeLogger 

3.   Save and exit the KWS.INI file. 

CREATING QUERIES 
KWS system administrators can create custom queries that can be used by all 
knowledge workers in an organization. Custom queries created and 
activated by the administrator will be listed under the Query, Tasks, 
Custom Queries menu. 

Custom Query Setup 

Title: r OK 

KWS Version:    W$~ 

Query Select List 

Created By: KAPPES.S F? Active        Cancel 

SELECT TASK.NUM. TASK_LEVEL. TASK_PARENTNUM. TASK ID. TASK.NAME, TASK DUEDATE. 
TASK_FIXDATE.TASK_ESTDATE.TASK_STARTDATE,TASKFrNISHDATE. TASK CYCLE. 
TASK.DURATION, TASK_LOGDURATION.:TASK PCTEFFORT,TASK STATUS; TASK KW.      ! 

TASK_KWPERF.TASK.PRIORITY.TASK ASSIGN8Y;TASK CYCLETNUM. TASK JNSTPARENT. 
TASK.ORG. TASKiPRMATE;TASK_TODO.TASK LATESTÄRT.PCT COMPLETE.STATUS CHANGE. 
TASK_TYPE, TASKJHOOTNUM. CYCLENUM. TASK DUEDATE_FMT~TASK DURATION FM~T. 
TASK_PCTEFFORT_FMT.TASK.EARLYSTART.TASK DESCRNUM.TASK OWNER. 

:Query FROM/WHERE Clause: 

d 

FROM TASK. WORKGROUP.ASSIGN WHERE (TASK_KW = WORKGROUP ID OR TASK KWPERF = 
WORKGROUPJD)AND (KWJD = '$KWID1AND (TASK_TYPE = OJAND (TASK NUM <> " 
TASK_CYCLETNUM) AND (TASK.TODO <> 0) ORDER BY TASK DUEDATE. TÄSK_NAME 

"3 

zl 
Figure 7-22: Custom Query Dialog box 
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Creating a Custom 
Query 

To insert a new custom query: 

1. Select the Custom ToDo Queries submenu under the Admin menu. 

2. Click the Insert button. The Custom Query Setup Dialog Box will 
appear. 

The Custom Query Setup dialog box contains the following data fields: 

Title The title of the query. 

KWS Version The version of KWS under which this 
query was written. If the query is executed 
under a different version of KWS, a 
warning message is displayed but 
execution is still allowed. 

A check box for activating the query. If a 
query is not active, it will not appear on the 
Custom Queries menu. 

This is a list of the KWS fields that will be 
returned from the database. This is a non- 
editable list, provided only for reference 

This is the actual SQL From and Where 
clause for the Select statement. The 
administrator may edit this field to return 
the desired information from the database. 
The query must be a standard SQL 
statement. Variables may be entered in 
this clause and must start with $. If the 
variable is not followed by a character that 
is not alphanumeric, it can be terminated 
by a $. The user will be prompted for 
these variables when the query is executed. 

Active 

Query Select List 

Query From/Where 
Clause 

3. Enter the information in data fields. 

4. Click OK. 

Deleting a Custom 
Query 

To delete a Custom Query: 

1. Select the Custom ToDo Queries submenu under the Admin menu. 

2. Select the query to delete from the query list. 
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*!* Modifying a Custom 
Query 

*!* Executing a Custom 
Query 

3.   Click the Delete button. 

To modify a Custom Query: 

1. Select the Custom ToDo Queries submenu under the Admin menu. 

2. Select the query to edit from the query list. 

3. Click the Modify button. The Custom Query Setup dialog box will open. 

4. Make the desired modifications to the data fields. 

5. Click OK. 

To execute a Custom Query: 

1. Select Query from the KWS Menu Bar. 

2. Select Tasks from the Query Menu. 

3. Select Custom Queries from the Query...Tasks menu. 

4. From the Custom Queries menu, select the name of the query to be run. 
The query will run and return the results in a task list window. 

TASK ARCHIVING 

The Task Archiving feature allows tasks to be moved to a separate archive 
database. These tasks can later be restored by copying them from the 
archive database to the main KWS database. 

A KWS database can have only one archive database associated with it, and 
an archive database can be associated with only one main KWS database. 
This association is set up using the KWS Database Setup dialog box. 

When a task is moved to the task archive, the attachments remain in the main 
KWS attachment directories and will be moved to the attachment archive 
directory if the last link to an attachment is deleted. 
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*** Setting up a Task 
Archive database 

To setup a Task Archive database: 

The task archive database must be setup by the KWS system administrator 
and associated with the KWS main database using the Database 
Connections manager: 

1. Create a new KWS database (see KWS System Administrator's Guide) and give 
the new database the same database ID as the main KWS database. 

2. Open the KWS Connections window by selecting the Database Connections 
option from the Admin menu. 

3. Edit the entry for the new archive database by selecting the entry and clicking 
Modify. 

4. In the KWS Database Setup dialog box click the Archive checkbox. 
This action identifies this database as an archive database, thereby preventing its 
display in the Login dialog box. 

5. Click OK. 

6. Edit the entry for the main KWS database by selecting the entry and clicking 
Modify. 

7. In the Archive Connection ID field, select the connection id for the archive 
database setup in the previous steps. 

8. Click OK. 

The archive database is now associated with the main KWS database and 
will be opened when the user selects Archive Manager from the Admin 

menu. 

***  Opening the Archive 
Manager Window 

To open the Archive Manage Window: 

1. Select Archive Manager from the Archive menu. You must be an administrator 
to select this option. 

2. The Archive Manager Window appears (Figure 7-23). 
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Figure 7-23: Task Archive Manager Window 

Archiving a Task To archive a task: 

1. Open the Archive Manager Window as described above. 

2. Drag the tasks to be archived from a Task or ToDo window to the Archive 
Manager Window. 

3. The tasks will be copied to the task archive and you will be given the option of 
deleting the original tasks. 

Or... 

1. Select a task in the Task Manager Window. 

2. Select Archive Selected Task from the Admin menu. 

3. The Archive Manager Window will be opened if it has not already been 
opened, and the selected task(s) will be copied to the archive. You will be given 
the option of deleting the original tasks. 

Restoring a Task From 
the Task Archive 

To restore a task from the task archive: 

1. Open the Archive Manager Window as described above. 

2. Drag the tasks to be restored from Archive Manager Window to a KWS task 
window. The tasks will be copied from the task archive to the task window. 
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Viewing, 3-38 

Preferences, 1-4 
Display Field, 7-5 
Font and Display, 7-4 

Printing, 1-31 
Field Setup, 7-9 
Font Setup, 7-8 
Page Setup, 7-7 

Private Tasks 
Adding, 2-6 
Deleting, 2-7 

Program Window, 1-2 
Queries 

Custom, creating, 7-42, 7-44 
Custom, deleting, 7-43 
Custom, Executing, 7-44, 7-45, 7-46 
Custom, modifying, 7-43 

Query Menu, 1-6 
Attachments, 1-6 
Dolts, 1-6 
Search Text in Windows, 1-7 
Tasks, 1-7 

Reassignment, 7-27 
Org-ID, 7-28 
User's Tasks, 7-27 

Search, 1-23 
Steps, 3-55 

Copying, 3-58 
Deleting, 3-57 
Inserting, 3-57 
Modifying, 3-57 
Moving, 3-58 
Orphans, 7-33 
Reordering, 3-57 
Status, changing, 3-58 
Viewing, 3-56 

Successor. See Predecessor and Successor 
Symbols, 2-3 
System Options, 7-2 

Non-Working Days, 7-2 
Notifications, 7-2 

Task Manager, 3-22 
Adding Public Tasks, 3-25 
Attachments, 3-24 
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Changing Status of a Task, 3-27 
Children, 3-24 
Do Its, 3-24 
Opening, 3-23 
Parent, 3-24 
Sibling, 3-24 
Steps, 3-24 
Symbol Menu, 2-4 
View Tasks, 3-23 

Task Menu, 1-7 
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Button Bar, 1-14 
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Converting Private to Public, 3-27 
Converting Public To Private, 3-27 
Copying, 3-26 
Cyclic. See Cyclic Tasks 
Data Fields, 3-3 
Definition, 3-2 
Deleting, 3-25 
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Do Its, 2-5 
Exporting, 7-32 
Importing, 7-32 
Indicator Columns, 2-4 
Manager, 3-22 
Modifying, 2-5, 3-25 
Moving, 3-26 
Orphans, 7-33 

Permissions, assigning, 3-28 
Query, 1-7 
Security, 3-14 
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Status, 3-17 
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Symbol Menu, 2-4 
Window, 3-22 
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Do Its, time contingent, 5-13 
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Title Bar, 1-2 
To Do 
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Calendar, 1-2, 2-9 
Graph, 2-14 
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To Do Calendar, 2-9, 2-11 
To Do List 
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Viewing, 2-7 
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ToDoMenu, 1-8 
ToDo Window, 2-2 
Tools Menu, 1-11 
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User List, 7-20 

Modifying, 7-21 
Viewing, 7-20 

Window Configuration 
Button Bar, 7-4 
Saving, 7-3 
Status Bar, 7-3 

Window Menu, 1-12 
Work Groups, 7-20, 7-23 

Adding, 7-25 
Adding Users, 7-26 
Deleting, 7-25 
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